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Welcome 
 
Thank you for purchasing our ecommerce template software. Our shopping 
cart software is designed to get your store up and running with minimum cost 
and hassle whilst providing a powerful solution to your ecommerce needs. 
 
We have tried to do as much as the work for you, through the design, 
payment processor integration, shipping options etc. which will leave you to 
personalize the store, add your categories and products and get up and 
selling as soon as possible. 
 
Please take time to read through the notes provided here to get the most out 
of your online store. 
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Requirements 
 
You will require one of the following HTML editors: 
 

• Macromedia Dreamweaver 3, 4, MX or 2004 
• Microsoft Frontpage 2000, 2002 or 2003 
• Adobe GoLive 5, 6 or CS 

 
You will need a hosting company where your store will reside; the minimum 
requirements are as follows: 
 
ASP version 
 

• Microsoft Windows Server  
• Support of ASP pages 
• Database (Access) 
• ASPEncrypt for offline credit card processing (optional) 

 
PHP Version 
 

• Unix / Linux Server  
• Support PHP version 4.1 or above 
• MySQL Database 
• cURL component installed for UPS shipping
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Installing the Template 
 
You should have downloaded an .exe file to your hard drive following 
purchase; this will be the id of the template you have purchased with the .exe 
extension e.g. 0003fe00bkg0021.exe 

 

 
 

1. Double click on the icon 
2. Read through the License Agreement 
3. Select the Checkbox to accept the Agreement 
4. Click on Next 
 
You will then receive a window prompting you to provide a location where you 
would like to save your extracted file: 
 

 
 

5. You can leave the default settings or click on the Browse button to 
save the software to a different location on your hard drive.  

6. Click on “Start” to extract the software.  
 
The extraction program will then run and your software will be saved on your 

hard drive. 
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Note 
 
We strongly recommend that you keep the .exe file in a safe place in case you 
need to run it again at a later date and to prevent loss of data in the event of a 
computer crash.
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Opening the Template in Dreamweaver 
 
In Dreamweaver you must define the site before making any changes to the 
template. Please note, there are slight variations between the different 
Dreamweaver versions, but the basic principle remains the same. 
 
1. Open Dreamweaver 
2. Select Site 
3. Click on New Site 
 

 
4. Ensure the Advanced Tab and in the Site Name Section give the 

template site a name 

5. In the Local Root Folder Section and select the yellow folder to 
browse to the folder you extracted the template to. (By default this should 
be C:\Dreamweaver Templates\DW Store Template).  
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To get started you won't need to fill in any other information. Click on Done 
 
Please see our tutorial here www.ecommercetemplates.com/tutorials/ 
for more help. 
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Opening your Template in Frontpage  
 
1. Open FrontPage 
2. Select File 
3. Choose Open Web 
4. Browse to the location where you extracted your ecommerce template 

(by default this should be C:\Frontpage Templates\FP Store Template). 
 

 
 

NOTE 
 
We would strongly recommend you following the above instructions whenever 
you edit the template in FrontPage as this will open the complete site.  If you 
choose File > Open, this will only open one individual file and when you make 
changes such as changing the location of a Hyperlink it will not establish the 
Cache for the whole site.
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Opening the Template in Adobe GoLive 
 
1. Open Adobe Golive 
2. Select File 
3. Choose Open  
4. Browse to the location where you extracted your ecommerce template 

(by default this should be C:\GoLive Templates\GL Store Name). 

 

5. Locate the .site file 

 

6. This will open the list of files and folders that make up your GoLive 
store 
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7. Double click on any of the file names will bring up the page in design 
view. Items that are repeated on several pages such as the company 
name, news section, menu etc. have been set up as GoLive 
components so the whole site can be updated from the one file. Double 
clicking on any of the components will bring it up for modification. 
Components are shown with a change in cursor: 

 

8. After making the modifications you should be prompted to update all 
files that use that component 
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9. Agree to update all files and move on to the next one 

10. To set up a new page, the easiest way is take an existing page and 
save it under a new name. 

11. If you see the green bug icon rather than the tick next to a file in the 
site list then you will probably have a broken link in that file or one of 
the components included on that page. Bug icons in the vsadmin or inc 
folders can usually be ignored. 
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Uploading the store to your server 

You may want to make some design changes before uploading the store to 
your host or alternatively start adding products and categories straightaway to 
the online admin section and leave the design elements to later. 

 
Using an FTP program to upload your store 

You may already have a FTP program installed – if not, you can download a 
copy from one of the popular download sites like www.download.com or 
www.tucows.com - search for “FTP Utility” and you’ll get a large choice of 
programs. Popular utilities including WS_FTP Pro and Cute FTP 

Alternatively both Dreamweaver and FrontPage have their own built in FTP 
programmes. 

• Using Dreamweaver to upload your store 

• Using Frontpage to publish your store 

Note. 

Your hosting company should have provided you with the details for logging 
onto your server – the three key items are: 

• FTP address 

• FTP user name 

• FTP password 

With that information you should be able to connect to your server. The usual 
set up when using a FTP program is to have your local files on the left window 
and the server files on the right so you can send the files and folders from 
your local hard drive to your server. The hosting company will often have a 
number of folders already set up and you may need to check their instructions 
to find out where the store pages need to go but this will usually be in a folder 
called “htdocs” public html” or “www” 
With that information you can now transfer the files from your hard drive to the 
host server. It is best to upload all the files and folders from your extracted 
template – do not upload the main folder eg. DW Virtual Tones Ecomm Plus 
but rather the files and folders included within that folder ie. /vsadmin/ 
/prodimages/ /images/ categories.asp, cart.asp etc. 
Once you have the entire site uploaded you can then go on to make your 
database connection and log in to the admin section. 

 
14  © Ecommerce Templates 

http://www.download.com/
http://www.tucows.com/


 
 
Using Dreamweaver to Upload your Store 

Dreamweaver has an inbuilt FTP utility, which you can use to upload your files 
and folders. When you first defined the site you may have only set up the local 
information. If you want to use Dreamweaver to upload your store you will 
need to add some details to the remote window: 
1. Select Site 
2. Click on Define Site 
3. Double Click on the Template Site to Define 
4. Ensure the Advance Tab is selected and choose Remote Info 
5. Enter the Remote Host Details 
6. Select Done and close and dialogue boxes that may be open 
Your host should have given you these details when you signed up for your 
hosting account. Once you have entered the information above, make sure 
you are connected to the internet and hit the test button to make sure your 
connection is correct. 

 

7. Select Site 

8. Choose Site Files 

9. Select the Put Icon to upload all files 
and folders to your web host 

The “Templates” folder doesn’t actually have to 
reside on your server as it is only used for 
making changes locally but it won’t harm 
anything if it is uploaded.Once you have the 
entire site uploaded you can then go on to 
make your database connection. 
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Publishing your Store via FrontPage 

If you have a Frontpage version and your host has Frontpage extensions 
installed it is possible to use Frontpage to transfer your site from your hard 
drive to your server. 

1. Open your site in FrontPage - File > Open Web 

2. Click on the Publish Icon: 

 

3. Next give the URL of the site you are publishing to: 

 

4. And finally type in the Frontpage Username and Password that were 
supplied by your hosting company: 
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Once you have the entire site published you can then go on to make your 
database connection. 

Making the Database Connection 

There are two ways of setting the database connection depending on the type 
of Template you have purchased.  Please choose the appropriate section to 
set your database connection. 

• ASP version 

• PHP version 

Now that all the files and folders are on your host server, it’s necessary to 
make the connection between the store and the database that dynamically 
generates the store functions. The set up is different for the ASP and PHP 
versions: 

ASP Version 

The easiest way to set up your connection is by preparing a quick test file and 
then copying the contents into your db_conn_open.asp file in the vsadmin 
folder - here's how to do it: 

1. Open Notepad and Copy and Paste the following lines of code: 

<HTML> 
<BODY> 
sDSN = "Provider=Microsoft.Jet.OLEDB.4.0;Data 
Source=<%=server.mappath("vsproducts.mdb")%>;" 
</BODY> 
</HTML>  

2. Save the file as test.asp  

3. Upload this file to your fpdb folder (the one where your database 
resides)  

4. Now Open this page in your browser, the URL should be something 
like www.yourdomain.com/fpdb/test.asp  

5. Copy the contents of that page - it should look something like this 

sDSN = "Provider=Microsoft.Jet.OLEDB.4.0;Data 
Source=C:\web\database\vsproducts.mdb;"  

 

 

 
© Ecommerce Templates Page 17 of  229 



 

6. Open the file db_conn_open.asp (located in the vsadmin folder of 
your template) in notepad and replace the current content with what you 
have copied from test.asp - just make sure that you don't delete the 
opening and closing <% %> tags so your code in db_conn_open.asp 
should look something like this: 

<% 
DIM sDSN 

sDSN = "Provider=Microsoft.Jet.OLEDB.4.0;Data 
Source=C:\web\database\vsproducts.mdb;" 

%>  

7. Upload your new db_conn_open.asp to your server, overwriting the 
original in the vsadmin folder  

Note 

That should be working fine now and you can check the connection at the 
following URL:  www.yourdomain.com/vsadmin/admin.asp and you can 
login with the default username mystore and password changeme. 

If when you login and you get a message saying your Database Connection 
needs to be set then try following the above steps again checking everything 
carefully. 

If you get an error message saying that your database is not writeable then 
this will indicate that your connection has been set correctly but you will need 
to contact your host to get write permissions set to your database folder. 

We would also recommend making a back up of the db_conn_open.asp file 
just in case it gets overwritten at any time. 

Important 
The folder where the database resides should be non-browseable. This 
means that nobody will be able to download your database by typing in 
www.yourstore.com/fpdb/vsproducts.mdb - it’s worth running a check. If you 
can download the database then ask your host if there is a special folder 
under the root of the site where your database can be placed, if they can set 
non-browseable permissions on the database folder, or in Frontpage, right 
click the database folder, choose properties and uncheck the "allow files to be 
browsed" box. 
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PHP Version 

To set the database connection, open the file vsadmin/db_conn_open.php 
in a text editor such as Notepad. You need to fill in the details in the spaces 
provided. The 4 pieces of information that you need to provide are the 
username and password for database access, the name of the database 
and the address of the database. If you are in any doubt about these, please 
ask your host who will provide you with the information. Then fill in the gaps 
between the quotes as shown. 

$db_username = "loginname"; // Your database login username 
$db_password = "loginpassword"; // Your database login password 
$db_name = "databasename"; // The name of the database you wish to use 
$db_host = "localhost"; 

The last parameter $db_host is normally "localhost". However, it can also be 
a URL like 

$db_host = "db.myhost.com";  

You host should have given you access to a hosting control panel where, 
amongst other things, you can set up the mySQL database connection. 
Here’s an example using “cpanel” 

1. Log into to your hosting control panel, this will typically be the URL 
www.yoursite.com/admin/ or www.yoursite.com/cpanel/ and after 
entering your username and password you should see a screen with 
the mySQL icon: 

 

2. Click there and choose your user name and password, then click 
“Add User” 
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3. When the screen refreshes you’ll need to give your database a name 
and click on Add db: 

 

4. Finally choose the database you have just set up from the drop down 
and choose “Add User to Db” 

 

5. You will then be presented with details of your connection string that 
you can copy and paste into db_conn_open.php. 

 

Note 

Make sure you include the underscore in your user name and database 
name 

6. Upload the db_conn_open.php and replace the file in your vsadmin 
directory 
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Once this information has been correctly entered and uploaded, you can 
install the database tables and data.  

7. To do this, just open the file createdb.php in a browser by entering the 
address for instance: 

http://www.yoursite.com/createdb.php 
Replacing "www.yoursite.com" with whatever is the URL of your site.  
 
The following screen will appear, please see following page: 

 

8. Then click on the button to Install Ecommerce Plus and your 
database will be created. Please remember to delete this file from your 
web after running it, as otherwise others could use it to destroy your 
information. 

The store should be working fine now and you can check it at: 

www.yourdomain.com/vsadmin/admin.php and you can login with the 
default user name mystore and password changeme. 

Please view our tutorial at www.ecommercetemplates.com/tutorials/ for 
further help. 
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Files and folders 

Now the store is on the server it may be an idea to become familiar with the 
files and folders that make up the store itself. Below is an overview of what 
each folder includes and its function: 

Fpdb: This is where your database resides. (ASP version only) 

Images: This folder contains all the graphics that are used in the design of the 
site – it should also contain a folder called “extras”, where you can find the 
.png files and/or blank graphics. 

Prodimages: This is the default folder for placing your product images. You’ll 
see that at the beginning it contains the dozen or so images used in the 
default store. 

Vsadmin: This is where all the admin pages, scripts and images are kept. 
You don’t need to make any design changes here but there a couple of files 
that you may need to edit once you have all the files published to your server. 

Includes: This folder contains the include pages. If you’re not familiar with 
includes, these are files that are used on several or all of the pages on the 
store – updating these pages will cause all pages that “include” them to be 
updated at the same time. They are typically news sections, headers, menu 
and footers. (Frontpage only) 

Templates: This folder should contain the .dwt file, usually called Main.dwt. 
This is where you should make the global changes to your site. Once you've 
made the changes to this file, save it and you'll be prompted if you want to 
update all the files using this template - agree to the prompt and you should 
be able to see the modifications you've made on subsequent pages. 
(Dreamweaver only) 
Library: Some of the templates use library items for the news sections or 
menus. These can be inserted or deleted from the editable sections and like 
the .dwt file, any changes made to the .lbi file will be made on all the pages 
containing the library item on saving. (Dreamweaver only) 
 
The other files are the ones that make up the site and store itself and will have 
a .html, .php or .asp extension. 
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The Control Panel  
 
Once the site is uploaded to your server and the database connection has 
been set, it’s possible to connect to the admin area. Depending on the version 
your admin area will be here: 
 
ASP Version 
 

www.yourstore.com/vsadmin/login.asp 
 
PHP Version 
 

www.yourstore.com/vsadmin/login.php 
 
The default username is  - mystore 
The default password is  - changeme 
 
Once you have logged in you will be presented with links to the various 
sections that make up the control panel, the main admin settings are detailed 
below. 
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Change Username and Password 
 
This should be your first change as all the templates come with the same 
combination. It’s best to choose an alphanumeric combination and make sure 
you write them down and save in a safe place. If you forget the combination 
later on it is possible to retrieve them, there is help in our troubleshooting 
page. 
 
1. To change the Username and Password click on the  

button. 
2. Key in your Username 
3. Key in your Password and repeat this process for the Confirm Password 

option 
Click on Submit 
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Main admin settings 
 
To access the main admin settings login to your control panel and select the 

 Button.   
 
Edit admin settings 
 
This will be the next page you will want to visit and includes all the important 
information regarding the general functionality of your store. The various 
options are outlined below: 
 
Country settings 

 

 
 
This is where you select your country / currency default. So if your store sells 
in UK Pounds you would want to choose Great Britain and Northern Ireland. 
 
Currency Converter (optional) 
 
It is possible to show your prices in up to three other currencies other than the 
default. Sales will always be processed in the default currency but it does 
provide a guide for international purchasers regarding the approximate price 
in their local currency. 
 

 
 
You can set your own rates and change them when you like by filling in the 
rate field and selecting the currency of your choice from the drop down menu 
for symbols. 
 
Alternatively it is possible to connect to our currency updater. This is currently 
a free service using the username (testuser) and password (testpw) but in 
the future there will be a monthly charge for connecting to our updated rates. 
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Although updated regularly these will only ever be approximations and we 
strongly suggest that you make that clear on your store. 
The currencies currently supported are: 
 

• Danish Krone (DKK)  
• Swedish Krone (SEK)  
• New Zealand Dollars (NZD)  
• Australian Dollars (AUD)  
• Canadian Dollars (CAD)  
• Swiss Francs (CHF)  
• Euros (EUR)  
• British Pounds (GBP)  
• Japanese Yen (JPY)  
• United States Dollars (USD)  

 
If you do not want to show alternative currencies on your product and product 
detail pages then leave all the fields blank and the feature will be ignored on 
your store. 
 
Email confirmation 
 
You will probably want to be notified by email once an order is placed on your 
store. You can choose that option by ticking the box here and adding your 
email address. It is important that the address you stipulate is valid for your 
store domain so it should be in the format of you@yourdomain.com rather 
than you@anotherdomain.com 
 

 
 
If you have problems receiving emails from your store, please view our 
troubleshooting guide. 
 
Email object (ASP version only) 
 
Most users won’t need to change anything here but if there is a problem with 
emails not being received through the store then you may need to make a 
change here. Your host will be able to tell you what email components are 
supported. 
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If you do need to set a mailhost then follow the link and make the necessary 
change in vsadmin/includes.asp – also be sure to check out the email 
troubleshooting section. 
 
Store URL 
 
This piece of information is crucial to the store functionality. In most cases the 
base URL will be the same as your domain, such as 
http://www.yourstore.com/ but if you have placed your store files in a 
different folder you would need to specify that here, for example 
http://www.yourstore.com/folder/ or http://folder.yourstore.com/ 
 

 
 
Products Per Page 
 
By default the number of products that show on your product page is eight – if 
you would like to change that then enter a different value here. Remember 
that setting a high value will slow the page load time. 
 

 
 
Handling charge 
 
This is where you can set a charge for handling. It will apply to all products on 
your store. If you need to change the text that appears on your store for 
“handling” then this can be edited in the file vsadmin/inc/languagefile.asp/.php 
 

 
 
Shipping type 
 
Here is where you will choose your shipping method. We have ample 
instructions to help set up this part in our shipping section. Remember it is 
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only possible to use one shipping method on a store, mixing them is currently 
not an option. 
 

 
 
Pack products 
 
This is where you can set the shipping totals on products individually (pack 
products separately) or on the order as a whole (pack products together). The 
option is available for UPS, USPS and weight based shipping only. 
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USPS /UPS 
 
The following 3 options are for UPS / USPS shipping only and should be self-
explanatory. 
 

 
 
Canada Post 
 
If using Canada Post add you Retailer ID here. 
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Stock management 
 
This allows you to set the number of items in stock and when the last item is 
added to the cart the "Buy" button is replaced by an "Out of Stock" message.  
 
The text for “Out of Stock” can be changed in the 
vsadmin/inc/languagefile.asp/.php 
 
It's also possible to configure how long the last item can remain in someone's 
cart until it becomes available again if a purchase is not made: 
 

 
 
This means that if the last item is added to the cart, and the person decides 
not to purchase, then after the designated time (three hours in the above 
example) the item becomes available again for purchase. 
 
The number of items left in stock is shown in the product admin section - each 
product will have a number after it like this: 
PC Keyboard (6) 
The number will decrease with each sale. It is necessary to "turn on" the stock 
management in your Main Admin page to use this feature. 
 
If you are using Stock Management it is also possible to download the current 
items you have in stock. This can be achieved through the products admin 
page by clicking on the “dump inventory” button. This will download a .csv file 
that can be viewed in Excel. 
 
From Version 4.4.0 you can use stock management on product options as 
well as on the overall product. On the products admin page if you are using 
stock management you should see a drop down menu which allows you to 
choose between "In Stock" that will set the stock level for the overall product 
and "By Options" which will set stock levels by the stock of the product 
options. 
An important thing to note is that if you share an option between 2 products 
the options stock is shared between 2 products. This could be useful if you 
have say only 20 disk drives, each of which could go in one of 5 different 

 
© Ecommerce Templates Page 31 of  229 



 

models of PC. However, if this is not what you intend then on the product 
options admin page we have also provided a "Clone" button to quickly create 
a copy of one product option. Using the Option Working Name you will also be 
able to distinguish these internally. 
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Delete orders 
 
There will always be a number of “purchasers” who finally decide not to go 
through the purchase process and abandon the cart. It may be they’ve 
changed their mind or are simply finding out how the store works. In this case 
the order will show in the order admin page with a gray “authorize” button. In 
these cases it’s important to check with your payment processor admin to find 
out if payment was made or not. In the majority of cases this won’t have 
happened so the “order” can be deleted. This feature will delete unauthorized 
/ uncompleted orders in the amount of time stipulated in the drop down menu. 
It is also possible to delete orders manually in the orders admin page. 
 

 
 
Delete credit card numbers 
 
This option only applies if you are using Offline Credit Card Processing 
through our “Capture Card” method. It is a further security measure so that 
sensitive credit card information is left on the server for the minimum amount 
of time possible. You can select the amount of time that the credit card details 
can be viewed through the online admin orders page – we strongly 
recommend setting this to a workable minimum. If you are not using the 
Capture Card method, this feature can be ignored. 
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Admin Tweaks 
 
You should only need to select these options if you are having problems 
viewing the admin pages, particularly the Admin Countries page. If this 
doesn’t resolve your problem we suggest using a Browser such as Netscape 
7 for making changes to the Admin Countries page. 
 

 
 
Remember that any changes you make on this page will only take effect after 

you have clicked on the “Submit” button. 
 
Multiple languages 
 
How it works 
 
This feature was added in Version 4.8.0 and allows you to have up to 3 
languages running off the same database and control panel. You can select 
the number of languages you require and which parts of the store you want to 
translate from your main admin page. The full set up details are outlined 
below. 
 
How to set it up 
The first thing you will need to do is to define how many languages you will be 
using and which parts of the store you are going to translate. In the main 
admin settings of the control panel you should see a drop down menu for the 
number of languages and a box with the different sections. Use Ctrl + Click for 
multiple selections. 
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As you will probably want to offer the navigation and information pages in 
other languages then the next thing you will need to do is upload all the store 
files and vsadmin folder to a new folder on your server. For example, if you 
are going to have a Spanish based store then make a folder called /spanish/ 
on your server and upload all the files there. 
 
The last thing you need to do is to tell the database which language is being 
used in that particular version. Open vsadmin/includes.asp or 
vsadmin/includes.php for the new language store you have set up and add 
this to the list for the ASP version: 
 
languageid=2 
 
..or for the PHP version: 
 
$languageid=2; 
 
where the number 2 is the identifier of the language. As an example if you 
have the main store set up in English and language versions for Spanish and 
French then you would have the languageid as 1 for English, 2 for Spanish 
and 3 for French in the respective include pages. 
 
You can now go into your control panel and start adding the information for 
the alternative languages. As an example if you have chosen to have 
separate language product names then in the products admin you should see 
three boxes, the first for the main store language the next two for the 
alternatives: 
 

 
 
Once that is all set up you can add links from your main store to the two new 
language stores.
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Edit Payment Providers (Main Page) 
 
The Payment Providers Admin page shows a list of the payment processing 
companies and methods currently supported by Ecommerce Templates. 
 
To access the Payment Provider click on the  button. 
 

 
 
Order Column  This column allows you to define the order that payment 

options appear on the checkout page of your store.  
 
Provider Name  The second column is the list of payment companies / 

methods currently supported. 
 
Configure You can set the necessary details of the payment method. 
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Supported Payment Providers 
 
Email 
 
The email option will simply email you the order details from a purchase. It will 
not include any credit card information and can be used if you would like to 
accept money orders, checks, cash on delivery etc. You can make it clear on 
your store the payment methods and process you are willing to accept here 
and it’s possible to change the default text for “Email” in the “Show As” field. 
You may wish to change this to something like “Check” depending on what 
you will be using it for. 
 

 
 

You can have a second email type payment provider by downloading the files 
from www.ecommercetemplates.com/free_downloads.asp and uploading 
these to your vsadmin/inc/ folder. From the payment provider list, this would 
be listed as “Custom”. 
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PayPal 
 
The advantage of using PayPal is that they can be used in conjunction with 
credit card processors to give your clients more choice for making payments. 
 
1. The first thing you will need is an account with PayPal, if you don’t have 

one yet then you can sign up here. (PayPal sign up) 
 
2. Once you have created your account, you need to set up the instant 

payment notification (IPN). This is necessary so that sales are 
automatically validated. To do this log into your PayPal account and click 
on the "Profile" tab. 

 

 
 
3. Now click on the link instant payment notification preferences link. 
 

 
 
4. The URL that you want to enter is the one to the file ppconfirm.asp/php 

in your admin directory. So for instance it might be: 
 

http://www.yourstore.com/vsadmin/ppconfirm.asp/php 
 
5. After entering this URL, just click the checkbox to activate instant 

payment notification and you're all done. 
 
6. You can then go to your 

Ecommerce Template 
Payment Provider Admin 
page and add the email 
address associated with 
your PayPal account. 
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Troubleshooting PayPal 
 
Setting up PayPal IPN is quite simple but if you have tried the above 
instructions and your orders are still not automatically authorized, then we 
have some troubleshooting information here for you. 
 
Your host will need the XML pack installed on the server for IPN to work. You 
can check this by opening the ppconfirm.asp/php page directly in your 
browser by entering the URL like so: 
 

http://www.yourstore.com/vsadmin/ppconfirm.asp/php
 
(you will of course need to change yoursite.com for the URL of your own site) 
If you just get a blank page then probably the XML pack is installed. If you 
receive an error then please send a note to your host asking them if they will 
install the XML pack. It is available free here… 
http://www.microsoft.com/xml/
 
Or comes as standard when IE6 is installed on the server. 
 
PayPal has introduced a new Merchant Tools feature called “Auto Return”. If 
you select this option in your account, PayPal has you add in the URL you 
would like your customers to return to on your website. What actually happens 
is that you are directed to the Thank You page that gives an error message 
“Sorry there has been an error”. You will also not receive order confirmation, 
so don't use this PayPal feature with the ecommerce templates. 
 
For more information, rates and support, please visit www.paypal.com. 
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2Checkout 
 
1. The first thing you will need to do is set up an account with 2Checkout. 
 
2. Once you have created your account, choose Edit Payment Providers in 

the store admin settings and click modify for 2Checkout.  
 
3. Make sure the Enabled box is checked, and enter the account number 

for your 2Checkout account. You do not need to, nor should you enter 
your secret 2Checkout password. The Show As field refers to how you 
would like the name to appear on checkout. 

 

 
 
4. Select the Demo Mode” checkbox for testing your store but remember to 

deselect once your store is live and ready to accept orders. 
 

5. Now log into your 2Checkout account. At the top there are several popup 
menus, with the mouse over the Shopping Cart menu, you should see a 
link to Cart Details. 

 

 
 
6. Once there, you want to make sure that the answer to the following 

question is Yes. 
 

Return to a routine on your site after credit card processed. 
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7. Also ensure that the URL of the return address is set to the file 

thanks.asp or thanks.php in your web, so for instance 
 

http://www.yourstore.com/thanks.asp 
http://www.yourstore.com/thanks.php 

 
8. Save changes and you are all set. 
 
Note 
 
As well as setting your 2Checkout account to demo mode using your store 
admin, you can also set it to Demo mode in your 2Checkout admin page. 
Make sure you are not in demo mode before going live by logging into your 
2Checkout account, then go to the Shopping Cart -> Cart Details link and 
make sure you see 
"Click Here to put your account in cart test payment mode."  
 
NB: It's best not to use the Direct Return option from 2Checkout. 
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Authorize.net (SIM method) 
 
Included with your store template there is a special file in the admin directory 
called wpconfirm.asp/php. The function of this file is to interpret the 
response from Authorize.Net. You need to enter the URL of this file in your 
Authorize.Net admin section to indicate that it is a valid URL. To do this: 
 
1. Log into your account at https://secure.authorize.net 
2. Scroll down till you see the "Transaction Response" section, and click 

"Response/Receipt URLs"  
3. Click "Add URL"  
4. Enter the exact URL of this file, for instance . . .  
 

http://www.yourstore.com/vsadmin/wpconfirm.asp /php 
 
5. Click Submit.  
6. Now go back to the https://secure.authorize.net settings main menu.  
7. Scroll down until you see "Security", then click on "Obtain Transaction 

Key".  
8. Answer the Secret Question you used to set up your account and take 

note of this transaction key.  
 
Now, in your Ecommerce Template admin, go to the Payment Providers 
section, click "Modify" for Authorize.Net and enter your Merchant Login Id 
and Transaction Key where indicated. Make sure the system is set to 
"Enabled" and is in demo mode to allow you to test easily. 
 
You should now be ready to 
run some tests through the 
system. To test, use the 
following visa card number 
with any date in the future. 
4007000000027 
 
When you're ready to go live, 
don't forget to take 
Authorize.Net out of demo 
mode in your Ecommerce 
Plus Template admin 
section. 
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Troubleshooting Authorize.net 
 
If you receive an error such as "The referrer, relay response or receipt link 
URL is invalid" or an error number 14, then please check that the Store URL 
in your Admin Main page is correct. The Store URL should be the URL of the 
base of your store. If it´s not in a subdirectory it would be 
http://www.yoursite.com. If it is in a subdirectory then you will need to add 
that, for instance . . . http://www.yoursite.com/store/ 
 
Do remember to change http://www.yoursite.com for the actual URL of your 
site. You´ll be surprised how many trip up on that one. 
 
If you receive the error "(13) The merchant login ID or password is invalid or 
the account is inactive." then check that in the Merchant Login ID under the 
Authorize.net payment providers page of the Admin Control Panel you have 
entered the Login number not the Merchant ID number.
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WorldPay 
 
1. The first thing you will need to do is set up an account with WorldPay. 

 
2. Once you have opened your account with WorldPay and been accepted, 

open your Ecommerce Plus Template admin pages and go to the 
Payment Provider section. 
 

3. Now click on Modify next to WorldPay. 
 

4. Where it says "Account Number" you want to enter the "Installation ID" 
that was sent to you by WorldPay. 

 
IMPORTANT NOTE: Make 
sure it is your installation ID 
and not your company ID that 
you enter. The 2 numbers are 
very similar and can easily be 
confused. 
 
5. Make sure that the 

Enabled and Demo 
Mode checkboxes are 
checked. 

 
Please note that WorldPay would have given you a password to enter their 
administration area. You do NOT want to enter that into the Ecommerce 
Template admin area. 
 
6. Now go to the WorldPay online administration area at 
 

http://support.worldpay.com/admin/  
 

7. Here you need to enter your WorldPay username and password. 
 

8. The type of integration you want is "Select Junior". This is the default 
when you setup an account with WorldPay, so leave this as it is. 
 

9. Now at the bottom-right of the screen, choose "Configuration Options". 
 
10. Set the Merchant's shop URL to the URL of your store. 

 
11. With your Ecommerce Plus template, in the admin directory, you will 

notice that you have a file called wpconfirm.asp/php. You want to set the 
"Callback URL" to point to this file. So for instance it might be . . . 

 
http://www.yourstore.com/vsadmin/wpconfirm.asp/php 
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12. Make sure the "Use callback response" checkbox is checked. 

 
13. Now click "save changes". 

 
14. While your WorldPay account is in test mode you can use the following 

Credit Card number for testing purposes 4000 0000 0000 0002 along with 
any valid (ie in the next 5 years) expiry date. 

 
You are strongly encouraged to fully test the system. 
 
NOTE: From Version 4.3.0 the 4 digit address validation code is now added to 
the auth code for Worldpay transactions. To interpret this code please see . . .  
http://support.worldpay.com/kb/user_guides/cms/help/appendix/cms_6130.ht
ml 
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NOCHEX 
 
Once you have created your account, you just need to go to the Edit 
Payment Providers link on your store admin, chose Modify for NOCHEX 
and enter the email address that is associated with your NOCHEX account. 
 
Setting up APC 
 
1. The NOCHEX Automatic 

Payment Confirmation 
system will mean that your 
orders will be automatically 
authorized when they come 
in. Setting it up is quite 
simple.  
 

2. To enable APC support on your NOCHEX account you have to contact 
NOCHEX support here: 
 
http://www.nochex.com/help/contact/support/
 

3. Once you have done this you can log in to your NOCHEX account and 
click on the "Edit Automatic Payment Confirmation Details" menu 
option. The URL that you will need to enter is: 

 
http://www.yourstore.com/vsadmin/ncconfirm.asp/php 

 
(You will of course need to change yoursite.com for the URL of your own site) 
 
Troubleshooting NOCHEX 
 
Setting up NOCHEX APC is quite simple but if you have tried the above 
instructions and your orders are still not automatically authorized, then we 
have some troubleshooting information here for you. 
 
Your host will need the XML pack installed on the server for IPN to work. You 
can check this by opening the ncconfirm.asp page directly in your browser by 
entering the URL like so: 
 
http://www.yourstore.com/vsadmin/ncconfirm.asp/php 
 
(You will of course need to change yoursite.com for the URL of your own site) 
 
If you just get a blank page then probably the XML pack is installed. If you 
receive an error then please send a note to your host asking them if they will 
install the XML pack. It is available free here: 
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http://www.microsoft.com/xml/ 
Or comes as standard when IE6 is installed on the server. 
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Verisign PayFlow Pro (ASP version only) 
 
Verisign PayFlowPro is slightly more complicated than other payment 
processing systems we offer, in that the credit card transaction takes place on 
your own server, and hence you require an SSL certificate on your site.  
 
Enabling Payflow Pro will force the second phase of checkout to take place on 
a secure (https) connection. For instance, with Payflow Pro enabled, you will 
find that after viewing the contents of the cart and clicking checkout, the URL 
changes from 
 
http://www.yourstore.com/cart.asp 
 
to 
 
https://www.yourstore.com/cart.asp 
 
If you do not yet have a certificate installed this will fail. To purchase an SSL 
certificate we can recommend www.thawte.com www.geotrust.com 
www.instantssl.com  
 
For testing purposes we have provided a way around this. In the file 
vsadmin/includes.asp set the following where you see the line 
 
pathtossl = "" 
 
. . . and fill in your usual URL. 
 
pathtossl = "http://www.yourstore.com/" 
 
Now you just need to enter the information that Verisign sent you when you 
opened your account by going to your store admin and clicking on Edit 
Payment Providers, and you should be all set. 
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Please note that it is possible to use shared SSL space if your host provides 
for this, but you must be able to access the same database as for the rest of 
your store. To do this, you need to copy at least these files to your shared 
SSL space . . . 
 
cart.asp 
vsadmin/db_conn_open.asp 
vsadmin/includes.asp 
vsadmin/inc/inccart.asp 
 
. . . plus probably your images directory. 
 
Then set the pathtossl as above to the directory that contains these files. For 
instance 
 
pathtossl = "https://www.yourhost.com/yourdirectory/" 
 
We have provided more information about setting up on a secure server here
 
Note 
 
The PayFlow Pro systems does need the PayFlow Pro Com Control installed 
on the server. As Verisign are such a big company this is normally done 
already, but it should be possible for a host to get in touch with Verisign about 
PFProCOMControl to get it installed. If it is not installed you will typically see 
an error message like this: 
 
Server object error 'ASP 0177 : 800401f3'  
 
Server.CreateObject Failed 
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Verisign PayFlow Link 
 
1. Login to your Verisign Manager 
2. Click on "Account Info" in the top left, then click on the "Payflow Link 

Info" link on the left 
3. Set the "Return URL Method:" to POST 
4. Set the Return URL to the thanks.asp/php page in your web. For 

instance this may be 
 

http://www.yoursite.com/store/thanks.asp/php 
 
4. Further down the page, the "Receipt Button Text:" should be set to 

something stronger than the default. For instance "CLICK HERE TO 
FINALIZE". 

5. Now login to your Ecommerce Plus admin section, go to the payment 
providers section and click modify for Payflow Link. Make sure it is 
enabled, and enter your login and partner. (The partner is normally 
VeriSign) 

 

 
 
SECPay 
 
When testing your interface either use a merchant id of 'test' or use either 
'secpay' or your merchant_id and make sure SECPay is set to demo mode 
in your template payment provider admin. You can use the test credit card 
number 4444333322221111 to perform test transactions. 
 
Be sure to enter your merchant id and not your merchant number in the 
payment provider admin section. The merchant number supplied by the bank 
is never exposed to the Internet. 
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Capture card (ASP version) 
 
The Capture Card system is available so that you can safely capture and 
store credit card numbers from your customers to process on your own credit 
card processing terminal. 
 
Requirements. 
 
· Windows server supporting .asp pages and an Access database  
· SSL certificate  
· Personal certificate  
· ASPEncrypt component installed on your server (Optional but 
recommended)  
· Internet Explorer 5.5+  
 
Setting up the "Capture Card" system with ASPEncrypt 
installed. 
 
To set up the "Capture Card" system please do the following. 
 

1. To obtain a Personal Certificate, please go to the following URL and 
follow the onscreen instructions. 

 
http://support.persits.com/encrypt/demo_cert.asp
 

2. Once you have installed your Personal Certificate in Internet Explorer, 
you must now export your Public Key. To do this, in Internet Explorer go 
to Tools -> Internet Options and click on the "Content" tab. Now click on 
"Certificates…".  
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3. On the "Personal" tab you should see the certificate you have just 

installed. Click on this and choose "Export…" to bring up the export 
certificate wizard. 

 

 
 
4. The first step of the wizard will ask you if you want to export the private 

key with the certificate. You MUST select "No, do not export the private 
key". This is most important as if you export the private key you will be 
compromising the security of the system. 
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5. On the next page of the wizard choose Base-64 encoded X.509 (.CER) 

as the format. Now give the file a filename such as certificate.cer and 
save it on your desktop or somewhere you have easy access to it. 

 

 
 
6. Run notepad or other text editor and open this certificate.cer file. 
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Remember that as certificate files are automatically created with a .cer 
extension, to look under "all files" and not just files with a .txt extension.  
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7. Open your Ecommerce Plus template online admin section, click on 
Payment Providers and then click on modify for Capture Card. 

 

 
 
8. You want to make sure the processor is "Enabled", select the credit 

card types that you want to use and in the box at the bottom where it says 
"Upload New Certificate" you want to copy and paste all the information 
in your certificate.cer file to the this box, and then click "Submit" to 
upload the certificate information. 

 
Now try a test transaction. After the first checkout page all information will be 
taken on a secure connection.  
 
(For instance https://www.yoursite.com/cart.asp.) For this to work you will 
need to have an SSL certificate installed on your site, and which you can 
obtain from www.thawte.com or www.geotrust.com.  
 
If you do not have an SSL certificate installed then for testing purposes you 
can override this by opening the file vsadmin/includes.asp and set the 
following  
 
pathtossl = "http://www.yoursite.com/" 
 
(Obviously you would replace yoursite.com with the actual name of your site.) 
This will force the system to use an http (unsecure) instead of https (secure) 
connection. 
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You can also use this method if you want to use a different URL for your 
secure connection. Though do remember, both locations must be able to see 
the database. 
 
Also, the switch to secure server relies on the setting of the store URL in the 
admin main page, so do remember to set this properly. 
 
To complete a Capture Card transaction you will need a valid test credit card 
number such as 4111111111111111 and just choose any date. 
 
After completing a test transaction you now want to make sure you can view 
the credit card number. Log in to your Ecommerce Plus admin section and go 
to the orders page. Now click on the order you just made. You should see a 
certificate pop up asking if you want to install Xencrypt by Persits software. 
This is the object that will "decode" your credit card numbers, so please select 
Yes to install this if you wish to view the results of credit card transactions. 
This process only needs to be performed once. Remember to always view the 
admin orders page on an HTTPS connection. 
 
To reduce security risks set the automatic deleting of credit card information 
to a workable minimum level - we would suggest that 2 days is ample time. 
This setting can be found on the main admin page. You can also manually 
delete the credit card information from your database by hitting the "delete" 
button. 
 
Checklist for the ASPEncrypt method 
 
1. Go to http://support.persits.com/encrypt/demo_cert.asp and follow the 

onscreen instructions.  
2. In Internet Explorer go to Tools -> Internet Options -> Content -> 

Certificates  
3. Click on the new certificate and choose "Export"  
4. Select "No" to export the private key  
5. Choose Base-64 encoded X.509 (.CER) as the format  
6. Name the file certificate.cer and save it to you desktop  
7. Open the file certificate.cer in Notepad or your favorite text editor  
8. In your admin section of your ecommerce template open the "payment 

providers" page  
9. Click on "Modify" for the "Capture Card" option  
10. Select the credit card types you want to allow  
11. Paste all the code from the certificate.cer that you have open in 

Notepad to the box entitled "Upload new certificate"  
12. Press submit and test!  
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F.A.Q. 
 

• · What is ASPEncrypt? 
• · What if ASPEncrypt is not installed on the server?  
• · Can I use my host's shared SSL certificate? 
• · What is a personal certificate? 
• · Is this system really secure? 

 
What is ASPEncrypt? 
 
ASPEncrypt is a component that resides on your host's server. It provides a 
client-side ActiveX sub-component, called XEncrypt, which performs all 
cryptographic operations directly on your machine for better security. In 
particular, operations involving the user's private key such as digital signing 
and data decryption can be performed without jeopardizing the security of the 
private key. More information from www.aspencrypt.com. 
Not all hosts have the component installed so it is worth asking - we 
recommend the Windows hosting at www.tokios.net  
 
What if ASPEncrypt is not installed on the server? 
 
Although we strongly recommend using ASPEncrypt, it is possible to use the 
system without by choosing encryptmethod="none" in vsadmin/includes.asp. 
If you decide to use this method, remember to delete the credit card 
information at very regular intervals. The details are still on a secure 
connection but without the added security of encryption. 
 
Can I use my host's shared SSL certificate? 
 
Yes, you can. Alternatively you can apply for your own through a company 
like Thawte, Geotrust or InstantSSL. 
 
What is a personal certificate? 
 
This is a data structure that stores someone's personal information such as a 
name or email address, together with this person's public key. As the credit 
card details are encrpyted, this will be necessary so that only you have 
access to the credit card information through your control panel. 
 
Is this system really secure? 
 
It's as secure as we can possibly make it. If anyone was to gain access to 
your database, they wouldn't be able to see any of the sensitive information 
stored there as it is in an encrypted form. As with any web site, store or 
application you should always pay particular attention to the security issues. 
Remember to secure your database so that it cannot be downloaded, make 
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regular back-ups, change your passwords, make them alphanumeric and if 
you are running your own server, keep your Windows patches updated. 
 
We have provided more information about setting up on a secure server here
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Capture Card (PHP Version) 
 
To set up the "Capture Card" system please do the following. 
 
1. Open your Ecommerce Plus template online admin section, and click 

on modify for Capture Card. You want to make sure the processor is 
"Enabled", select the credit card types that you want to use. 
 

2. Open the file vsadmin/includes.php and set $encryptmethod=""; to 
$encryptmethod="none";. 
 

Now try a test transaction. After the first checkout page all information will be 
taken on a secure connection. ( 
 
For instance https://www.yoursite.com/cart.php.) For this to work you will need 
to have an SSL certificate installed on your site, and which you can obtain 
from www.thawte.com or www.verisign.com. If you do not have an SSL 
certificate installed then for testing purposes you can override this by opening 
the file vsadmin/includes.php and set the following  
 
$pathtossl = "http://www.yoursite.com/"; 
 
(Obviously you would replace yoursite.com with the actual name of your site.) 
This will force the system to use an http (insecure) instead of https (secure) 
connection. 
 
You can also use this method if you want to use a different URL for your 
secure connection. Though do remember, both locations must be able to see 
the database. 
 
Also, the switch to secure server relies on the setting of the store URL in the 
admin main page, so do remember to set this properly. 
 
To complete a Capture Card transaction you will need a valid test credit card 
number such as 4111111111111111 and just choose any date. 
 
After completing a test transaction you now want to make sure you can view 
the credit card number. Log in to your Ecommerce Plus admin section and go 
to the orders page. Now click on the order you just made. Remember to 
always view the admin orders page on an HTTPS connection. 
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To reduce security risks set the automatic deleting of credit card information 
to a workable minimum level - we would suggest that 2 days is ample time. 
This setting can be found on the main admin page. You can also manually 
delete the credit card information from your database by hitting the "delete" 
button. We strongly advise that you delete the credit card information as 
quickly as possible to reduce the security risks. 
 
We have provided more information about setting up on a secure server here
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PsiGate 
 
1. The first thing you will need to do is set up an account with PsiGate. 

 
2. Once you have opened your account with PsiGate and have  been 

accepted, open your Ecommerce Plus Template admin pages and go 
to the Payment Provider section. 
 

3. Now click on Modify next to PsiGate. 
 

 
 
4. Where it says "Merchant ID" you want to enter the "ID" that was sent to 

you by PsiGate. 
 
NetBanx 
 
1. The first thing you will need to do is set up an account with NetBanx. 

 
2. Once you have opened your account with Netbanx and have  been 

accepted, open your Ecommerce Plus Template admin pages and go 
to the Payment Provider section. 
 

3. Now click on Modify next to NetBanx. 
 

 
 
4. Where it says "Merchant ID" you want to enter the "ID" that was sent to 

you by NetBanx. 
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Custom 
 
This option is for anyone wanting to add a payment provider that is not 
currently supported by Ecommerce Templates. 
 
It does require a solid knowledge of coding but this option will make things 
simpler as the database is already set up to handle an extra processor and 
any updates that are made in the future will not overwrite the modifications 
that have been made. If you are not confident about making the changes 
yourself, then we suggest contacting one of the developers here for a quote. 
 
Do be aware also that not all payment systems will fit into the model we have 
provided, but the vast majority should. 
 
We do have a lot of Custom payment providers already set up, so please 
check here for the latest list 
www.ecommercetemplates.com/free_downloads.asp
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Setting up a secure server 
 
Some payment methods like Verisign Payflow Pro, authorize.net (AIM) and 
Capture Card require that the checkout portion of the process take place on a 
secure server. There are two methods of doing this. One is to have a secure 
certificate installed on your web. (Your host can tell you if this is possible with 
your hosting plan). This means that you can access your web using both non 
secure (http) and secure (https) methods. For instance both these URL´s 
would be valid... 
 
http://www.yoursite.com/products.asp 
https://www.yoursite.com/products.asp 
 
If you enable a payment method that does require the checkout on a secure 
server, then the second stage of checkout will automatically switch to a 
secure server. As during testing you may not have a secure certificate 
installed, we have provided a method for you to override this. In your 
vsadmin/includes.asp/php file set the following... 
 
pathtossl = http://www.yoursite.com
 
By doing this you will force the second stage of checkout to remain on a non 
secure (http) connection 
 
One thing to note is that if you are on an https connection and then click on 
say the link to the categories.asp/php page, you will remain on the https 
connection, which is not really desirable. To overcome this you can make all 
your links absolute. For instance, don´t link to categories.asp/php but rather 
link to http://www.yoursite.com/categories.asp 
 
Some hosting providers may provide shared space on their secure server. 
Generally this is a cheaper option as you don´t have to purchase your own 
secure certificate, but it is a bit more difficult to set up. 
 
The first thing you must make sure of is that you can access your database 
from both the secure and the non-secure areas. Your host can tell you if this 
is possible when you contract the secure space. 
 
You will need to make a copy to your secure area of the thanks.asp/php and 
cart.asp/php pages. Also, you will need any images from your images 
directory that are used by these pages and the whole vsadmin directory on 
the secure space. 
 
Now set the pathtossl, for instance... 
 
pathtossl = "https://secure.yourhost.com/yourdir/" 
pathtossl = "https://yoursubdomain.yourhost.com/" 
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http://www.yoursite.com/


 
 
As above, remember to make links in your site absolute to make sure that 
your customers do not get stuck on the secure portion of your site. 

 
© Ecommerce Templates Page 65 of  229 



 

 
 
 
Chapter 3 
Categories and Products 
 
 
Introduction
Accessing the Categories
Adding a new category  
Adding products
Product options
Discounts and coupons
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Introduction 
After setting up the main settings, the next step will be to get your own 
categories and products on your store. The software does come with some 
sample data for you to work. You can have up to 10 levels of sub-categories. 
 
Accessing the Categories 
Select the “categories” link from the left hand menu. 
 
 

The following screen will appear 
 

 
 

The Screen Explained 
Order Category Path: This will give you the hierarchy of your category set 
up. The Home option refers to categories.asp / categories.php. The drop 
down option on the left allows you to order the categories on your store 
(requires MSIE 5+) 
 
Category Name: This is the working name assigned to your category – it may 
be different from the name that appears on your store depending on the 
naming system you have chosen. Text in bold denotes a category that can 
have products added to it. The number in brackets (15) refers to the category 
id and is useful when manually setting up links on the store. 
 
Discounts: Option to assign a Discount 
 
Modify: Modify the properties of the Category 
 
Delete: Delete a Category 
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Adding a New Category 
Click on the New Category button 
 

 
 
The Screen Explained 
Category Name: This is the name of the category that will appear on your 
store. 
 
Category Working Name: This is for internal use only and is useful when you 
have categories that could have the same name. 
 
Sub Category Of…: This drop down allows you to choose the category 
above the one you are adding. In the example above, “Toshiba” will be a sub-
category of “laptop1”. 
 
Category Function: There are two options when setting up a new category. 
The category may have products added to it, in this case select “Products can 
be added to this category”. If there are to be further sub-categories in the 
hierarchy then select “Categories can be added to this category”. It will not be 
possible to add a product to a category that has subsequent sub-categories. 
 
Category Image: This is an optional field where you would place the path to 
the image to accompany the category name. 
 
Category Description: Also optional if you would like to describe the 
category to your users. It is possible to add HTML to this field. 
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Overview 
The multiple category system allows for a hierarchy of up to 10 levels. If you 
inadvertently exceed the 10 levels an error will appear. Products can only be 
added to the last category in your hierarchy. Be sure that when creating sub 
categories you don’t get into a loop of categories when the "Top Category" of 
one of your categories links back to one of its own sub categories. If this 
occurs you will see the error message “LOOP”. You must fix this before 
continuing. 
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Adding products 
Once you have at least one category defined it’s possible to start adding 
products to the store.  
 
1. Click on the “Products” link in the admin section will bring up a page 

with the default list of top categories and categories that come with the 
download: 

 

 
 

Note 
 
Once products 
have been 
added you 
can select the 
link “Show all 
products in 
all sections” 
and this will 
give a 
complete 
listing of 
products on 
your store: 
 
Products 
shown in red 
are currently 
out of stock 
items. 
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Assigning discounts is dealt with at the end of this chapter.  
 
2. Click on “New Product” to add a product to your store.  
 

Below is an example of a product admin page followed by detailed notes. 
 

 
 

Note:  Obligatory fields are marked with a * 
 
Reference: An alphanumeric field, this must be a unique combination and is 
typically the id of the product. By default this isn’t shown on the store but can 
be added in the vsadmin/includes page (more details in our Advanced 
tweaks chapter). 
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Adding a Product Explained 
Section:   

The category where the product will be placed. It is possible to assign a 
product to multiple categories using the additional sections drop down at the 
bottom of the page. 

 
Prod. Name:   

The name of the product that will appear on the store. It is also used for the 
ALT information for the associated product image and is used in the search 
function for locating products. 
 
Price:   

Numeric field for displaying the price of the product. It’s not necessary to add 
a currency symbol as the software takes care of that by taking the information 
from the country settings chosen in the main admin settings. 
 
In Stock:  
 
If using the Stock Management feature this is where you can specify the 
number of products in stock. Choosing the drop down option of “By Options” 
means you have chosen to set Stock Management depending on product 
options rather than the product itself.  
 
Display Product:   

Check the box if you want the product to appear on your store. Uncheck if not. 
This is useful if you temporarily need to remove the listing so you don’t have 
to type in the product information at a later date. 
 
Sell button:  

If this is checked you will generate a “buy button” under the product. 
Unchecked will generate a message “Out of Stock” This text can be edited 
in vsadmin/inc/languagefile. If you need to disable the buy and / or checkout 
button for all your products, please refer to the Advanced Tweaks chapter. 
 
Image:   

This is where you will need to set the path to the small image that is shown on 
your product pages. The default location for the product images is the in the 
folder /prodimages/. We suggest preparing an image here of between 100 
and 150 pixels in width. It’s best to keep the name lowercase and with no 
spaces. If there is no image associated with the product, then leave the field 
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blank. If you need multiple images for a product, then please refer to our 
Advanced Tweaks chapter. 
 
Large Image: 

This is the path to the images shown on the product detail page. Again the 
default location is /prodimages/ and we would suggest a maximum width of 
450 pixels. The field can be left blank if required. 
 
Product Weight:  
 
If you are using UPS, USPS or weight based shipping then you will need to 
enter a value here as it will be the base for shipping cost calculations. The 
value you set is up to you, meaning that the example of “6” above can mean 6 
kilos or 6 pounds, depending on how you want to work. A value of 6.5 would 
be 6 kilos 500 grams or 6 pounds 8 ounces. 
 
Product Options:   

This is where you can stipulate the number of product options associated with 
each product. When you choose one or more from the drop down, the product 
options field will appear below with drop downs for selecting the choices you 
set up through the product options admin page. 
 
Description:   

As the name suggests, a place to describe your product. This is searchable 
from your search page so it is best to make it keyword rich and informative. It 
is also possible to add HTML to the field for formatting, links etc. There is 
more information in the Advanced Tweaks chapter. 
 
Long Description:   

The text here will appear on the product detail page. Again it is possible to 
add HTML. Leave blank if you do not require a details link from your main 
product page. 
 
Exemptions:   

It is possible to make products tax exempt. Multiple choices can be made by 
pressing and holding down the <ctrl> key whilst selecting. 
 
List Price:   

Here you can show the manufacturers recommended price of a product. On 
the store your main price will be shown below with the list price in a lighter 
color and crossed out. The appearance can be changed in 
vsadmin/inc/languagefile. 
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Additional Sections:   

As mentioned above it is possible to associate a product with multiple 
categories. First you need to choose the number of categories the product is 
to be placed in. 
 

 
 

Once the number is selected you should be presented with the same number 
of drop downs where it is possible to choose the relevant categories. 
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Product Options 
By default each product can have up to 15 product options, although this can 
be changed in the vsadmin/includes file. 
 

 
 

Selecting “New Option” will allow you to set up a new group of product 
options that can be associated with one or more products.  
  
Selecting “Clone” will allow you to make further copies of the product option 
information without having to type all the information in a second time. This is 
useful if you have product option sets that are very similar. Just click on clone 
and give the option a new Working Name and / or Option Name as 
appropriate.  
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Product Options Cont . . . 

 
 
Option Name:   

This will be the text that appears on the store below the product description 
and next to the drop down menu for options. 
 
Working name:   

This if for internal use only. It may be that there are several product option 
groups that would normally have the same name eg. Size (for shoes) Size (for 
shirts) Size (for pants). By giving each a different working name, it is easier to 
select the appropriate group for each product. 
 
Force Selection:   

If this is checked the field becomes obligatory and the purchaser has to 
choose an option to continue. 
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Price Diff (%):   

Any price changes between the options chosen will be shown in real time on 
the store. If there is no price difference for a product option then leave the 
fields blank. If the product option costs $1 more than the base price then add 
one to the box. If the product option costs $1 less than the base price then 
enter –1. 
 
If the price difference is a percentage of the total base price then check the 
(%) box and add the percentage change to the price diff boxes eg 10 would 
add 10% to the base price. The base price is the one set in the product admin 
page. 
 
Weight Diff(%):  

It may be that a product option choice would involve an increase in weight of 
the product to be shipped. You can modify the weight in much the same way 
as the price as a flat rate, or as a percentage if the (%) box is selected. 
 
New Text Input Option:  

Sometimes it’s not possible to have a product option in a drop down menu as 
it is up to the purchaser to choose their own. An example of this would be if 
for example you were selling baseball caps that had a special slogan on them 
or were offering domain names for sale. The Text Input Option allows for 
custom user input. 
 

 
 

Note 
 
You can set default text in the field that appears on your store, this would be 
something like “Add your slogan here” or “www.domain.com” from the 
previous examples. It’s also possible to set the height and width of the input 
box as well as making the field obligatory. 
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Discounts and Coupons 
Discounts and coupons are powerful marketing tools that allow you to give 
your clients special offers on products or categories, allow wholesalers to 
purchase at special rates, provide incentives through your offline advertising 
or help clear "difficult to sell" stock amongst many other uses. Once you have 
set up the discounts and coupons you wish to use on your store you can go 
back to the product / category admin pages to assign the ones you want to 
use. 
 

 
 
This explains the options you will see when you go to add a new discount or 
coupon. 
  
Coupon or discount:   

The difference between a coupon and a discount is that a coupon will need a 
special code to be entered during the checkout phase for it to be applicable. A 
discount however will apply to all of your website visitors, as long as the 
conditions you can set below are met. Coupons are especially useful 
therefore for promotions in magazines or through other advertising. 
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Coupon / Discount Effect:   

You can choose between Free Standard Shipping, Flat rate discount or 
Percentage discount. You can set up more than one coupon or discount at a 
time to have combinations of these. 
 

• A flat rate discount would be for instance "$20 off if you spend over 
$150 on our store". 

 
• A percentage discount would be for instance "5% discount on all our 

goods". 
 
Working Name:   

You have to assign a name or phrase to the discount you create. This text will 
also be shown to your website visitors to inform them of the discounts 
available so it should be meaningful and short. Examples of "Working Name" 
would be: 
 

• "Free Standard Shipping on orders of $35 or more" 
 
or 
 

• "10% discount if you buy 3 or more products from our store" 
 
Coupon Code:   

If you are creating a coupon, you will need to assign a coupon code. This is 
the code your website users will need to enter to access the discount. For 
instance, if your coupon code is GH777733D then in your magazine 
advertising you could put the following "Special offer for readers of this 
magazine. Enter the code GH777733D during checkout to receive a 5% 
discount". 
 
Number Available:   

With some promotions you may want to limit the number available. For 
instance: 
 

• "5% discount to the first 50 people who purchase". 
 
If you do not want to limit the number available, just leave this field blank. 
 
Number Days Available:  

Allows you to set a time limit in days. If you do not want to limit the time 
available, just leave this field blank. 
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Min Max Purchase Amount:  

This allows you to set minimum and maximum purchase limits for discounts to 
apply and also the ability to include discounts and coupons within a banded 
range that can be defined here. So for example, spend between $50 and 
$100 products for a 5% discount - spend between $100 and 150 for a 10% 
reduction etc. 
 
...or you could have a simple set up like $25 off all orders over $100. 
If you do not want to use this feature, just leave the fields blank.  
 
Min / Max Quantity:  

This allows you to set minimum and maximum limits for discounts to apply 
and also the ability to include discounts and coupons within a banded range 
that can be defined here. So for example, buy between 5 and 10 products for 
a 5% discount - buy between 6 and 10 for a 7% reduction etc. 
Also note that if your "banded" discounts have the same name they will only 
be displayed once which can be advantageous. For instance the case where 
For every 11 products purchased, get one free. 
If you do not want to use this feature, just leave the fields blank.  
 
Discount Amount:  

The actual amount of the discount. For instance for a Percentage discount of 
10%, just enter 10 here. For a flat rate discount of $15, just enter 15 here.  
 
Please note that for Free Standard Shipping, this value is ignored. 
 
Scope:  

You may want to have a discount of 5% if your customer buys 5 of a certain 
product. You may however want to offer a discount of 5% if your customer 
buys 5 of any product on your website. 
Likewise if you wanted to offer a discount of 5% if someone spends $50 or 
more on one particular product, or you may want to offer a discount of 5% if 
someone spends $50 or more on your website as a whole. 
 
The "Scope" allows you to do both of these types of discount. 
 
You would use the setting "Applies storewide to product totals" for setting 
up a discount which applies to product totals on total purchase on your store.  
 
Once you have set up a discount of this type it is automatically in effect and 
you need do no more. 
 
"Assign to cat’s for discounts on category totals" allows you to narrow 
down the effect of a discount to individual categories. Now go to the 
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categories admin page and you should see a column "Discounts" and click on 
the "Assign" button. 
 
"Applies storewide but to individual products" would set up a discount 
that applies to totals of a particular product. Now go to the products admin 
page and you should see a column "Discounts" and click on the "Assign" 
button. 
 
"Assign to individual products / cats" allows you to narrow down the effect 
of a discount to an individual product or category. Once you have created this 
type of discount, you can then assign it to a particular product or category. To 
do this, go to your products or categories admin pages and you will see a 
column "Discounts" with a button  
 
Restrict to certain countries:  

This setting only applies to "Free Standard Shipping". It enables you to set 
free shipping only for orders within a particular country. To set the countries to 
which free shipping applies, go to your countries admin page and you will see 
a column "FSA" which stands for "Free Shipping Applies". Only those 
countries checked will be eligible for free standard shipping. Remember that a 
rule will have to be set up first in your discount admin page for this to apply. 
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Chapter 4 
Orders and Affiliates 
 
 
 
Orders admin
Order details
Order status types  
Affiliates program
Drop shipping 
Customer login
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Orders admin 
 
Hopefully the Orders Admin page will be the one you will visit most so it is important 
to know your way around. You will receive a notification email for each order that is 
placed through your store but it is a good idea to check the page regularly in case the 
purchaser didn’t make it back to your store after buying and the email notification 
wasn’t triggered. 
 
Clicking on the View orders link should bring up the orders admin page: 
 

 
 

The interface here will provide you with all the information on orders as well 
as the ability to search your order database, change the order status, 
download orders etc. 
 
To take advantage of the advanced search features, click on “Power Search”. 
 

 
 
The various options on this screen are outlined below: 
 
To refine the search options you can select one or a combination of parameters: 
 
Orders From / On – Orders Till: This is where you can specify a date range. 
Clicking on the “DP” button will bring up a calendar for easier date selection: 
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It is also possible to add single numbers to the From / Till fields. If you need to view 
orders between the last 2 to 4 days then place 2 in the Orders From box and 4 in the 
Orders Till. If you need all orders for the previous 4 days then place 4 in the Orders 
From box and leave the Orders Till field blank. 

 
Order ID: if you know the order id you want to check then placing the number here 
will bring up the details of that particular order eg. Type “503” to view the details of 
order number 503. 
 
Search Text: This will allow you to perform a search on the following parameters: 
authorization number 
order name 
email address 
address 
city 
state 
zip 
phone 
…and can be further refined by choosing the date selection and/or Order 
Status. This will also come in useful for your marketing when you can make 
advertising decisions based on where your orders are coming from. 
 
Order Status: This allows you to view all orders dependent on the status of those 
orders. For example you can view all Completed Orders over a particular date range. 
 
Start with power search: Selecting the checkbox will set a cookie so that the 
advanced search panel appears each time you visit the Orders Admin page. 
 
Power Search: Clicking will hide the advanced search panel. 
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Order details 
 
When viewing the order admin page or looking at the results of a search you will be 
presented with a table of results: 
 

 
 

Order ID: This is the order number and the first order on your store will be 
“501”. Click on the order number or on the Name to bring up the full details of 
that particular order. 

 
 
Printing the invoice / packing slip 
If you press <ctrl> and click the Order ID at the same time you will be 
presented with a printable version. (PC and Microsoft Explorer only. Other 
combinations will have to select the Printable Invoice Checkbox at the bottom 
of the page). 
You can add your own header, address and footer to smarten it up – to do this 
you will need to make the changes in your vsadmin/includes.asp/php file there 
are details in our Advanced tweaks chapter and on our parameters page. 
 

 

 
© Ecommerce Templates Page 85 of  229 



 

Method: This will show how the client has paid. Information in red will indicate 
an uncompleted order. 
 
Auth code: This is a very important field and particular attention should be 
paid to the message that appears here. Under normal circumstances, when 
an order goes through an authorization code will appear here – this means 
that the order has been received and the purchaser has returned to your store 
and should have received email notification of their purchase. If you see an 
“authorize” button, as in the example above, the most likely reason is that the 
buyer abandoned the cart before going through with checkout. It may be that 
they changed their mind, suffered a power failure or were simply testing the 
system, however it may also be possible that they never made it back to your 
store after purchase. For this reason it’s important to check with your credit 
card processing admin page before deleting or authorizing. If you find that the 
order did in fact take place then you can click on the authorize button and add 
the authorization code given by the payment processor. If there is no record of 
the order you can delete from the drop down in the “Status” field. 
 
Status: This is where you can set the status of your order and the default 
options are unauthorized, cancelled, deleted, authorized, packing, shipping, 
shipped, completed. It is possible to change these values in Admin Order 
Status page to give a clearer message to the public if they choose to view the 
status of their order. 
Using Internet Explorer on a PC there is a quick method for changing lots of 
order status at once. If you say change an orders status to "Shipped" and hold 
down the Ctrl key the all the orders on that page will have the status changed 
to shipped. This is not available on other browsers. 
 
 
Purge deleted: Once an order is deleted, it will remain in the system for 3 
days – this is a security measure in case an order is deleted by mistake. 
Selecting “purge deleted” will remove all trace of deleted orders. 
 
Dump orders to CSV file: Clicking here will prompt a download of the orders. 
This can be opened in Excel. It will give details of the order such as address, 
price, quantity and shipping. 
 
Dump details to CSV file: This will also include the product information. 
 
At the bottom of the page it is possible to quickly flick through date ranges, for 
example, orders from a month ago, a week ago, yesterday etc. 

 
86  © Ecommerce Templates 



 
 
Order status types 
 
It is possible to configure up to 18 parameters for the order status by clicking 
on the “Edit Order Status Types” on the main admin page. 
 

 
 

The first four options are pre-defined ie. Cancelled, Deleted, Authorized, 
Unauthorized. It is possible to change the text that the public will see when 
checking their order status but the meaning will be kept the same. For 
example changing the wording for “Authorized” will not change it’s meaning 
for the store software. 
 

 
 

The following fourteen order types are free to edit as you wish. 
 
The customer can view their order status details through the page 
www.yourstore.com/orderstatus.asp/php 
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ASP: If you do not have this page on your ASP site then open the page products.asp 
save it as orderstatus.asp and then in HTML view find the include line: 
<!--#include file="vsadmin/inc/incproducts.asp"--> 
and change it to: 
<!--#include file="vsadmin/inc/incorderstatus.asp"--> 
Save the page and upload to your server with the other store pages in the root 
of your web. 
 
PHP: If you do not have this page on your PHP site then open the page products.php 
save it as orderstatus.php and then in HTML view find the include line: 
<?php include "vsadmin/inc/incproducts.php"; ?> 
and change it to: 
<?php include "vsadmin/inc/incorderstatus.php"; ?> 
Save the page and upload to your server with the other store pages in the root 
of your web. 
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Affiliates program 
 
This enables you to run a complete affiliate suite from your site - potential 
affiliates can sign up and enter their information and password, and you can 
view the orders they generate through the online admin section. 
 

 
 
How the affiliate program is run is completely up to you - you decide on the 
percentage that will be paid out, how often and by what method - all the 
partner needs to do is place a link on their site including their partner code to 
earn commission. 
By default the affiliate cookie is set to 30 days - this means that if someone 
visits your site through an affiliate link one day and buys on another the 
partner will earn the commission as long as 30 days haven't passed since 
their first visit. You can change how long you want a cookie to stay actives in 
the file vsadmin/includes.asp/php 
 
If you need to specify a default percentage that your referrers will earn, you 
will need a minimum of version 4.5.0 and add the corresponding parameter in 
the vsadmin/includes.php / .asp page 
 
How to set it up
Basically everything is in place for you to get started immediately - each 
template comes with a file called affiliate.asp/php - this will be where the 
partner can sign up and also log on to their account. 
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The partner can choose to be notified by email of each affiliate sale that is 
made and the store owner can check the status of the account through the 
online admin. You may want to make a page or two previous to 
affiliate.asp/.php explaining the procedures etc. for earning commissions and 
also a disclaimer. 
 
Important information
The referring URL will typically be in the form of 
http://www.ecommercetemplates.com/default.asp?PARTNER=name - you 
can ask affiliates to link to individual pages or sections by changing the URL 
before the question mark, for example 
http://www.ecommercetemplates.com/products.asp?PARTNER=name but it's 
very important that the page is linked to is a .asp/.php page and includes the 
following lines of code: 
ASP version: 
<!--#include file="vsadmin/db_conn_open.asp"--> 
<!--#include file="vsadmin/includes.asp"--> 
<!--#include file="vsadmin/inc/languagefile.asp"--> 
<!--#include file="vsadmin/inc/incfunctions.asp"--> 
 
PHP version: 
<SCRIPT LANGUAGE="php"> 
include "vsadmin/db_conn_open.php"; 
include "vsadmin/includes.php"; 
include "vsadmin/inc/languagefile.php"; 
include "vsadmin/inc/incfunctions.php"; 
</SCRIPT> 
 
 
 
 
 
 
 
 
 
 
Drop shipping 
How it works 
This feature was added in Version 4.8.0 and allows you to group products per 
manufacturer, designer, dropshipper etc., keep track of the sales per group 
and includes the ability to send an email notification when a particular order is 
placed through your store. This may be to the drop shipping company, a 
manufacturer, a contributor or anyone really you need to notify of a sale. 
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How to set it up 
The first thing you will need to do is set up an account for each drop shipper / 
manufacturer so click on the link Dropshipper / Designer / Manufacturers link 
from your admin home page and you will be presented with a screen like this. 
 

 
 
Click on the button "Click to Add New" and you will be able to set up the 
details. 
 

 
 
Fill in all the details. If you want the drop shipper to receive notification of a 
sale with details of the order then select "Send Email" from the drop menu. 
Once you have set up the accounts for each entity you can then choose who 
needs to be notified from the drop down box on the product admin pages. 
 

 
 
Sales can then be tracked through the dropshipping admin page. 
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The email address is clickable so you can contact the person directly and it's 
also possible to modify their details or delete the entry from the dropshipping 
admin page. 
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Customer login 
 
In Version 4.2.0 we introduced the customer login feature. This allows for 
wholesale pricing / tax / shipping exemption for login customers and page 
protection. This means it is possible to offer retail and wholesale pricing 
without the need for a second database as well as offering tax and shipping 
exemption to particular users. You can also restrict access to certain pages of 
your site. 
 
 
ASP Version 
PHP Version

 
Enabling customer login (ASP Version)
If you would like to have a login status box on each page you will need to add 
one line of code where you would like the login box to appear. The code you 
need is the following: 
 
<!--#include file="vsadmin/inc/incminilogin.asp"--> 
 
Paste that into HTML / code view exactly where the login box should appear 
and make sure that it comes somewhere after the include lines: 
 
<!--#include file="vsadmin/db_conn_open.asp"--> 
<!--#include file="vsadmin/includes.asp"--> 
<!--#include file="vsadmin/inc/languagefile.asp"--> 
<!--#include file="vsadmin/inc/incfunctions.asp"-->  
 
To enable the login you will then need to go to vsadmin/includes.asp and add 
the line (if it's not already present) enableclientlogin=true 
 
Finally you'll need to set up the login page itself. Open your thanks.asp page 
and save it as clientlogin.asp. Then go in to HTML / code view and locate this 
line: 
 
<!--#include file="vsadmin/inc/incthanks.asp"--> 
 
....and change it to 
 
<!--#include file="vsadmin/inc/incclientlogin.asp"--> 
 
Save clientlogin.asp and upload it to your server. 
 
You should now be able to see the login box and the login page on your store.
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Login Box 

 

 
Login Box after successful login 

 

 
Login Box if enableclientlogin=true 

hasn't been set in vsadmin/includes.asp 
 
 

 
Login Dialogue on clientlogin.asp 

   
 
Setting up a client 
In your home admin page there should be a link client login admin, click to 
set up your clients' options. 
 

 
 

Click on new client login to add the details and parameters available for 
each particular customer. 

 
94  © Ecommerce Templates 



 

 
 

Enter the client name, password, the relevant action (You can use CTRL + 
Click to select more than one choice) and finally the login level. When done, 
click on submit and your client will have been set up with the parameters you 
have assigned. 
 
Login level 
You can assign different levels of login permissions on any page to say that a 
particular page is restricted to anyone below the login level assigned in the 
login admin section. For example, if you set requiredloginlevel=4 then only 
people who you have set up with a login value of 4 or above can view the 
page when logged on. Only place the code on the pages where you need to 
restrict access, for example, it should not go on clientlogin.asp 
To add the level of restriction to individual pages you will need to add the line: 
<% requiredloginlevel=4 %> 
...where 4 is the threshold of permission for that page. This needs to come 
anywhere before the line 
< !--#include file="vsadmin/inc/incfunctions.asp"-->  
 
 

Enabling customer login (PHP Version) 
If you would like to have a login status box on each page you will need to add 
one line of code where you would like the login box to appear. The code you 
need is the following: 
 
<?php include "vsadmin/inc/incminilogin.php"?> 
 
Paste that into HTML / code view exactly where the login box should appear 
and make sure that it comes somewhere after the include lines: 
 
<?php include "vsadmin/db_conn_open.php"?> 
<?php include "vsadmin/includes.php"?> 
<?php include "vsadmin/inc/languagefile.php"?> 
<?php include "vsadmin/inc/incfunctions.php"?> 
 
To enable the login you will then need to go to vsadmin/includes.php and add 
the line (if it's not already present) $enableclientlogin=true; 
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Finally you'll need to set up the login page itself. Open your thanks.php page 
and save it as clientlogin.php. Then go in to HTML / code view and locate this 
line: 
 
<?php include "vsadmin/inc/incthanks.php"?> 
 
....and change it to 
 
<?php include "vsadmin/inc/incclientlogin.php"?> 
 
Save clientlogin.php and upload it to your server. 
 
You should now be able to see the login box and the login page on your store. 
 

 
Login Box 

 

 
Login Box after successful login 

 

 
Login Box if $enableclientlogin=true; 

hasn't been set in vsadmin/includes.php 

 
Login Dialogue on clientlogin.php 

   
 
Setting up a client 
In your home admin page there should be a link client login admin, click to 
set up your clients' options. 
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Click on new client login to add the details and parameters available for 
each particular customer. 
 

 
 
Enter the client name, password, the relevant action (You can use CTRL + 
Click to select more than one choice) and finally the login level. When done, 
click on submit and your client will have been set up with the parameters you 
have assigned. 
 
Login level 
You can assign different levels of login permissions on any page to say that a 
particular page is restricted to anyone below the login level assigned in the 
login admin section. For example, if you set requiredloginlevel=4 then only 
people who you have set up with a login value of 4 or above can view the 
page when logged on. Only place the code on the pages where you need to 
restrict access, for example, it should not go on clientlogin.php 
 
To add the level of restriction to individual pages you will need to add the line: 
 
<?php $requiredloginlevel=4;?> 
 
...where 4 is the threshold of permission for that page. This needs to come 
anywhere before the line 
 
<?php include "vsadmin/inc/incfunctions.php"?> 
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The last thing you need to do is find the code at the top of your page that 
looks like this: 
 
<?php 
session_cache_limiter('none'); 
session_start(); ?><html> 
 
...and change it to: 
 
<?php 
session_cache_limiter('none'); 
session_start(); 
ob_start(); ?><html> 
 
..making sure there is no space before the code and you just have the one 
opening <html> tag. 
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UPS Shipping 
 
Setting up your Ecommerce Plus template to automatically use the UPS 
Online® Tools Rates & Service Selection to automatically calculate your 
shipping costs is a simple matter. Just follow the steps below. 
 
Firstly, log in to the admin section for your Ecommerce Plus template and 
click on "main settings" using the menu on the left. From the Shipping Type 
dropdown menu select UPS Shipping. 
 

 
 
On the same page you will see a setting "Shipping Units" where you can 
define the weight units that are used to define your product weights. Please 
note that the shipping units are limited in some countries. Notably, the United 
States is limited to specifying product weights in lbs and ounces. 
 

 
 
Now, go back to the admin home page by clicking on "home" on the left 
menu. Click on the text link near the bottom of the page which says "Register 
with UPS" and follow the steps in the registration wizard. 
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After completing the UPS Wizard you are now ready to test your system. Try 
adding a product to your cart where you know the weight of the product. Then 
in the checkout phase after filling out your customer and shipping information, 
you should see the available UPS shipping options along with the associated 
costs. You should do a couple of tests to make sure they match what you 
would expect from the UPS online shipping calculator at http://www.ups.com/. 
 
NB. If you receive the following error at this stage . . . 
This measurement system is not valid for the selected country 
. . . then this means that you have to return to the Ecommerce Plus admin 
section, "main settings" page to change the Shipping units you are using from 
lbs and ounces to Kilograms or vice-versa. 
 
If you are using the PHP version and receive blank page instead of the UPS 
Wizard then contact your host and ask them if they have the cURL component 
installed. This is a free download and is available on the majority of hosting 
plans. 
 
Oversize Packages. 
For each OS1 package, set the product weight to be 30 pounds. 
For each OS2 package, set the product weight to be 70 pounds 
 
The way that you deliver your packages to UPS for delivery can affect the 
total cost of delivering the package. You can change the pick up type by 
setting the following in your vsadmin/includes.asp or vsadmin/includes.php file 
. . . 
 
upspickuptype="03" 
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The code in quotes there would be taken from the following table... 
 
01 - Daily Pickup 
03 - Customer Counter 
06 - One Time Pickup 
07 - On Call Air 
19 - Letter Center 
20 - Air Service Center 
 
Remember to enclose the code above in double quotes. Also, please note 
that these options are not exactly the same as you might find on the UPS 
website but we hear that is something that UPS are working on. 
 
UPS Order Tracking 
It's possible for customers to track their orders from a page on your site - if 
you don't have the tracking page, all you need to do to enable it is take a copy 
of products.asp and call it tracking.asp 
Then go to HTML view and change the line 
 
<!--#include file="vsadmin/inc/incproducts.asp"--> 
 
to 
 
<!--#include file="vsadmin/inc/inctracking.asp"--> 
 
For the PHP version take the page products.php and save it as tracking.php 
Then go to HTML view and change the line 
 
<?php include "vsadmin/inc/incproducts.php" ?> 
 
to 
 
<?php include "vsadmin/inc/inctracking.php" ?> 
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USPS Shipping 
 
Setting up your Ecommerce Plus template to automatically use USPS 
shipping is pretty simple as the majority of the integration has been done for 
you. Just follow the steps below. 
 
US and overseas shipping costs are automatically calculated according to 
product weight and destination. To activate USPS shipping method you need 
to register for a username and password. The process is quite simple and the 
registration form is available at . . .  
http://www.uspsprioritymail.com/et_regcert.html  
 
Make sure you follow the link for the API password request, not the "Shipping 
Assistant". 
 
You will receive a long email from USPS with information regarding testing the 
system before going live on the production server. We have already done this 
step for you so that can be ignored. All that is needed is to follow the 
instructions for going live on the production server. 
 
The final step for using USPS shipping is to enter your ZIP code in the admin 
main panel along with your USPS username and password. These are used 
in determining shipping costs within the USA.  
 

 
 
 
Once you have selected USPS shipping in the admin main page 
 

 
 
…then you should see a link "Edit UPS Shipping Methods" on your admin 
home page and that is where you can select the shipping methods that your 
package shipment can use. 
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There's no more to it than that really, and as all the integration has already 
been provided in the software you should be up and running with USPS. 
 
All that is left to do is to add the weight of each product as they are added 
through the product admin section. The shipping cost will then be calculated 
on checkout depending on the origin, destination and weight of the order. 
 
IMPORTANT NOTE: After you apply to the USPS, you will receive an email 
from them with your username and password. In this email will be a couple of 
lines about how to switch your profile to allow you access to the production 
server. Until you follow this step you will receive an error in checkout about 
not being authorized on the server. 
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Other Shipping Methods 
 
No shipping 
As the name suggests, this is the option to choose if there are no shipping 
costs involved. 
 

 
 
Flat rate shipping 
If you select flat rate shipping you can enter 2 shipping costs in the product 
admin section. One is for the cost to ship one of an item, and the second is 
the cost to ship the second and subsequent instance of an item. First select 
Flat rate Shipping from the main admin settings page. 
 

 
 
If the cost for the first item is $5.00 and the cost for the second and 
subsequent is zero then total shipping cost will be $5.00 however many of a 
product is shipped. Second and subsequent is for one particular product only. 
If you sell one product x and one product y then both will be charged the first 
shipping cost. These values can be set in your product admin pages. 
 

 
 
If you want it so that store wide to ship one of any product is $XX and to ship 
any second and subsequent product is $YY then you would have to use 
weight based shipping. 
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Weight based shipping 
Shipping is calculated by product weight according to the shipping zone to 
easily facilitate national and international shipping. If weight based shipping is 
selected, then the country zone can be set in the countries admin panel, and 
new zones can be edited by following the Edit Postal Zones link in the main 
admin panel. 
 
The first thing to do is select weight based shipping in your main admin setting 
page 
 

 
 
The system works such that you can set a series of weight limits and shipping 
costs for packages up to those weight limits. The weight limits are set in the 
admin postal zones page. The weight can be in pounds, kg, ounces, 
whatever. You give it meaning by what you enter as the product weight in the 
products admin page. 
 

 
 
For instance, if you have entered a weight of 2.4 in the products page, and 
that to you means 2.4 kilos, then if your weight limit is up to 3 then that is up 
to 3 kilos also. With the price, that will be whatever the currency you use is. If 
it is 4.5 and you use dollars, then it is $4.50. 
 
After adding your product weight to the products, you’ll need to set up your 
zones and rules in the admin postal zones page. Set up the names of the 
zones you would like to use. 
 

 
 

Now click on the “Edit Rules” link to set up your weight / price ratio. 
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If your highest weight is 50 and the price for that is $5.00, and you set "For 
every 5 above the highest weight add an extra 0.5" then at a weight of 55, the 
price would be $5.50, at a weight of 60 the price would be $6.00 and so on. 
 
The final step is to make the relation between the zones you have set up and 
the countries corresponding to those zones. Click on your admin countries link 
and you should see a full list of counties and various options. 
 

 
 
Enabled Tick the boxes next to the country name for the countries you want 
to ship to. These will appear in a drop down menu on the checkout page. 
Some countries have worse reputations than others regarding fraud so you 
might want to bear this in mind when making your selection 
 
 
Tax If you need to set a particular tax rate for a country, it can be entered 
here. For example if you are based in the UK you may be obliged to add VAT 
to all UK orders, in that case you would want to add 17.5 to the tax box. 
 
FSA This stands for Free Shipping Available. Tick the box if you want to offer 
free shipping to certain countries. In addition you will need to set this up as a 
discount or coupon in your discount admin page. 
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Position This refers to the position of the country in the drop down menu that 
appears on the checkout page. On Top of Top will be the first country that 
appears, On Top will override the rest, which can be sorted alphabetically. 
 
Postal Zone Indicates the zones you set up in your admin postal zones page. 
Use the drop down choices to match the country with your zone. 
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Price based shipping 
The idea here is very similar to weight based shipping but you would need to 
define the price per postal zone rather than weight. 
 
First select Price based Shipping from you main admin page. 
 

 
 
Then click on "Postal Zones". As an example fill in Max Price with 1 in the first 
column and 1 in the second column - that would mean that the shipping cost 
of items up to a price of $1 would be $1, and in the example below prices up 
to $5.00 would be charges at $2.00 - continue like that until you have all the 
prices you require. The highest price option means that over a price of $50, 
$0.50 will be added to shipping for every increment of $5 in the price of the 
product. The examples here are in dollars but of course this would depend on 
the currency you are using on your store ie. “5” could mean dollars, pounds, 
euros etc. 
 

 
 

You would then need to set up your postal zones as explained above in 
Weight Based Shipping. 
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Further Options 
 
Standard / Express shipping 
The examples above are only for Standard shipping rates but it is possible to 
split them into Standard and Express. 
 

 
 

In the admin postal zones page you may see the above message, clicking on 
the link will give you the opportunity to set to rates for different shipping – one 
for “Standard” and one for “Express”. 
 

 
 

This option can be used for weight based and price based shipping and the 
text for “Express” and “Standard” that will appear on your store can be 
modified in the file vsadmin/inclanguagefile.php/.asp 
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State Zone Rules 
In the examples above we split the zones into countries or world zones but it 
is possible to further fine tune these options by assigning different rates per 
state / province / county. 
 

 

 
 

In the Postal Zones page it’s possible to split the shipping zones into States. 
 

 
 
You can then edit the rules, much the same as for the World Zone Rules 
previously. 
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Shipping States 
Clicking on the shipping states link will bring up a list of States. This is where 
you can change the tax rate per state. By default the list will be US States but 
this can be overwritten by applying our regional plug in available at 
www.ecommercetemplates.com/free_downloads.asp
 

 

 
 

You can also choose which states will appear in the drop down menu on 
checkout by selecting them here. 
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Pack products 
On the main admin settings page there is a drop down choice of packing 
products separately or together, which will affect the final price of shipping for 
USPS, UPS and Weight Based Shipping. 
 
 

 
 
Choosing the packing products together option will calculate the shipping 
price based on the total weight of the package. Packing products separately 
will calculate the shipping cost as a sum of the individual postage cost. 
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Shipping FAQ 
Can I show shipping costs before checkout?
Can I use multiple shipping methods?
I don't need to charge a per item shipping...someone can order 1 product or 
20 products and I charge the same amount - I want them to have the option of 
choosing either standard or express and not be charged per item.
I want to charge $5 for the first item entered into the cart, and then $1 for each 
additional item. What method should I use?
How do I set up shipping based on a percentage of the final sales price?
How do I add tax to shipping?  
 

Can I show shipping costs before checkout? 
That's not really possible as the cart doesn't have the information of where the 
items have to be shipped to. One suggestion is to set up a static shipping 
charge page outlining costs and directing customers there. 
 

Can I use multiple shipping methods? 
It's not possible to mix 'n' match shipping methods. 
 

I don't need to charge a per item shipping...someone can order 1 
product or 20 products and I charge the same amount - I want them to 
have the option of choosing either standard or express and not be 
charged per item. 
Using weight based shipping, set every product a very low weight, (say 0.1). 
Then set up your postal zones with only one rule per zone, which has a very 
high max weight, (say 9999) and the cost as your shipping cost. On the admin 
main page make sure "pack products together" is set. 
 

I want to charge $5 for the first item entered into the cart, and then $1 for 
each additional item. What method should I use? 
Use weight based shipping and set every weight to 1 to make things easy. 
Then in the postal zones section, set the rules so that a weight of 1 is $5, a 
weight of 2 is $6 and for each 1 above the highest weight add an extra $1. 
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How do I set up shipping based on a percentage of the final sales price? 
In the admin main page set up the shipping type to price based shipping. 
Then for the postal zones admin page click on edit rules, and then just set 
something like... 
for every 1 above the highest weight add an extra 0.2 which would charge 
shipping at 20%. 
for every 1 above the highest weight add and extra 0.35 
..which would add shipping at 35%. 
 
The first example for instance would round to the nearest 20 cents of course, 
but you could say 
 
for every 0.5 above the highest weight add an extra 0.1 
 
 

How do I add tax to shipping? 
Open the file vsadmin/includes.asp or php and change taxShipping=0 to 
taxShipping=1. 
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Introduction 
 
The great thing about working from templates is the simplicity of setting up the 
design of your store to reflect your products and needs. The hard work of 
preparing the layout of the store is already done for you – from there you can 
change color schemes, add your own graphics and modify the existing ones. 
 
All the templates come with .png files. These can be edited in Fireworks from 
Macromedia – they have a 30 day free trial available if you don’t already have 
the program. 
 
Graphics and sections, which are repeated on many pages, are usually set up 
as include pages for Frontpage, components for GoLive or form part of the 
Dreamweaver .dwt file or library items. 
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Using Macromedia Fireworks 
You don’t have to own a copy of Fireworks to work with our templates but it 
does make graphic editing simpler. The .png files are found in the 
images/extras folder. There are blank gifs which you can use in other graphics 
programs to add your own text to. 
 

Editing text 
File>Open and browse to the image you need to edit and click on the text tool, 
the icon is an “A” 
 

 
 
Place your cursor on the text and type your wording. 
 

 
 
Save your graphic by going to File>Export Preview 
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Choose the format (usually as a GIF) and settings you want for the graphic, 
paying particular attention to file size / quality 
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You can change the color of the text by choosing the select tool (the white 
arrow). 
 

 
 
Click on the graphic and select the color from the properties window. 
 

 
 
You can also change the font by selecting from the drop down list in the same 
window. 
 

 
 
If you need to change the background color choose Modify>Canvas>Canvas 
Color. 
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Effects such as drop shadow, bevel etc. can be added by clicking on the plus 
sign next the word “effect” in the properties window and selecting the options 
until you get the look that best suits your needs. 
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Editing graphic colors 
Most of the templates have small rounded corner graphics, menu tops or 
bottoms etc., which are easily changed. These usually consist of a 
background color, which can be changed as above and a rounded image 
which is modified by selecting it and changing the color in the properties 
window. 
Often a graphic is made up of different layers – in Fireworks you can see 
them in the Layers Window. 

 

 
 
Click on the name and you’ll see the layer highlighted and the properties 
window will show the color and any effects that have been applied. 
 

 
 
You can change the color of the individual elements (layers) by clicking on the 
color next to the paint icon and selecting the color of your choice. 
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NB There are quite a few windows available in Fireworks, probably the most 
important being the tools and properties – if you don’t see these, select them 
from the “window” menu at the top of the screen. 
 
Always export your graphic by going to File>Export Preview and choosing the 
format (usually as a GIF) – it’s best not to use .png files on your site as not all 
browsers recognize the format and the file size will be much larger too. 

 
© Ecommerce Templates Page 123 of  229 



 

 
Batch processing 
A very useful feature of most graphics programs is the ability to change a 
large number of graphics to the same specifications. This is really useful for 
the ecommerce templates when preparing the product images for the product 
and product detail pages. 
 
The first thing to do is place all your images in a folder on your hard drive. 
Then open Fireworks and choose File > Batch Process from the top menu 
 

 
 

Browse to the folder where you saved your images and select the ones you 
want to change or choose to select them all 
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Now you can set up the rules for the changes you want to make to the 
images. For photos you will probably want to export the picture as a .jpg file 
 

 
 

And you’ll probably want to set a uniform size. To avoid distorting the graphic 
it’s best to set the width (in the example at 150 pixels) and allow the height to 
scale accordingly by choosing variable 
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The Rename and Commands options probably won’t be needed. Click on 
next and you will be given the option of where you would like to save your 
newly modified files and the option of saving the script so it can be used again 
at a later date. 
 

 
 

Clicking batch will modify all the files you selected to the specifications you set 
up. 
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Frontpage issues 
The majority of the colors on the templates are cell backgrounds, which can 
be changed by right clicking on the cell in normal view and choosing “cell 
properties”. 
 

 
 

You can then select the color of your choice. 
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Frontpage includes 
All the Frontpage ecommerce templates use include files. These allow you to 
update the whole site by making changes on a single page. They are typically 
used for news items, header and footer sections - anything really that appears 
the same on all or most of the pages on a site. The include pages are kept in 
a folder called /includes/. We've added a brief explanation below on how to 
use them with the ASP and PHP templates. 
 

 

 
 
The ASP templates use Frontpage includes - they're very simple to use and 
can be added to and deleted at will. 
 
Modifying an include page (ASP Version) 
In Frontpage folder view, open the includes folder and double click on the file 
you want to change. Make the modifications and on saving, all the pages that 
are linked to that include file will be automatically updated. There are only a 
couple of things to be wary of. If the include file uses graphics, make sure that 
your new graphics will fit into the space provided for them. Some include files, 
typically ones used for news sections, use smaller text. This is achieved 
through .css class - take a look at the code and you'll probably see something 
like this: <td class="smaller"> or <p class="smaller"> - if this is the case, and 
you want to maintain the look, you may need to manually add the class to the 
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<p> tag when adding a new paragraph. Speaking of <p> tags, be careful as 
sometimes Frontpage will add them to your code, both on the include page 
and the main page which contains the include - this may cause some extra 
spacing to occur and will mess up your design, particularly in Netscape 7. To 
delete them open the page in HTML view, delete and save, making sure you 
have the "Preserve existing HTML" box checked in Page Options. There is 
further help on using CSS in this chapter. 
 
NB. Only code that is between the opening and closing <BODY> tags will be 
read in include files, so if you have to put some script into the <HEAD> 
section, it will have to be moved to the <BODY> section. 
 
 
Frontpage Navigation (ASP Version) 
 
Many of the ASP version Frontpage ecommerce templates use a theme so it 
is easy to add new buttons and pages without having to open your graphics 
program. If there is not a tree structure in Navigation View it means the 
templates relies on Frontpage includes for navigation. 
 
Changing Button Names 
Button names are based on the Title of the page. They must be kept short 
because FrontPage will not wrap button names. They will appear on one line 
and will need to fit within the space allotted on the button. In Frontpage, go 
into Navigation View and right click on the page icon in the tree structure, 
choose Rename and type the name of the page you need. 
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You will probably also want to change the name of the page itself so right click 
on the page name in folder view, choose Rename and type the new .htm or 
.asp name you require. It’s best to keep names lower case and without 
spaces. 
 
If you need to change the wording of the “home” link go to Tools>Web 
Settings>Navigation and place your wording there. 
 

 

 
 
 
Adding a Page 
To make more pages on the same navigation level, open a page > go to File 
> Save As > assign a new Page title by clicking on Change > type in the new 
title > OK > type in a new File name. Save. This will give you an exact copy of 
the first page without altering the first page. Drag the new page's file name 
into Navigation View in the place on the menu where you would like it to 
appear. FrontPage will automatically add the new page to the navigation bar. 
To finish the new page, insert appropriate content. 
 
For some reason Frontpage won’t allow you to have a .asp page as a parent 
file in navigation view so what you will need to do is change the extension to 
.htm, attach the page in the navigation tree chart and then change the 
extension back to .asp. 
 
Deleting a Page 
In Navigation View, right click on the icon of the page you wish to remove > 
Delete > Delete this page from the Web > OK. 
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Troubleshooting 
If your Frontpage navigation doesn’t show when you publish your site to your 
server then go to Tools > Recalculate Hyperlinks to see if that will bring it up. 
Also check that the theme has been attached. 
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Modifying an include page (PHP Version) 
There are a couple of issues with the Frontpage version when using the PHP 
templates. Frontpage extensions do not work with pages with the .php 
extension, so this means that FrontPage Includes and FrontPage Navigation 
do not work. We have found a neat way around these issues, but there are a 
couple of things to bear in mind.  
 
First, for include pages, we have just used PHP includes. It's already set up 
for you, and you will find the included pages in the includes folder. Unlike 
FrontPage includes however, all links will be relative to the file that is doing 
the including. So, for this reason we recommend you use links relative to the 
site root if you want to use the same include files in folders and sub folders. 
 
Examples of different ways to link pages are . . .  
 
This is a relative link: mypage.php  
This is a link relative to the site root: /mypage.php  
This is an absolute link: http://www.mysite.com/mypage.php  
 
The include page will not show up when you preview in a browser, so you'll 
need to upload the site to your server to view your modifications. There is a 
utility that will allow you to view your changes in Frontpage and they have a 
30 day free trial available. 
 
You can also work "live" on the server: 
 
How to work "live" on the server 
Open Frontpage  
Select File > Open Web 
 

 
 
In the box that appears type your full URL eg. http://www.yourdomain.com/  
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You'll now be prompted for your Frontpage user name and password  
 

 
 
Once verified, your site will be open and live, any changes you make on 
"saving" will be made to your live site 
 
 
PHP includes and navigation 
Because FrontPage Navigation is not available, you will have to make up and 
over buttons for the navigation. (This does not apply to templates which use 
DHTML PopOut menus as navigation or text based menus.) To change 
navigation, open the page which contains the navigation. (Normally 
includes/leftnavigation.htm.) You will see some lines of code such as . . . 
addrollover('special.php','images/special.gif','images/specialov.gif'); 
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To add buttons to the navigation, just add extra lines here, or edit the existing 
ones. The parameters are: 
 
The link. 
This can be relative: about.php 
or relative to the site root: /about.php 
or absolute: http://www.mysite.com/about.php  
The "normal" state of the image: images/menu/about.gif 
The "mouseover" state of the image: images/menu/aboutov.gif 
 
The same rules apply about relative links as for the FrontPage Includes 
however.
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Configuring Frontpage for PHP 
If Frontpage doesn't recognize the .PHP pages, you'll need to configure it like 
this: 
 
In Frontpage go to Tools>Options>Configure Editors  
 

 
 
Choose "Add" 
 

 
  
 
Put PHP for file type  
Put the same information as you have for htm, html etc. - this is usually: 
Editor Name: FrontPage 
Command: frontpg.exe  
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Adding a new page 
The simplest way to add new pages to your site is to open an existing page, 
such as about.htm and save it under a new name, such as new.htm. If the 
template uses Frontpage navigation then remember to drag the page into 
navigation view so that the menu shows up correctly. 
 
Frontpage tip: Be careful not to drag the borders of your cells and tables in 
an attempt to change the layout – always work with cell and table properties.
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Dreamweaver Issues 
 
Remember that before making any changes to a Dreamweaver template you 
will first need to define your site by selecting Site > New Site from the 
Dreamweaver top menu. There are full details in our introductory chapter.  
 
Main.dwt 
Global changes should be made in the file Templates/Main.dwt. These will 
typically be the header, menu and footer sections. On making a change to the 
file Main.dwt you will be asked if you want to update all the files using the 
template 
 

 
 

Agree to the prompt and all the pages will be updated. If you are not prompted 
then it probably means that your site hasn’t been defined. 
 
 
News.lbi 
The news section will typically be a library file and if present will be found in 
the Library folder. This file can be used to update all the pages that are linked 
to it. If you need different news sections on different pages, save New.lbi 
under a new name, make the text changes and drag it into the place on the 
page where the original library item was located. 
 
Editable Regions 
Content which is unique to each page will be set up as an Editable Region. 
The main body of content will be typically called “Body” and is represented by 
a light blue box around the area that can be edited. 
 

 
 

The cursor will show as an arrow within an editable region and as a circle with 
a line through it in the locked region of the page. 
 
To change the background colors in Dreamweaver, click in the cell in design 
view and then select the bg color from the Properties Window. 
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Adding a new page 
The simplest way to add new pages to your site is to open an existing page, 
such as about.htm and save it under a new name, such as new.htm.
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GoLive Issues 
The first thing to do when you've opened up Adobe GoLive is to go to File > 
Open from the top menu. 
 

 
 
Browse to the folder where you extracted the template to and locate the .site 
file. 
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You should then see the listing of all the files and folders that make up your 
GoLive shopping cart. 
 

 
 
You'll find the package has some sample pages, the store .asp/php pages 
and a number of folders. To make site-wide changes to the design, adding 
your company name, changing the menu etc. you'll need to work from the 
components. These can be opened by double clicking on the various 
components that make up a page. 
 

 
 
Once you've made the changes, save the file and you'll be prompted if you 
want to update all the files using this template - agree to the prompt and you 
should be able to see the modifications you've made. 
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Adding a new page 
The simplest way to add new pages to your site is to open an existing page, 
such as about.htm and save it under a new name, such as new.htm.
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Cascading Style Sheets (CSS) 
 
On the ecommerce templates we use cascading style sheets (css) to allow 
you to easily manage the font and hyperlink properties. In the root of your web 
you will have a file typically called style.css and on each page a link to it like 
this <LINK REL=STYLESHEET TYPE="text/css" HREF="style.css">. This can 
be edited in Frontpage, GoLive or Dreamweaver by double clicking on it or 
can be opened and modified in a text editor like Notepad. 
 
Editing the hyperlink properties with CSS 
After opening the file you should see some lines like this: 
 
A:link { 
color: #3366FF; 
text-decoration: none; 
} 
 
A:visited { 
color: #3366FF; 
text-decoration: none; 
} 
 
A:active { 
color: #3366FF; 
text-decoration: none; 
} 
 
A:hover { 
color: #FF9966; 
text-decoration: none; 
} 
 
The parameters are pretty clear, any hex value will suffice for the color and if 
you require an underline when the cursor passes over a link, change "none" 
to "underline". Note that some browsers, notably Netscape 4x will ignore the 
hover option. 
 
Editing the font properties with CSS 
The font type and size is also set in the css file, here's an example: 
 
TD { 
font-size: 12px; 
font-family : Verdana,Arial; 
} 
 
P { 
font-size: 12px; 
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font-family : Verdana,Arial; 
} 
 
This means that all text that is between <TD> or <P> tags will be Verdana, 
size12 - if Verdana is not installed on the user's machine then it will revert to 
Arial. If you want to change the color of the text from the default then add a 
line like this for red text: 
 
TD { 
font-size: 12px; 
font-family : Verdana,Arial; 
color: #CC0000; 
} 
 
P { 
font-size: 12px; 
font-family : Verdana,Arial; 
color: #CC0000;  
} 
 
Editing the horizontal rule properties with CSS 
 
This line of code will give you a blue horizontal rule, one pixel in height: 
 
HR { 
color : #3366FF; 
height : 1px; 
} 
 
Netscape browsers will ignore this. 
 
Using CSS classes 
 
CSS classes allow you to vary your styles on a page, for example giving a 
section smaller text or different link properties - this can be really handy when 
for example you have light and dark backgrounds and you need your links to 
show up well on both. Here's an example of using a class for hyperlink 
properties: 
 
A.dark:link { 
color: #FFFFFF; 
text-decoration: none; 
} 
 
A.dark:visited { 
color: #FFFFFF; 
text-decoration: none; 
} 
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A.dark:active { 
color: #FFFFFF; 
text-decoration: none; 
} 
 
A.dark:hover { 
color: #FF9966; 
text-decoration: none; 
} 
 
This will give you white links with an orange mouseover. To apply it to 
individual links you'll need to add the class like this: 
 
<a class="dark" href="mylink.html">link text</a> 
 
To change text size or color between <TD> or <P> tags you might have 
something like this: 
 
TD.smaller { 
font-size: 11px; 
font-family : Verdana; 
color : #CC0000; 
} 
 
P.smaller { 
font-size: 11px; 
font-family : Verdana; 
color : #CC0000; 
} 
 
This will give you red 11 pixel size text when you add a class like this for a 
paragraph: 
 
<p class="smaller"> 
 
...or for the cell 
 
<td class="smaller"> 
 

Editing the category layout 
In version 4.1.0 we added the possibilty of showing the categories in multiple 
columns rather than in one vertical list. As people will want to align the text 
and images in different formats, we added CSS classes to make the 
modifications as simple as possible. 
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The first thing you will want to do is set up the category format that best suits 
your site, this involves adding a parameter to your vsadmin/includes.asp or 
vsadmin/icludes.php files, depending on your version. 
 
Next thing to do is open your CSS file, this is found in the root of your store 
and is typically called style.css or stylesheet.css 
 
Copy and paste these lines into the CSS file: 
 
P.catname { 
text-align: center;  
margin-top: 0px;  
margin-bottom: 4px;  
vertical-align:top;  
text-align: center; 
} 
 
P.catdesc {  
margin-top: 0px;  
margin-bottom: 4px;  
vertical-align:top; 
} 
 
IMG.catimage {  
border:1px;  
border-thickness: 1px;  
border-color: #000;  
border-style: solid;  
vertical-align:top;  
} 
 
TD.catimage {  
vertical-align:top;  
}  
 
TD.catname {  
vertical-align:top;  
text-align: center;  
}  
 
TD.catnavigation {  
vertical-align:middle; 
text-align: left;  
} 
 
The classes explained 
 
P.catname: The alignment of the category name 
P.catdesc: The alignment of the category description 
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IMG.catimage: The properties of the category image 
TD.catimage: The alignment of the category image 
TD.catname: The alignment of the category name 
TD:catnavigation: the alignment of the top category navigation 
 
Some examples 
 
Using the settings as listed above would show the category page as in the 
example here: 
 

 
 
If you would like the titles and text left aligned and without an image border, 
the CSS would need to be changed like this: 
 
P.catname { 
text-align: center;  
margin-top: 0px;  
margin-bottom: 4px;  
vertical-align:top;  
text-align: left; 
} 
 
P.catdesc {  
margin-top: 0px;  
margin-bottom: 4px;  
vertical-align:top; 
} 
 
IMG.catimage {  
border:0px;  
border-thickness: 1px;  
border-color: #000;  
border-style: solid;  
vertical-align:top;  
} 
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TD.catimage {  
vertical-align:top;  
}  
 
TD.catname {  
vertical-align:top;  
text-align: left;  
}  
 
TD.catnavigation {  
vertical-align:middle; 
text-align: left;  
} 
 
...and the layout would look like this: 
 

 
 
To move the top navigation to the right, change 
 
TD.catnavigation {  
vertical-align:middle; 
text-align: left;  
} 
 
to 
 
TD.catnavigation {  
vertical-align:middle; 
text-align: right;  
} 
 
The best thing is to play around with the settings until you find the one that 
best suits your site. You can always come back here to get the default 
settings if you run into difficulty. 
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Editing the price color 
 
In version 4.1.6 we added the possibilty of changing the color of the price from 
the style sheet. All you need to do is add the following to style.css, this 
example would make the price show as red: 
 
SPAN.price { 
COLOR: #FF0000; 
} 
 
Editing the product options properties 
 
In version 4.2.0 we added the possibilty of changing the format of the product 
options from the style sheet. All you need to do is add the following to 
style.css, this example would make the text show as red with Verdana 11px 
font: 
 
SELECT.prodoption { 
font-size: 11px; 
font-family : Verdana; 
color : #FF0000; 
} 
 
If you are using stock management with the product options, introduced in 
version 4.4.0, it's possible to "grey out" the options which are no longer in 
stock by adding the following to your main style.css file 
 
OPTION.oostock { 
color : #A0A0A0; 
} 
 
Editing the top product navigation 
 
In version 4.6.0 we added the possibilty of changing the format of the top 
product navigation eg. Home >> Product from the style sheet. All you need to 
do is add the following to style.css, this example would make the text show as 
red with Verdana 11px font: 
 
td.prodnavigation { 
font-size: 11px; 
font-family : Verdana; 
color : #A0A0A0;  
} 
 
P.prodnavigation { 
font-size: 11px; 
font-family : Verdana; 
color : #A0A0A0; 

 
© Ecommerce Templates Page 149 of  229 



 

} 
 
Editing the table backgrounds 
 
Version 4.7.0 allows you to set the table and cell background properties in the 
files search / tracking / order status / checkout via CSS classes. 
 
The new classes are: 
TABLE.cobtbl for the table. 
TD.cobhl for the cell highlights 
TD.cobll for the cell lowlights 
 
For example the following addition to your style.css file would give you a 
search table looking like this: 
 

 
 
TABLE.cobtbl{ 
background-color: #FF0000; 
}  
 
TD.cobhl{ 
background-color: #FFC42B; 
} 
 
TD.cobll{ 
background-color: #FFF7B8; 
color : #666666; 
} 
 
Editing the page numbers 
 
In version 4.7.0 we added the possibilty of changing the format of the page 
numbers from the style sheet. All you need to do is add the following to 
style.css, this example would make the page numbers show as Verdana size 
12: 
 
P.pagenums { 
font-size: 12px; 
font-family : Verdana; 
} 
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Editing the curreny format 
 
In version 4.7.0 we also included the possibility of changing the format of the 
alternative currencies. All you need to do is add the following to style.css, this 
example would make the currencies show in Verdana, size 10 and gray: 
 
SPAN.extracurr { 
font-size: 10px; 
font-family : Verdana; 
color: 666666  
}
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DHTML Menus 
 
Some of the templates use DHTML drop down or pop-out menus. In 
Frontpage these will be include files, found in the Includes folder – In 
Dreamweaver they form part of the .dwt template files and In GoLive they will 
be set up as a component. The link colors are set in the .css file. Like any 
script these won’t show up in design view and when previewing them in a 
browser they will not show correctly as they are dependent on the database 
connection. Once published to a server they should show correctly. 
 
If your site has a hierarchy of folders and subfolders it’s best to make all links 
relative to the root like this: /folder/subfolder/page.asp 
 
How the hierarchy works 
The top level of links ie. the ones that show on the menu with no interaction 
are set up with the code looking like this: 
 
mymenu.addMenu("help","HELP", "help.asp") 
mymenu.addMenu("affiliates","AFFILIATES", "affiliate.asp") 
mymenu.addMenu("search","SEARCH", "search.asp") 
mymenu.addMenu("checkout","CHECKOUT", "cart.asp") 
 
help – this is the id of your menu option 
HELP – the text displayed on your menu 
help.asp – the link 
 
So before you can have pop-outs it’s necessary to set a main top option, in 
the example above with the id help 
 
The code for the first pop-out level from the HELP link would look like this 
 
mymenu.addSubMenu("help", "faq", "FAQ", "#") 
 
help - this is the parent id defined above 
faq – this is the id for the next pop-out 
FAQ – the text that appears on the menu 
# - this is a null link, meaning that if clicked the user won’t go to  a new page, 
often you would place a real link like faq.asp here 
 
For a second level popout 
 
mymenu.addSubMenu("faq", "", "COMPATIBILITY", "compatibility.asp") 
 
The faq refers to the id we set up previously and because there will be no 
further pop-outs the next space can be left blank with "" 
 
You can have as many levels of pop-outs as you need. 
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How to open a link in a new window 
If you want to make the link open in a new window, look at this example: 
mymenu.addSubMenu("examples", "", "<b>virtual blue</b>", 
'http://www.ecommercetemplates.com/dwpopoublue/" target="_blank') 
Be careful with the punctuation here 
 
How to get a text rollover effect if a section name is not a link 
Sometimes it is not necessary to have a section linked, but the section has a 
number of pop-outs - to keep things tidy instead of having 
mymenu.addMenu("main","<b>main</b>", "main.htm") where the link is to 
main.htm, you can change it to mymenu.addMenu("main","<b>main</b>", "#") 
so you maintain the link color but are not taken anywhere in case anyone tries 
to click. 
 
How to get rid of the default help links and corresponding pop-outs 
Heres an example but the theory is the same for all the templates using the 
DHTML menu. 
 
First delete this line: 
 
mymenu.addMenu("help","HELP", "help.asp") 
 
and then all the pop-outs that it spawns, which will be: 
 
mymenu.addSubMenu("help", "faq", "FAQ", "#") 
mymenu.addSubMenu("help", "tutorials", "TUTORIALS", "#") 
 
mymenu.addSubMenu("faq", "", "COMPATIBILITY", "#") 
mymenu.addSubMenu("faq", "", "DHTML MENUS", "#") 
mymenu.addSubMenu("faq", "", "DHTML MENUS", "#") 
mymenu.addSubMenu("faq", "", "GRAPHICS", "#") 
mymenu.addSubMenu("faq", "", "LICENSE", "#") 
 
mymenu.addSubMenu("tutorials", "", "TEMPLATE SET UP", "#") 
mymenu.addSubMenu("tutorials", "", "INCLUDE PAGES", "#") 
mymenu.addSubMenu("tutorials", "navigation", "NAVIGATION", "#") 
 
mymenu.addSubMenu("navigation", "", "FP NAVIGATION", "#") 
mymenu.addSubMenu("navigation", "", "DW NAVIGATION", "#") 
mymenu.addSubMenu("navigation", "", "GL NAVIGATION", "#") 
 
How to set up categories and products manually 
By default the menu generates the category and product links from the 
information passed on from the database. But deleting these two sets of lines 
will remove that functionality: 
 
 
 
/* <% 
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 ' Please note, the following line of code is used to automatically create 
the links for the product sections If you do not want to use this feature, please 
delete this line of code in your Main.dwt template along with the 
corresponding section below. 
%> */ 
mymenu.addMenu("products","O PRODUCTS", "categories.asp") 
 
// Delete these 7 lines and the corresponding lines above if you  
// don't want an automatically generated popout menu. 
<% if false then %> </script> <% end if 
menuprestr = "O " 
menupoststr = "" %> 
<!--#include file="../vsadmin/inc/incmenu.asp"--> 
<% if false then %> <script language="JavaScript1.2"> <% end if %> 
 
Important notes 
Don’t use category id’s with spaces, keep them lowercase and with no 
strange characters 
Make sure a main category id is set up before making a corresponding pop-
out. 
There must be at least one pop-out in the menu for it to function correctly. 
There is nothing that needs editing in the .js file. 
The .js file and clearpixel.gif must go in the root of your site.  
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Chapter 7 
Advanced Tweaks 
 
 
 
Introduction
How to skin the control panel 
How to add a buy button to your home page 
Adding HTML to your product descriptions 
Adding thumbnail photos to your product detail page
Adding extra pictures to the product page 
Adding recommended products to your cart page
How to change text to graphics 
How to add a search box to each of your pages
How to pass search parameters to the search page
Advanced parameters and tweaks (ASP version) 
Advanced parameters and tweaks (PHP version)
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Introduction 
 
This chapter deals with some of the more advanced tweaking you can employ 
in the ecommerce templates to get even more functionality out of your store. 
 
Most of the ideas outlined below require a degree of confidence in editing 
code but if you make a backup of your page/site first, it can also prove to be a 
good learning tool. 
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How to skin the control panel. 
 
Version 4.8.0 saw the introduction of the CSS based skinable control panel. 
 
The design itself is 100% CSS based and XHTML transitional compliant, work 
on the code behind the admin is ongoing. 
 
Apart from speeding up download times the admin section is now skinable, 
allowing for simple changes in colors and graphics. 
 
We have some instructions below to help you change things around. 
 
The Stylesheet 
 
The stylesheet that governs the layout and colors can be found in your 
vsadmin folder and is called adminstyle.css. You will see that we have added 
comments to the file so you can see how the various sections are set up. 
 
Before making any changes we strongly suggest making a back up of 
adminstyle.css so you can always go back to the original. We would also 
suggest not making any changes at all if you are not confident editing CSS. 
 
Changing the backgrounds 
 
The main background color is set to light blue #E6E9F5 and can be changed 
here: 
background: #E6E9F5; 
The main body is white, although it's probably best to keep it that way it can 
be changed under #main: 
background: #FFF; 
The header section is set at #BFC9E0: 
background:#BFC9E0; 
 
There is also a background image associated with the header which gives the 
rounded effect at the top of the header: 
background-image: url('adminimages/newtoptopbg.jpg');  
 
Changing the table borders 
 
By default there is a dotted line around the table borders: 
border: 1px dotted #194C7F; 
Other options are dashed, solid, double… 
 
Other CSS changes 
 
Most of the other changes that can be made relate to the color of the input 
boxes, alternate cell colors, text and links. These should be self explanatory.  
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NB 

We strongly suggest not making any differences to the absolute positioning of 
elements and remember to preview the admin section in different browsers at 
different resolutions  

Changing the graphics 

The images associated with the control panel can be found in the folder 
/adminimages/ and we would suggest keeping the same dimensions 

Logo: 

adminimages/ecommerce_templates.gif" width="278" height="53"  

Left hand menu titles: 

adminimages/administration.jpg" width="150" height="31" 

adminimages/product_admin.jpg" width="150" height="31" 

adminimages/shipping_admin.jpg" width="150" height="31" 

adminimages/extras.jpg" width="150" height="31"  

Horizontal line graphic between menu items: 

adminimages/hr.gif  

Observations 

That should give you the basics for skinning the control panel but do check in 
different browsers and at different resolutions. Do make a back up of the 
original files before starting but if things become irreparable then get the latest 
updater and replace the stylesheet and images from the original. 

 
 
 
 
 
 
 
 
 

 
© Ecommerce Templates Page 159 of  229 



 

How to add a buy button to your home page. 
This is pretty simple, and of course your buy button can be added to other 
pages, it doesn’t have to be the home page. 
 
The first thing you need to do is to get the products on your store as you will 
need to copy and paste some code. 
 
Open the page on your store that has the product information that you want to 
include on another page this will typically be 
http://www.yourstore.com/products.asp?id=1 and view source. You’ll need to 
scroll down the page and find the code between the <form>….</form> tags – 
it should look something like this… 
 
<form method="POST" name="tForm0" action="cart.asp"> 
<tr> 
<td colspan="2"> 
<p>This inkjet printer really packs a punch for the home user. Full color prints at photo quality. 
Perfect for everything from letters to the bank manager, to printing out your favourite digital 
family pictures.</p> 
</td> 
</tr> 
<tr> 
<td width="59%" align="center" valign="middle"> 
<b>Price:</b> <span id="pricediv0" name="pricediv0">$95.00</span> 
</td> 
<td align="right" valign="bottom"> 
<input type="hidden" name="id" value="inkjet001"> 
<input type="hidden" name="mode" value="add"> 
<input type="image" src="images/buy.gif" border="0"></td> 
</tr> 
</form> 
 
This will give you a product description with a price and buy button. Copy the 
code between the form tags and then paste it into the place where you would 
like to display the information. That’s about it – you may need to edit the text 
or add a photo to get things looking good so your final code will look 
something like this: 
 
<form method="POST" name="tForm0" action="cart.asp"> 
<input type="hidden" name="id" value="XXXXXX"> 
<input type="hidden" name="mode" value="add"> 
<input type="image" src="images/buy.gif" border="0"> 
</form> 
 
Where xxxxxx is the id of your product. 
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Adding HTML to product descriptions 
This is a great way of formatting your product pages and product detail pages, 
sometimes simply spacing out text rather than using blocks can make reading 
the information much easier. You can use any valid HTML in the product 
description field. Here are some examples: 
 
<p>To make a double space between lines, put them between opening and 
closing <p> tags</p> 
 
To add colour to your text put them between font tags like this <font 
color=”#CC0000>This is red text</font> 
 
This is <b>Bold text</b> 
 
Here’s an example of adding an image to the description, for example you 
might want to add a heading for “special offers” or add extra product photos. 
 
<img src="images/specialoffers.gif" width="350" height="30"> 
 
Or you might want to link to another page, manufacturer’s site or wherever: 
 
<a href=”anotherpage.htm”>Another Page</a> 
 
<a href=”http://www.ecommercetemplates.com”>Another Site</a> 
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Adding thumbnail photos to your product detail page 
with JavaScript pop-ups. 
 
Taking this last point a little further, a lot of products might require more than 
one photo in the product detail page, a great way to do this would be to 
provide thumbnail photos that link to larger pop-up windows. The first thing to 
do is to set up a page with your large photo page, we’ll call it largephoto.htm, 
save it and you’re ready to set up your script. There are two parts to the script, 
first of all copy this line into Notepad and copy/paste into your 
proddetail.asp/php page before the closing </HEAD> tag: 
 
<SCRIPT LANGUAGE="JavaScript"> 
<!-- 
function launch(url, windname,x,y) { 
self.name = "opener"; 
remote = open(url, windname, "width="+x+",height="+y); 
} 
// --> 
</SCRIPT> 
 
NB In Dreamweaver this will have to go into your editable title tag 
 
In the product detail field you’ll need this code: 
 
 <a href="javascript:launch('largephoto.htm','mywinname',400,540)"><img 
src="images/largephoto.gif" width="100" height="135" border=”0”></a> 
 
This will give you a pop-up link to the largephoto.htm page you created with a 
width of 400 pixels and a height of 540. These can be edited to fit the size of 
your photo. 
 
If you want to add a “close this window” link on your largephoto.htm page the 
code would be:  
 
<a href=""onClick="window.close()">Close this Window</a> 
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Adding extra pictures to your product page 
 
By default you can have one product picture and one product detail picture. It 
is possible to add HTML to your product description or merge the pictures in 
your graphics program to make one graphic from several. Alternatively you 
can add a little code to the product picture field. 
 
Normally the path to your image would be /prodimages/graphic.jpg but if you 
wanted to add 2 graphics then you would place: 
 
/prodimages/graphic1.jpg"><br><img src="/prodimages/graphic2.jpg 
 
That would place one graphic under another, remove the <br> if they are to 
go side by side or add an extra <br> for greater vertical spacing. 
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Adding recommended products to your cart page. 
 
This is a way of trying to get people to continue shopping after they’ve added 
items to their cart, it’s really simple but you really should back up your 
cart.asp/cart.php first. 
 
Open the file cart.asp / cart.php 
 
Scroll down through the code until you find the include lines, for the ASP 
version they should be like this: 
 
<!--#include file="vsadmin/db_conn_open.asp"--> 
<!--#include file="vsadmin/includes.asp"--> 
<!--#include file="vsadmin/inc/languagefile.asp"--> 
<!--#include file="vsadmin/inc/incfunctions.asp"--> 
<!--#include file="vsadmin/inc/inccart.asp"--> 
 
..or for the PHP templates: 
 
<SCRIPT LANGUAGE="php"> 
include "vsadmin/db_conn_open.php"; 
include "vsadmin/includes.php"; 
include "vsadmin/inc/languagefile.php"; 
include "vsadmin/inc/incfunctions.php"; 
include "vsadmin/inc/inccart.php"; 
</SCRIPT> 
 
Add a couple of <br> tags after the above code to separate the cart 
information from your special offers and then copy and paste this code: 
 
<table border="0" cellpadding="2" cellspacing=”2” width="100%"> 
<tr> 
<td width="100%" colspan="4"><b>This month's special offers</b></td> 
</tr> 
<tr> 
<td width="25%" valign="bottom" align="center"><a 
href="/proddetail.asp?prod=testproduct"><img border="0" 
src="prodimages/computercable.gif" width="93" height="93"></a></td> 
<td width="25%" valign="bottom" align="center"><a 
href="/proddetail.asp?prod=inkjet001"><img border="0" src="prodimages/inkjetprinter.gif" 
width="93" height="93"></a></td> 
<td width="25%" valign="bottom" align="center"><a 
href="/proddetail.asp?prod=keyboard001"><img border="0" src="prodimages/keyboard.gif" 
width="93" height="93"></a></td> 
<td width="25%" valign="bottom" align="center"><a 
href="/proddetail.asp?prod=mouse001"><img border="0" src="prodimages/mouse.gif" 
width="93" height="93"></a></td> 
</tr> 
</table> 
 
This will give you a table in this format (without the cell borders): 
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This month’s special offers 
 

Product photo + 
link 

Product photo + 
link 

Product photo + 
link 

Product photo + 
link 

 
Maybe the best thing to do is to set up the table in your HTML editor and then 
paste in the code as you may require more or fewer rows and columns. 
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How to change text to graphics. 
 
All the default text that is generated by the store can be edited in file 
/vsadmin/inc/languagefile.asp or .php so here for example you could change 
the word “Details” on your product page to “More details” by editing this line 
for the ASP version xxPrDets="Details" and changing it to xxPrDets="More Details". 
For the PHP version it’s similar but the line looks like this $xxPrDets="Details"; 
 
It’s possible to take this a step further by changing the text “Details” to a 
graphic and adding a bit of “spice” to your page – all you need to do is add a 
line of code and make the graphic. So once you have a graphic and saved it 
in your images folder you can open up the languagefile page and modify a 
line of code: 
 
ASP version 
xxPrDets="Details" should be changed to: xxPrDets="<img src=””/images/details.gif”” 
border=””0””>" 
 
PHP version 
$xxPrDets="<img src=\"/images/details.gif\" border=\"0\">"; 
 
This of course applies to any of the store generated language but it’s 
advisable not to go overboard on adding graphics everywhere just for the 
sake of it. Make sure you pay particular attention to the syntax required. Again 
make a backup of the languagefile page before trying out any tweaks of code. 
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How to add a search box to each of your pages 
As well as the all signing, all dancing search page, you may want to have just 
a little search box in the left or right navigation column, or at the top of every 
page for instance. You can do this by copying and pasting the following code.  
 

<form method="POST" action="search.asp"> 
<input type="hidden" name="posted" value="1"> 
<input type="text" name="stext" size="16"><br> 
<input type="submit" name="Search"> 
</form> 
 
If you want to include your own graphic (search.gif) for the search button them 
change  
 
<input type="submit" name="Search"> 
 
to 
 
<input type="image" name="Submit" src="images/search.gif" border="0"> 
 
This is the most basic search, searching for "All Words" in all categories. But 
you could also use any of the parameters outlined in the tweak below 
as hidden fields to create a really powerful custom search or to search 
specific categories. 
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How to pass search parameters to the search page 
You can create your own "custom search" by passing parameters to the 
search page like this . . .  
 
search.asp?pg=1&scat=ts1&stext=Search Text&stype=exact&sprice=15 
 
This parameter needs to be there. Otherwise the search doesn't work 
pg=1 
 
This will specify a particular category. Top category id's should be preceeded 
by ts, sub categories by ms 
scat=ts1 
scat=ms4 
 
This is the text to search for 
stext=serial 
stext=Search Text 
 
This is the search type, all words, any word, exact phrase. Leaving this 
parameter out or blank will mean All Words, the default 
stype=any 
stype=exact 
 
This is the maximum price. Just leave it out if you don't want to specify a max 
price. 
sprice=15 
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Advanced parameters (ASP version) 
 
In the folder vsadmin there's a file called includes.asp - this is where you can 
specify some important options regarding mail, shipping, tax, and the display 
options for your product pages. Below is a guide to preparing the set up that 
best suits your needs. If you are updating your store from a previous version, 
you will need to add the variables below to the page includes.asp. For 
example if you don't have the line expireaffiliate=30 you will need to add it to 
the list. The order of the list is not important. 
 
Contents 
  
Email Options Layout Options Payment Options
· Mail components · Product listings · Setting the path to your SSL
· Email a friend · Product layout options · Disabling SSL
· HTML emails · Continue shopping link  · Encryption
· Email orders · Category layout options  · Dump credit card numbers
· Email headers and footers · DHTML menu · Force form submission
· Order status email    · Authorize.net
    · Capture card order status
Shipping / Tax Options Display Options Affiliate Options
· Adding tax to shipping · Product page display numbers · Affiliates cookie
· Removing the shipping 
address

· Removing buy and checkout 
buttons

· Affiliates commission

· Will pick up option · Remove top navigation   
· Show tax inclusive prices · Terms and Conditions   
· UPS options · Quantity boxes   
· Commercial location · Zero price message   
· Shipping insurance · Show product id   
· Invoice / packing slips · Hide product options   
· Canadian tax · Extra checkout fields   
· Per payment provider 
handling charge

· Forcing minimum purchase 
amount

  

· Split heavy packages · Alternative currency format   
· Canada Post · Product detail link   
  · Hide product option price   
Discount Options Customer Login Admin Tweaks
· Remove discount / coupon 
feature

· Enable customer login · SQL Server

· Hide discount / coupon text · Wholesale pricing · Currency formats
  · Forwarding page · Adjust date
    · Character sets
    · Multiple languages
    · Multiple admins

 
 
 
  
 

 
© Ecommerce Templates Page 169 of  229 



 

 

Mail options (Minimum version 1.3.7 to 4.6.0*) 
 
More often than not, you'll want to use CDONTS as your mail system but if 
you need to specify a mailhost, you can do so in vsadmin/includes.asp. 
Typically these would be smtp.yourhost.com or mail.yourhost.com - your host 
should be able to help you with this if you need it. eg. 
mailhost = "mail.yourhost.com" 
* From version 4.6.0 the smtp server is set on the admin main page rather 
than in the vsadmin/includes.asp file. 

Product listings (Minimum version 1.3.7) 
 
You can now choose how to sort your product listings - you can do this 
alphabetically, by id or by price. There are four options: 
 
1 = sorting the products alphabetically  
2 = sorting the products by id  
3 = sorting the products by price (cheapest first)  
4 = sorting the products by price (most expensive first)  
So for example if you wanted to list your products alphabetically you would 
choose this option: 
sortBy = 1 or by product id like this sortBy = 2 
 

Setting the path to your SSL (Minimum version 1.3.7) 
 
If you are using a payment provider that requires SSL then what the system is 
going to look by default is your website URL on an HTTPS connection, ie 
https://www.yoursite.com/cart.asp 
If you have shared ssl space which requires a different url, or if you want to 
override the switch to SSL for testing purposes then you can override it like 
this: 
 
pathtossl = "https://www.yourhostssl.com/yourdir/" 
. . . or . . .  
pathtossl = "http://www.yoursite.com/" 
. . . to keep it on http and not go to https 

Product page display numbers (Minimum version 1.3.7) 
 
To display the product page number links at the top of the page as well as the 
bottom set pagebarattop=1 
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Disabling SSL (Minimum version 3.5.4) 
 
Setting nochecksslserver=TRUE will disable the checking with capture card 
and other payment systems that require an SSL server that check you are on 
an SSL connection. 
 
IMPORTANT NOTE: 
This should not be set unless you are most certainly sure that you are on 
HTTPS when viewing the credit card details. Our check for SSL can be fooled 
the way some servers set up their shared SSL certs so all this switch does is 
remove the warning in this case. It should NOT be used to enable yourself to 
view CC details on a non-SSL connection. 

Adding tax to shipping (Minimum version 3.5.9) 
 
If you need to add tax to shipping you'll need to choose taxShipping=1 - if not 
leave it as it is ie. taxShipping=0 
 
Setting taxShipping=2 will add the shipping tax to the state and country tax 
totals. 
 

Shipping address (Minimum version 3.6.3) 
 
Use: 
 
noshipaddress=true 
 
to cause a shipping address entry section not to be shown on the checkout 
page if set. 
 

"Will pick up option" (Minimum version 4.1.0 - only for UPS / USPS / 
weight and price based shipping.) 
Use: 
willpickuptext="Will Pickup" 
If you want to allow your customers the option of picking up their purchase 
from your physical location. The text here can be changed as necessary. 
 
Use 
willpickupcost=1.32 
To set the cost of picking up from your location. Set to zero if there is no 
charge 
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Layout options (Minimum version 1.3.7) 
 
In version 1.3.7 we have added the possibility for different layout formats for 
your products: 
 
productcolumns=2 
 
useproductbodyformat=1 
 
usesearchbodyformat=1 
 
usedetailbodyformat=1 
 
usecategoryformat=1 
 
allproductsimage="" 
 
By setting useproductbody format to 2 like this useproductbodyformat=2 the 
products are displayed with the product options, price and buy button below 
the product image. When useproductbodyformat is set to 1 the product 
options, price and buy button are displayed to the right of the product image. 
 
The reason we added this second layout is that it lends itself well to having 
more than one column of products. So, when using useproductbodyformat=2 
the products will be displayed in the number of columns specified by 
productcolumns, such as 
 
productcolumns=2 
 
You can have as many as you like in theory, but just make sure they fit on 
your page. 
 
Please note that with the useproductbodyformat set to 1 the productcolumns 
setting will be ignored. 
 
To allow you to specify the search results independently of the general 
product display, you can set usesearchbodyformat to 1 or 2 in the same way. 
 
There is also a second product detail format available now. Setting 
usedetailbodyformat=2 will display the product detail page with the image to 
the left of the product description, price, quantity and buy button. 
 
If you need the category text and description to the right of the image choose 
usecategoryformat=2 
 
allproductsimage="" allows you to specify an image for "All Products" and the 
path can be inserted here. 
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usecategoryformat=1 
 

Email a friend (Minimum version 1.3.7) 
 
You can now add the option of emailing a friend from your product detail page 
- this adds a link to a pop-up window with a form that you can fill out to 
forward the information regarding a product to a friend. If you wish to use this 
feature set the parameter like this useemailfriend=true - if you would like to 
disable the feature then you need useemailfriend=false 
 

Removing store functions (Minimum version 2.0.0)  
 
You can simply eliminate the buy and checkout buttons as well as the price 
for all products, this is done by choosing nobuyorcheckout=true and 
noprice=true. 
 

Affiliates cookie (Minimum version 2.0.0) 
 
By default the affiliate cookie stays active for 30 days, this means that if 
somebody clicks on an affiliate link and then comes back later to purchase as 
long as it's within 30 days, the sales will be accredited to the affiliate partner. If 
you need to change this then the value here expireaffiliate=30 will have to be 
modified. 
 

Affiliates commission (Minimum version 4.5.0) 
 
You can now set an affiliate percentage in the affiliates admin, and set a  
defaultcommission=12  
to set a default commission for new affiliates 
 

SQL server (Minimum version 2.0.0) 
 
If you need to use SQL server rather than the Microsoft Access database then 
you will need to put sqlserver=true. Also make sure you change your 
connection string as suggested in the instructions. The majority of users 
however will be working from Access and won't need to use this option. 
 

Discounts / coupons (Minimum version 3.0.0) 
 
To remove the discount and coupon function choose nogiftcertificate=true. 
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Hide discount or coupon text (Minimum version 4.1.0) 
To remove the discount and coupon text that appears on category and 
product pages 
noshowdiscounts=true 
 

Show tax inclusive prices (Minimum version 3.1.2) 
 
To show tax inclusive prices on the products page use showtaxinclusive=true 
- the wording for the tax can be changed in vsadmin/inc/languagefile.asp. 
 

UPS Options (Minimum version 3.5.0) 
 
The way that you deliver your packages to UPS for delivery can affect the 
total cost of delivering the package. We have set the default as "Customer 
Counter", though you can change this by setting the following in your 
vsadmin/includes.asp file . . . 
 
upspickuptype="03" 
 
The code in quotes there would be taken from the following table... 
 
01 - Daily Pickup 
03 - Customer Counter 
06 - One Time Pickup 
07 - On Call Air 
19 - Letter Center 
20 - Air Service Center 
 
Remember to enclose the code above in double quotes. Also, please note 
that these options are not exactly the same as you might find on the UPS web 
site but we hear that is something that UPS are working on...more information 
 
To add UPS shipping insurance based on the product value, but not ask the 
customer... 
addshippinginsurance=1 
To ask the customer if they would like shipping insurance on the checkout 
form... 
addshippinginsurance=2 
 

Commercial location (Minimum version 3.5.0) 

Set commercialloc=true if you want to place a question and checkbox on 
checkout for shipping to a commercial location. This is automatically set for 
UPS but can be used for other shipping methods. 
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Currency formats (Minimum version 3.1.2) 
 
Normally the currency is automatically set by your country settings, but 
sometimes servers don't seem to have locales installed, and some have 
special needs. These are the parameters available: 
 
overridecurrency=TRUE 
- Switches the currency overriding on 
 
orcsymbol="US$" 
- The currency symbol used on product pages. 
 
orcemailsymbol="US$" 
- The currency symbol used in emails. Normally the same, but can be handy if 
you wish to set your product page currency symbol to an HTML code like € or 
¥ and then in the email set it to EURO or YEN 
 
orcdecplaces=2 
- How many decimal places your currency has. 
 
orcpreamount=FALSE 
- If you want to display the currency symbol before or after the amount. 
 
orcurrencyisosymbol="USD" 
- If you need to force the settlement in US Dollars even if you are selling from 
another country. 
 

Encryption (Minimum version 3.5.0) 
 
At the moment for using the "capture card method", credit card encryption can 
be used if ASPEncrypt is available on the server so the parameter will be 
encryptmethod="aspencrypt". If you do not want encryption, you have to 
explicitly set encryptmethod="none". Remember that by doing so, you have to 
take extra care to make sure the database is secure and to delete the card 
numbers from the database as soon as they are processed. If you are unsure 
about your site security, it might be an idea to contact one of the developers 
here for consultation. 
 

Top navigation (Minimum version 3.5.0) 
 
If you need to remove the top navigation ie. home >> category >> product 
then set showcategories=false 
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Terms and Conditions (Minimum version 3.6.0) 
 
If you need to make your customers agree to your terms and conditions on 
checkout, set termsandconditions=true 
You will also need to create a page with your terms and conditions called 
termsandconditions.asp ...which will be shown in a 420 x 380 popup. 
 

Quantity boxes (Minimum version 3.6.1) 
 
Setting the following to TRUE will put up a quantity box on the products and 
the product details page (not available if using usedetailbodyformat=2): 
 
showquantonproduct=FALSE 
showquantondetail=FALSE 
 

Zero price (Minimum version 3.6.3) 
 
If you set this, for instance... 
 
pricezeromessage="<b>Price: Please call</b>" 
 
...then in the case where a price is set to zero, this message will be printed 
instead. If the pricezeromessage is not set then products with a zero price will 
be displayed as Price: $0.00 as usual. 
 

Show product id (Minimum version 3.6.3) 
 
showproductid=true 
 
...will cause the product id to display on the product pages. The text "Product 
ID" is from the vsadmin/inc/languagefile.asp as xxPrId 
 

Hide product options (Minimum version 3.6.4) 
 
noproductoptions=true 
 
...this will hide all the product options on the products page. 
 

Invoices / packing slips (Minimum version 3.6.6) 
 
invoiceheader="<img src='images/logo.gif' border='0'><br><br>" 
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...this will print your logo at the top of the invoice. Obviously you will need to 
upload the logo to your images folder and set the path / name correctly. 
 
invoiceaddress="<br><b>EcommerceTemplates.com</b><br>My 
Address<br>MyTown, 90210<br>California<br><br>" 
 
... this will print your address on the invoice. As you can see it is possible to 
use HTML for formatting. 
 
invoicefooter="<br><br><font size='1'>Thank you for shopping with 
EcommerceTemplates.com</font>" 
 
..will print the footer information you need to include. Again HTML can be 
used for formatting 
 

Dump credit card numbers (Minimum version 3.6.6) 
 
dumpccnumber=true 
 
...this will dump the credit card numbers to the .csv file. Note that if you are 
using ASPEncrypt this option will not be available as the numbers cannot be 
decrypted in a CSV file. 
 

Continue shopping (Minimum version 3.6.6) 
 
actionaftercart=1 
 
...or not setting anything will mean that the continue shopping button will take 
the URL from the xxHomeURL from the vsadmin/inc/languagefile.asp which is 
the current default. 
 
actionaftercart=2 
 
...will make the cart "continue shopping" button return to the page you just 
came from when you are on the cart contents page. 
 
actionaftercart=3 
 
...when you add something to your cart, you will refresh immediately back to 
the products page you came from without going to the cart contents page. 
 

Adjust date (Minimum version 3.6.6) 
 
dateadjust=3 
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...would adjust the date the order status was updated by 3 hours. 
 
dateadjust=-4 
 
...would adjust it by minus 4 hours. This is so that if your server time is not the 
same as your local time then you can adjust for this. 
NB 
Version 4.6.3 allows for the date adjust in the admin section too rather than 
only in public view as before. 
 

Shipping insurance (Minimum version 3.6.6) 
 
Shipping insurance can now be added to more shipping types than just UPS 
shipping. If using UPS shipping, then adding 
 
addshippinginsurance=1 
 
to your includes.asp file will calculate shipping costs with insurance. If using 
UPS shipping then add 
 
addshippinginsurance=2 
 
will ask the user if they would like shipping insurance, and if so add it to the 
shipping cost. 
 
With shipping types other than UPS, you have to also set an amount, 
shipinsuranceamt 
for instance... 
shipinsuranceamt=5 
If addshippinginsurance=1 then in this example 5% of the product price total 
will be added to the shipping cost for insurance. 
If addshippinginsurance=2 then in this example 5% of the product price total 
will be added to the shipping cost for insurance IF the user checks the "yes I 
want shipping insurance" box on checkout. 
If addshippinginsurance=-1 then in this example 5.00 (of your monetary units, 
say Dollars) will be added to the shipping cost for insurance. 
If addshippinginsurance=-2 then in this example 5.00 (of your monetary units, 
say Dollars) will be added to the shipping cost for insurance IF the user 
checks the "yes I want shipping insurance" box on checkout. This method will 
not work with USPS shipping for which shipping insurance is not available. 
 

HTML email (Minimum version 4.0.0) 
 
Emails can be sent in HTML if you wish by adding the following switch: 
htmlemails=true 
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Email orders (Minimum version 4.0.0) 
If you need to set email orders as Unauthorized in your admin orders page, 
set 
emailorderstatus=2  
 

Category layout (Minimum version 4.1.0) 
categorycolumns=1 - will give you a vertical list of categories in a single list 
categorycolumns=2 - will show the categories in two columns 
categorycolumns=3 - will show the categories in three columns 
' catseparator="" - is required to use the new category set up - no changes are 
necessary here 
 

Extra checkout fields (Minimum version 4.1.0) 
It is possible to add two new fields to your cart checkout page. The company 
name field will go at the top of the checkout form and the additional field at the 
bottom. These can be moved by editing the vsadmin/inc/inccart.asp file - they 
can also be made obligatory. 
 
extraorderfield1="Company Name" - adds a company name field to the top of 
your cart checkout page, the text can be edited here for other uses. 
extraorderfield1required=true - will make this field obligatory, setting to false 
will make it optional 
extraorderfield2="Another Field" - will add an additional field to the bottom of 
the cart checkout page, obviously the text will need editing here. 
extraorderfield2required=true - will make this field obligatory, setting to false 
will make it optional 
 

Force form submission (Minimum version 4.1.3) 
For payment processors where the credit card details are taken on an SSL 
connection on your site you can set the parameter: 
forcesubmit=true 
...which will submit the form by default in 5 seconds. If you want to change 
that 5 second interval you can set 
forcesubmittimeout=5000 
where the time is set in miliseconds, so the above example would result in a 5 
second delay. 
 

Enable customer login (Minimum version 4.2.0) 
To enable the customer login box you will need to add the line (if it's not 
already present) 
enableclientlogin=true 
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Wholesale pricing (Minimum version 4.6.0) 
Wholesale prices can be set for product options. To do this add the parameter 
wholesaleoptionpricediff=true 
 
You can disable discounts for logged in customers with the wholesale 
attribute by adding the parameter 
nowholesalediscounts=true 
 
You can set a separate minimum wholesale purchase amount and message 
by setting the following 
minwholesaleamount=23.00 
minwholesalemessage="Your message" 

Email headers and footers (Minimum version 4.2.2) 
This feature allows you to add email headers and footers to emails either for 
all payment systems, or depending on the payment system chosen. 
If you want to add a header or footer to all emails then just add the following 
to your vsadmin/includes.asp file 
 
emailheader="This is your email header" 
emailfooter="This is your email footer" 
 
If you want to add a header or footer only for a particular payment system 
then first go to your admin payment providers page. You will see that now the 
first column is the payment provider id. Take a note of the id of the payment 
provider you are interested in. Now if for instance you wanted to add a header 
or footer for the "Email" payment provider, you will see that the id is 4. All you 
have to do is add the id "4" after emailheader or emailfooter like this... 
 
emailheader4="This is your email header for the email payment provider" 
emailfooter4="This is your email footer for the email payment provider" 
 

Order status email (Minimum version 4.5.0) 
You can now set the system to send an email to customers when you change 
the order status on the admin orders page. To turn this feature on you need to 
add the following parameter for example... 
orderstatusemail="Your order id %orderid% from %orderdate% has been 
updated from %oldstatus% to %newstatus% on %date% and the order 
tracking is %statusinfo%" 
The message can be anything you like, and can contain HTML if you have the 
htmlemails=true setting. The following parameters will be replaced with the 
actual order and order status details... 
%orderid% 
%orderdate% 
%oldstatus% 
%newstatus% 
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%date% 
%statusinfo%  
You can also set a parameter orderstatussubject for the order status emails in 
the vsadmin/includes.asp file, for example... 
orderstatussubject = "Place text here" 
If you don't set this then the default email subject "Order status updated" will 
be used for the order status emails. 
 
Using the setting 
alwaysemailstatus=true  
will mean that the checkbox for "email order status change" is always set by 
default.  
 

DHTML menu (Minimum version 4.6.0) 
You can now limit the number of "popout levels" that the DHTML pops out to 
by setting the parameter 
menupoplimit=2 
. . . where 2 in this example would limit to 2 popout levels. 
 

Authorize.net (Minimum version 4.5.0) 
Add the parameter secretword to encrypt your authorize.net merchant id and 
transaction key in the database for extra security. For example... 
secretword="this is my secret word" 
Please note that if you set this, you will have to reset your merchant id and 
transaction key in your admin payment providers page for authorize.net 
 
If you are using the authorize.net AIM system you can now set the parameter  
acceptecheck=true  
to allow for eChecks. You will need to have your authorize.net account set up 
for accepting eChecks. 
 
Authorize.net AIM method can now be used with the WellsFargo 
SecureSource system using the setting 
wellsfargo=true 

Capture Card order status (Minimum version 4.6.0) 
You can set the order status of "Capture Card" orders by setting the following 
capturecardorderstatus=5 
. . . which in this case would set the order status of a capture card order to 5. 
To see the order status id numbers just look on your order status admin page. 
 

Canadian tax (Minimum version 4.3.0) 
Support for the Canadian PST / GST / HST tax system, including the Price 
Edward Island and Quebec systems of adding the provincial tax to the product 
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total + government tax. To use this feature you would need to download the 
current Canadian plug-in and also set the parameter... 
canadataxsystem=true 
 

Per payment provider handling charge (Minimum version 4.3.0) 
You can set a "per payment provider" handling charge. On the payment 
providers admin page, each payment provider shows a unique id. You would 
use the text handlingcharge + the unique id to assign the charge. Say for 
instance if you wanted to add a $2.35 charge to the "2Checkout" payment 
provider, then if you look on the payment providers admin page you will see 
the ID for 2Checkout is 2, so you would set the following... 
handlingcharge2=2.35 
 
If you need to add tax to handling you'll need to choose taxHandling=1 - if not 
leave it as it is ie. taxHandling=0 
 
Setting taxHandling=2 will add the handling tax to the state and country tax 
totals.  
 

Split heavy packages (Minimum version 4.5.0) 
Adding the parameter splitpackat when using UPS or USPS shipping will split 
heavy packages into multiple packages. For instance... 
splitpackat=70 
 

Canada Post (Minimum version 4.6.0) 
To place Canada Post in test mode on the testing server, please use the 
following parameter 
canadaposttest=TRUE 
 

Forcing minimum purchase amount (Minimum version 4.3.0) 
Setting the parameter minpurchaseamount will force a minimum purchase 
amount. You can also set the parameter minpurchasemessage to display a 
message / html if the minimum purchase amount is not met. For instance... 
minpurchaseamount=4.99 
minpurchasemessage="I'm sorry, we have a minimum purchase amount of 
£4.99. Please go back and <b>buy some more</b>"  
 

Alternative currency format (Minimum version 4.7.0) 
You can now have total control over the display of the currency conversions if 
you require. For instance use the following. . . 
 
currFormat1="<b>€</b>%s" 
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currFormat2="<b>£</b>%s" 
currFormat3="<b>$</b>%s" 
 
In each of these %s is replaced by the actual currency value. Be careful that 
the symbols match the currencies you have chosen on your admin main page. 
Of course you can place any formatting or text here. 
 

Product detail link (Minimum version 4.7.0) 
Instead of having the product “details” link leading to the proddetail.asp page, 
you can specify your own link by adding the following (for example) to your 
vsadmin/includes.asp file. 
 
detailslink="<a href=""%largeimage%"" target=""_blank"">" 
detailsendlink="</a>" 
 
Any instances of %pid% will be replaced by the product id and any instances 
of %largeimage% will be replaced by the the value of you have set for large 
image in your admin products page. This will allow you to vary the links per 
product.  
 

Hide product option price difference (Minimum version 4.7.0) 
By setting the switch . . .  
hideoptpricediffs=true 
. . . you can hide the price difference in the product option drop down menus 
and the checkout page. Only the total price will be shown. 
 

Character sets (Minimum version 4.7.0) 
Greater support is now given for “Wide” Character sets such as Japanese and 
Chinese. You can set the following 2 switches . . . 
 
emailencoding="shift_jis" 
adminencoding="shift_jis" 
 
. . . changing “shift_jis” for the actual character encoding used in your emails 
and admin section pages. 
 

Multiple languages (Minimum version 4.8.0) 
 
If you need to have more than one language then set: 
languageid=2 
to indicate which language is being used for that particular admin section. 
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Multiple admins (Minimum version 4.8.0) 
 
You can have up to 5 different admins allowing you to have different store 
URL's etc for copies of your store in subwebs etc. To use a different admin id 
just set the following in your subweb's vsadmin/includes.asp file . . . 
storeadminid=2 
. . . where 2, 3, 4, 5 is the admin id you want to use in that subweb. 
 

Client login forwarding page (Minimum version 4.8.0) 
You can set per login level forwarding pages for the client login system or 
send the logged in client back to the referring page. To set the forwarding 
page for all pages you can set for instance . . . 
clientloginref="yourpage.asp" 
Or to use the "referring" page set . . . 
clientloginref="referer" 
Or optionally you can set . . . 
clientloginref2="otherpage.asp" 
. . . to set say a forwarding page for only those logged in with login level 2.
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Advanced parameters (PHP version) 
In the folder vsadmin there's a file called includes.php - this is where you can 
specify some important options regarding mail, shipping, tax, and the display 
options for your product pages. Below is a guide to preparing the set up that 
best suits your needs. If the include line is not present in your list, it can be 
added and the position of the line is not important to functionality. 
 
Contents 
  
Email Options Layout Options Payment Options
· Email a friend · Product listings · Setting the path to your SSL
· HTML emails · Product layout options · Disabling SSL
· Email orders · Continue shopping link  · Encryption
· Email headers and footers · Category layout options  · Dump credit card numbers
· Order status email · DHTML menu · Force form submission
   · Authorize.net
    · Capture card order status
Shipping / Tax Options Display Options Affiliate Options
· Adding tax to shipping · Product page display numbers · Affiliates cookie
· Removing the shipping 
address

· Removing buy and checkout 
buttons

· Affiliates commission

· Will pick up option · Remove top navigation   
· Show tax inclusive prices · Terms and Conditions   
· UPS options · Quantity boxes   
· Commercial location · Zero price message   
· Shipping insurance · Show product id   
· Invoice / packing slips · Hide product options   
· Canadian tax · Extra checkout fields   
· Per payment provider 
handling charge

· Forcing minimum purchase 
amount

  

· Split heavy packages · Alternative currency format   
· Canada Post · Product detail link   
  · Hide product option price   
Discount Options Customer Login Admin Tweaks
· Remove discount / coupon 
feature

· Enable customer login · cURL compilation

· Hide discount / coupon text · Wholesale pricing · Currency formats
  · Forwarding page · Adjust date
    · Character sets
    · Multiple languages
    · Multiple admins
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Product listings 
 
You can now choose how to sort your product listings - you can do this 
alphabetically, by id or by price. There are four options: 
 
1 = sorting the products alphabetically  
2 = sorting the products by id  
3 = sorting the products by price (cheapest first)  
4 = sorting the products by price (most expensive first)  
So for example if you wanted to list your products alphabetically you would 
choose this option: 
$sortBy = 1; 
or by product id like this  
$sortBy = 2; 
 

Setting the path to your SSL 
 
If you are not using authorize.net (AIM) or the Capture card method, then you 
may wish to specify a path to your secure space, this would be done here: 
$pathtossl = "/path/goes/here"; 
 

Disabling SSL 
 
Setting $nochecksslserver=TRUE; 
will disable the checking with capture card and other payment systems that 
require an SSL server that check you are on an SSL connection. 
 

Product page display numbers 
 
To display the product page number links at the top of the page as well as the 
bottom set 
$pagebarattop=1; 
 

Adding tax to shipping 
 
If you need to add tax to shipping you'll need to choose 
$taxShipping=1; 
if not leave it as it is: 
$taxShipping=0; 
 
Setting $taxShipping=2; 
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will add the shipping tax to the state and country tax totals. 
 

Shipping address (Minimum version 3.6.3) 
 
Use: 
 
$noshipaddress=true; 
 
to cause a shipping address entry section not to be shown on the checkout 
page if set. 
 

"Will pick up" option (Minimum version 4.1.0 - only for UPS / USPS / 
weight and price based shipping.) 
Use: 
$willpickuptext="Will Pickup"; 
If you want to allow your customers the option of picking up their purchase 
from your physical location. The text here can be changed as necessary. 
 
Use 
$willpickupcost=1.32; 
To set the cost of picking up from your location. Set to zero if there is no 
charge 
 

Layout options 
 
In version 1.0.3 we have added the possibility for different layout formats for 
your products 
 
$productcolumns=2; 
 
$useproductbodyformat=1; 
 
$usesearchbodyformat=1; 
 
$usedetailbodyformat=1; 
 
$usecategoryformat=1; 
 
$allproductsimage=""; 
 
Those who are upgrading from previous versions will need to add these 
parameters.. 
 
By setting useproductbody format to 2 like this  
$useproductbodyformat=2; 
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the products are displayed with the product options, price and buy button 
below the product image. When useproductbodyformat is set to 1 the product 
options, price and buy button are displayed to the right of the product image. 
 
The reason we added this second layout is that it lends itself well to having 
more than one column of products. So, when using  
$useproductbodyformat=2; 
the products will be displayed in the number of columns specified by 
productcolumns, such as 
 
$productcolumns=2; 
 
You can have as many as you like in theory, but just make sure they fit on 
your page. 
 
Please note that with the useproductbodyformat set to 1 the productcolumns 
setting will be ignored. 
 
To allow you to specify the search results independently of the general 
product display, you can set usesearchbodyformat to 1 or 2 in the same way. 
 
There is also a second product detail format available now. Setting  
$usedetailbodyformat=2; 
will display the product detail page with the image to the left of the product 
description, price, quantity and buy button. 
 
If you need the category text and description to the right of the image choose 
$usecategoryformat=2; 
 
$allproductsimage=""; 
allows you to specify an image for "All Products" and the path can be inserted 
here. 
 

Email a friend  
 
You can now add the option of emailing a friend from your product detail page 
- this adds a link to a pop-up window with a form that you can fill out to 
forward the information regarding a product to a friend. If you wish to use this 
feature set the parameter like this $useemailfriend=true; 
if you would like to disable the feature then you need 
$useemailfriend=false; 
 

Removing store functions  
 
You can simply eliminate the buy and checkout buttons as well as the price 
for all products, this is done by choosing  
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$nobuyorcheckout=true; 
and  
$noprice=true; 
 

Affiliates cookie  
 
By default the affiliate cookie stays active for 30 days, this means that if 
somebody clicks on an affiliate link and then comes back later to purchase as 
long as it's within 30 days, the sales will be accredited to the affiliate partner. If 
you need to change this then the value here 
$expireaffiliate=30; 
will have to be modified. 
 

Affiliates commission  
 
You can now set an affiliate percentage in the affiliates admin, and set a  
$defaultcommission=12; 
to set a default commission for new affiliates 
 

Discounts / coupons (Minimum version 3.0.0) 
 
To remove the discount and coupon function choose 
$nogiftcertificate=TRUE; 
 

Hide discount or coupon text (Minimum version 4.1.0) 
To remove the discount and coupon text that appears on category and 
product pages 
$noshowdiscounts=TRUE; 
 

Show tax inclusive prices (Minimum version 3.1.2) 
 
To show tax inclusive prices on the products page use 
$showtaxinclusive=TRUE; 
the wording for the tax can be changed in vsadmin/inc/languagefile.php. 
 

UPS Options (Minimum version 3.5.0) 
 
The way that you deliver your packages to UPS for delivery can affect the 
total cost of delivering the package. We have set the default as "Customer 
Counter", though you can change this by setting the following in your 
vsadmin/includes.php file . . . 
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$upspickuptype="03"; 
 
The code in quotes there would be taken from the following table... 
 
01 - Daily Pickup 
03 - Customer Counter 
06 - One Time Pickup 
07 - On Call Air 
19 - Letter Center 
20 - Air Service Center 
 
Remember to enclose the code above in double quotes. Also, please note 
that these options are not exactly the same as you might find on the UPS web 
site but we hear that is something that UPS are working on...more information 
 
To add UPS shipping insurance based on the product value, but not ask the 
customer... 
$addshippinginsurance=1; 
 
To ask the customer if they would like shipping insurance on the checkout 
form... 
$addshippinginsurance=2; 

Commercial location (Minimum version 3.5.0) 
Set $commercialloc=TRUE; if you want to place a question and checkbox on 
checkout for shipping to a commercial location. This is automatically set for 
UPS but can be used for other shipping methods. 
 

Currency formats (Minimum version 3.1.2) 
 
Normally the currency is automatically set by your country settings, but 
sometimes servers don't seem to have locales installed, and some have 
special needs. These are the parameters available: 
 
$overridecurrency=TRUE; 
- Switches the currency overriding on 
 
$orcsymbol="US\$"; 
- The currency symbol used on product pages. 
 
$orcemailsymbol="US\$"; 
- The currency symbol used in emails. Normally the same, but can be handy if 
you wish to set your product page currency symbol to an HTML code like € or 
¥ and then in the email set it to EURO or YEN 
 
$orcdecplaces=2; 
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- How many decimal places your currency has. 
 
$orcdecimals="."; 
- The symbol used for the decimal separator. Normally a "." but can be "," 
 
$orcthousands=","; 
- The symbol used for the thousands separator. Normally a "," but can be a "." 
 
$orcpreamount=FALSE; 
- If you want to display the currency symbol before or after the amount. 
 
$orcurrencyisosymbol="USD"; 
- If you need to force the settlement in US Dollars even if you are selling from 
another country. 
 
Please note, the dollar sign ($) is a special character in PHP and so must be 
preceeded with a slash, as in "US\$" 
 

Encryption (Minimum version 3.5.0) 
 
At the moment for using the "capture card method" with the PHP template 
there is no encryption of the credit card numbers so it is actually necessary to 
set  
$encryptmethod=""; 
to  
$encryptmethod="none"; 
Remember that by doing so, you have to take extra care to make sure the 
database is secure and to delete the card numbers from the database as 
soon as they are processed. If you are unsure about your site security, it 
might be an idea to contact one of the developers here for consultation. 
 

Top navigation (Minimum version 3.5.0) 
 
If you need to remove the top navigation ie. home >> category >> product 
then set 
 
$showcategories=FALSE; 
 

Terms and Conditions (Minimum version 3.6.0) 
 
If you need to make your customers agree to your terms and conditions on 
checkout, set $termsandconditions=TRUE; 
You will also need to create a page with your terms and conditions called 
termsandconditions.php ... which will be shown in a 420 x 380 popup. 
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Quantity boxes (Minimum version 3.6.1) 
 
Setting the following to TRUE will put up a quantity box on the products and 
the product details page (not available if using $usedetailbodyformat=2;): 
 
$showquantonproduct=FALSE; 
$showquantondetail=FALSE; 
 

Zero price (Minimum version 3.6.3) 
 
If you set this, for instance... 
 
$pricezeromessage="<b>Price: Please call</b>"; 
 
...then in the case where a price is set to zero, this message will be printed 
instead. If the pricezeromessage is not set then products with a zero price will 
be displayed as Price: $0.00 as usual. 
 

Show product id (Minimum version 3.6.3) 
 
$showproductid=TRUE; 
 
...will cause the product id to display on the product pages. The text "Product 
ID" is from the vsadmin/inc/languagefile.php as xxPrId 
 

Hide product options (Minimum version 3.6.4) 
 
$noproductoptions=TRUE; 
 
...this will hide all the product options on the products page. 
 

Invoices / packing slips (Minimum version 3.6.6) 
 
$invoiceheader='<img src="images/logo.gif" border="0"><br><br>'; 
 
...this will print your logo at the top of the invoice. Obviously you will need to 
upload the logo to your images folder and set the path / name correctly. 
 
$invoiceaddress='<br><b>My Company LLC</b><br>10, My Road<br>My 
Town, MyCity 90210<br>USA<br><br>'; 
 
... this will print your address on the invoice. As you can see it is possible to 
use HTML for formatting. 
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$invoicefooter='<br><br><font size="1">Thank you for shopping with 
EcommerceTemplates.com</font>'; 
 
..will print the footer information you need to include. Again HTML can be 
used for formatting 
 

Dump credit card numbers (Minimum version 3.6.6) 
 
$dumpccnumber=TRUE; 
 
...this will dump the credit card numbers to the .csv file. 
 

Continue shopping (Minimum version 3.6.6) 
 
$actionaftercart=1; 
 
...or not setting anything will mean that the continue shopping button will take 
the URL from the xxHomeURL from the vsadmin/inc/languagefile.php which is 
the current default. 
 
$actionaftercart=2; 
 
...will make the cart "continue shopping" button return to the page you just 
came from when you are on the cart contents page. 
 
$actionaftercart=3; 
 
...when you add something to your cart, you will refresh immediately back to 
the products page you came from without going to the cart contents page. 
 

Adjust date (Minimum version 3.6.6) 
 
$dateadjust=3; 
 
...would adjust the date the order status was updated by 3 hours. 
 
$dateadjust=-4; 
 
...would adjust it by minus 4 hours. This is so that if your server time is not the 
same as your local time then you can adjust for this. 
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Shipping insurance (Minimum version 3.6.6) 
 
Shipping insurance can now be added to more shipping types than just UPS 
shipping. If using UPS shipping, then adding 
 
$addshippinginsurance=1; 
 
to your includes.asp file will calculate shipping costs with insurance. If using 
UPS shipping then add 
 
$addshippinginsurance=2; 
 
will ask the user if they would like shipping insurance, and if so add it to the 
shipping cost. 
 
With shipping types other than UPS, you have to also set an amount, 
shipinsuranceamt 
for instance... 
$shipinsuranceamt=5; 
If $addshippinginsurance=1; then in this example 5% of the product price total 
will be added to the shipping cost for insurance. 
If $addshippinginsurance=2; then in this example 5% of the product price total 
will be added to the shipping cost for insurance IF the user checks the "yes I 
want shipping insurance" box on checkout. 
If $addshippinginsurance=-1; then in this example 5.00 (of your monetary 
units, say Dollars) will be added to the shipping cost for insurance. 
If $addshippinginsurance=-2; then in this example 5.00 (of your monetary 
units, say Dollars) will be added to the shipping cost for insurance IF the user 
checks the "yes I want shipping insurance" box on checkout. This method will 
not work with USPS shipping for which shipping insurance is not available.  
 

HTML email (Minimum version 4.0.0) 
 
Emails can be sent in HTML if you wish by adding the following switch: 
$htmlemails=true; 
 

Email orders (Minimum version 4.0.0) 
If you need to set email orders as Unauthorized in your admin orders page, 
set 
$emailorderstatus=2;  
 

Category layout (Minimum version 4.1.0) 
$categorycolumns=1; - will give you a vertical list of categories in a single list 
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$categorycolumns=2; - will show the categories in two columns 
 
$categorycolumns=3; - will show the categories in three columns 
 
$catseparator=""; - is required to use the new category set up - no changes 
are necessary here 
 

Extra checkout fields (Minimum version 4.1.0) 
It is possible to add two new fields to your cart checkout page. The company 
name field will go at the top of the checkout form and the additional field at the 
bottom. These can be moved by editing the vsadmin/inc/inccart.php file - they 
can also be made obligatory. 
 
$extraorderfield1="Company Name"; - adds a company name field to the top 
of your cart checkout page, text can be edited here for other uses. 
 
$extraorderfield1required=TRUE; - will make this field obligatory, setting to 
false will make it optional 
 
$extraorderfield2="Another Field"; - will add an additional field to the bottom of 
the cart checkout page, obviously the text will need editing here. 
 
$extraorderfield2required=TRUE; - will make this field obligatory, setting to 
false will make it optional 
 

Force form submission (Minimum version 4.1.3) 
For payment processors where the credit card details are taken on an SSL 
connection on your site you can set the parameter: 
$forcesubmit=TRUE; 
...which will submit the form by default in 5 seconds. If you want to change 
that 5 second interval you can set 
$forcesubmittimeout=5000; 
where the time is set in miliseconds, so the above example would result in a 5 
second delay. 
 

Enable customer login (Minimum version 4.2.0) 
To enable the customer login box you will need to add the line (if it's not 
already present) 
$enableclientlogin=true; 
 

Wholesale pricing (Minimum version 4.6.0) 
Wholesale prices can be set for product options. To do this add the parameter 
$wholesaleoptionpricediff=TRUE; 
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You can disable discounts for logged in customers with the wholesale 
attribute by adding the parameter 
$nowholesalediscounts=TRUE; 
 
You can set a separate minimum wholesale purchase amount and message 
by setting the following 
$minwholesaleamount=23.00; 
$minwholesalemessage="Your message"; 
 

Email headers and footers (Minimum version 4.2.1) 
This feature allows you to add email headers and footers to emails either for 
all payment systems, or depending on the payment system chosen. 
If you want to add a header or footer to all emails then just add the following 
to your vsadmin/includes.php file 
 
$emailheader="This is your email header"; 
$emailfooter="This is your email footer"; 
 
If you want to add a header or footer only for a particular payment system 
then first go to your admin payment providers page. You will see that now the 
first column is the payment provider id. Take a note of the id of the payment 
provider you are interested in. Now if for instance you wanted to add a header 
or footer for the "Email" payment provider, you will see that the id is 4. All you 
have to do is add the id "4" after emailheader or emailfooter like this... 
 
$emailheader4="This is your email header for the email payment provider"; 
 
$emailfooter4="This is your email footer for the email payment provider"; 
 

Order status email (Minimum version 4.5.0) 
You can now set the system to send an email to customers when you change 
the order status on the admin orders page. To turn this feature on you need to 
add the following parameter for example... 
$orderstatusemail="Your order id %orderid% from %orderdate% has been 
updated from %oldstatus% to %newstatus% on %date% and the order 
tracking is %statusinfo%"; 
The message can be anything you like, and can contain HTML if you have the 
$htmlemails=true; setting. The following parameters will be replaced with the 
actual order and order status details... 
%orderid% 
%orderdate% 
%oldstatus% 
%newstatus% 
%date% 
%statusinfo%  
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You can also set a parameter $orderstatussubject for the order status emails 
in the vsadmin/includes.php file, for example... 
$orderstatussubject = "Place your text here"; 
If you don't set this then the default email subject "Order status updated" will 
be used for the order status emails. 
 
Using the setting 
$alwaysemailstatus=true; 
will mean that the checkbox for "email order status change" is always set by 
default. 
 

DHTML menu (Minimum version 4.6.0) 
You can now limit the number of "popout levels" that the DHTML pops out to 
by setting the parameter 
$menupoplimit=2; 
. . . where 2 in this example would limit to 2 popout levels. 
 

Authorize.net (Minimum version 4.5.0) 
Add the parameter $secretword to encrypt your authorize.net merchant id and 
transaction key in the database for extra security. For example... 
$secretword="this is my secret word"; 
Please note that if you set this, you will have to reset your merchant id and 
transaction key in your admin payment providers page for authorize.net 
 
If you are using the authorize.net AIM system you can now set the parameter  
$acceptecheck=true; 
to allow for eChecks. You will need to have your authorize.net account set up 
for accepting eChecks. 
 
Authorize.net AIM method can now be used with the WellsFargo 
SecureSource system using the setting 
$wellsfargo=true; 
 

Capture card order status (Minimum version 4.6.0) 
You can set the order status of "Capture Card" orders by setting the following 
$capturecardorderstatus=5; 
. . . which in this case would set the order status of a capture card order to 5. 
To see the order status id numbers just look on your order status admin page. 
 

Canadian Tax (Minimum version 4.3.0) 
Support for the Canadian PST / GST / HST tax system, including the Price 
Edward Island and Quebec systems of adding the provincial tax to the product 
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total + government tax. To use this feature you would need to download the 
current Canadian plug-in and also set the parameter... 
$canadataxsystem=true; 
 

Per payment provider handling charge (Minimum version 4.3.0) 
You can set a "per payment provider" handling charge. On the payment 
providers admin page, each payment provider shows a unique id. You would 
use the text $handlingcharge + the unique id to assign the charge. Say for 
instance if you wanted to add a $2.35 charge to the "2Checkout" payment 
provider, then if you look on the payment providers admin page you will see 
the ID for 2Checkout is 2, so you would set the following... 
$handlingcharge2=2.35; 
 
If you need to add tax to handling you'll need to choose 
$taxHandling=1; 
if not leave it as it is: 
$taxHandling=0; 
 
Setting $taxHandling=2; 
will add the handling tax to the state and country tax totals. 
 

Split heavy packages (Minimum version 4.5.0) 
Adding the parameter $splitpackat when using UPS or USPS shipping will 
split heavy packages into multiple packages. For instance... 
$splitpackat=70; 
 

Canada Post (Minimum version 4.6.0) 
To place Canada Post in test mode on the testing server, please use the 
following parameter 
$canadaposttest=TRUE; 
 

Forcing minimum purchase amount (Minimum version 4.3.0) 
Setting the parameter $minpurchaseamount will force a minimum purchase 
amount. You can also set the parameter $minpurchasemessage to display a 
message / html if the minimum purchase amount is not met. For instance... 
$minpurchaseamount=4.99; 
$minpurchasemessage="I'm sorry, we have a minimum purchase amount of 
£4.99. Please go back and <b>buy some more</b>"; 
 

Alternative currency format (Minimum version 4.7.0) 
You can now have total control over the display of the currency conversions if 
you require. For instance use the following. . . 
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$currFormat1="<b>€</b>%s"; 
$currFormat2="<b>£</b>%s"; 
$currFormat3="<b>$</b>%s"; 
 
In each of these %s is replaced by the actual currency value. Be careful that 
the symbols match the currencies you have chosen on your admin main page. 
Of course you can place any formatting or text here. 
 

Product detail link (Minimum version 4.7.0) 
Instead of having the product “details” link leading to the proddetail.asp page, 
you can specify your own link by adding the following (for example) to your 
vsadmin/includes.asp file. 
 
$detailslink="<a href=\"%largeimage%\" target=\"_blank\">"; 
$detailsendlink="</a>"; 
 
Any instances of %pid% will be replaced by the product id and any instances 
of %largeimage% will be replaced by the the value of you have set for large 
image in your admin products page. This will allow you to vary the links per 
product. 
 

Hide product option price difference (Minimum version 4.7.0) 
By setting the switch . . .  
$hideoptpricediffs=true; 
. . . you can hide the price difference in the product option drop down menus 
and the checkout page. Only the total price will be shown. 
 

cURL compilation (Minimum version 4.3.0) 
An alternative is provided for those that don't have cURL compiled into PHP, 
but where the host provides cURL on the command line. This would only 
affect those users who wish to use UPS shipping calculations or Authorize.net 
AIM and receive an error about curl_init() being undefined. To use this feature 
you need to set the path to the cURL binary on your server in the parameter 
$pathtocurl. For instance... 
$pathtocurl="/usr/local/curl";  
 

Character sets (Minimum version 4.7.0) 
Greater support is now given for “Wide” Character sets such as Japanese and 
Chinese. You can set the following 2 switches . . . 
 
$emailencoding="shift_jis"; 
$adminencoding="shift_jis"; 
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. . . changing “shift_jis” for the actual character encoding used in your emails 
and admin section pages.  
 

Multiple languages (Minimum version 4.8.0) 
If you need to have more than one language then set: 
$languageid=2; 
to indicate which language is being used for that particular admin section. 
 

Multiple admins (Minimum version 4.8.0) 
You can have up to 5 different admins allowing you to have different store 
URL's etc for copies of your store in subwebs etc. To use a different admin id 
just set the following in your subweb's vsadmin/includes.php file . . . 
$storeadminid=2; 
. . . where 2, 3, 4, 5 is the admin id you want to use in that subweb. 
 

Client login forwarding page (Minimum version 4.8.0) 
You can set per login level forwarding pages for the client login system or 
send the logged in client back to the referring page. To set the forwarding 
page for all pages you can set for instance . . . 
$clientloginref="yourpage.php"; 
Or to use the "referring" page set . . . 
$clientloginref="referer"; 
Or optionally you can set . . . 
$clientloginref2="otherpage.php"; 
. . . to set say a forwarding page for only those logged in with login level 2.
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Chapter 8 
F.A.Q and Troubleshooting 
 
 
 
 
 
General F.A.Q.
ASP Plus version for Windows
PHP Plus version for Unix/Linux
Dreamweaver issues
Frontpage issues
GoLive issues
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General F.A.Q. 
How do I add links to individual products and categories?
I need to change hosts - any recommendations?  
Where can I get the updaters?
Can I upgrade from my Store Version to the Ecommerce Plus?
Can I resell your templates?
How do I edit the default text on my store?
I add a product to my cart but it shows as empty, why's that?
What is the function of the "Authorize" button in my orders admin page?
Why don't all my categories show up after I've added them through the online 
admin?
Why can’t I see the product images on my store? I just get a red “x”.
How can I download my complete product inventory?
How do I remove the dot after all my category names?
How can I match the fonts used on the graphics for my template?
 

How do I add links to individual products and categories? 
Once you have your products and categories added through the online admin 
section, browse your store and copy the URL of the product/category page 
from your address bar and paste it into the link box you have in your HTML 
editor. This should look something like this /proddetail.asp?prod=ref001 or 
/categories.asp?cat=1 
 

I need to change hosts - any recommendations? 
We don't do hosting ourselves but you can find a number of recommendations 
here on our hosting page http://www.ecommercetemplates.com/hosting.asp. 
 

Where can I get the updaters? 
The updates are available from 
http://www.ecommercetemplates.com/updaters.asp. Free for the first 6 
months and $29.95 for a further 6 months, please email us if you have a 
change of address. 
 

Can I upgrade from my Standard Version to the Ecommerce Plus? 
The price is $60 for the upgrade available from 
http://www.ecommercetemplates.com/upgrades.asp. 
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Can I resell your shopping cart software? 
For the time being, the only avenue is through our affiliates program or 
reseller program, which will give you a 20% return on each purchase made 
through your affiliate link. 
 

How do I edit the text on my store? 
All the default language generated by the store can be edited in the file 
/vsadmin/inc/languagefile.asp/php - the most recent additions are always 
added to the top for people who have already made changes and are 
updating their store version. 
 

I add a product to my cart but it shows as empty, why's that? 
There are 2 known reasons for this happening: 
 
Your cart page is in a frameset -> Remove the page from frames.  
You don't have cookies enabled in your browser -> In Internet Explorer go to 
Tools > Internet Options > Privacy  
If that doesn't solve your problem, please post on our support forum. 
 

What is the function of the "Authorize" button in my orders admin page? 
You'll see this button if someone has gone through checkout but hasn't made 
it back to your store, this may be because they're just playing around with the 
cart, have decided at the last moment not to purchase or there was a glitch on 
the Processor's site. Only hit the authorize button after you've checked with 
your Payment Provider and are sure the payment has been made correctly. 
You can set the amount of time that unauthorized orders appear on your store 
in the admin section. 
 

Why don't all my categories show up after I've added them through the 
online admin? 
This is probably because you haven't added any products to the categories - 
once you associate a product with a category, they should show up. 
 

Why can’t I see the product images on my store? I just get a red “x”. 
 
The default folder for the product images is called prodimages and the 
graphics should be uploaded there and the path set in your product admin 
page. If you see a red “x” in place of the graphic, make sure the file name is 
spelled correctly, that it is lowercase with no spaces in the name and has the 
correct .jpg or .gif extension. 
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How can I download my complete product inventory? 
 
You will need to be using the Stock Management program. This can be 
switched on in your main admin setting page. Then go into the main products 
admin page and click on the “Dump Inventory” button. This will download your 
inventory to a .csv file, which can be opened in Excel. 
 

How do I remove the dot after all my category names? 
There is a setting your vsadmin/inc/languagefile.asp/.asp file. 
For the ASP version find xxDot="." and change it to xxDot="" 
For the PHP version find $xxDot="."; and change it to $xxDot=""; 
Remember to upload your language file to the server for the change to take 
place. 
 

How can I match the fonts used on the graphics in my template? 
All the font information is included in the file instructions.txt that accompanies 
the download. The fonts are just used as a suggestion so if you don’t have a 
particular font installed you can use a different one or perform a search on 
Google to see if it is available. 
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ASP Plus version for Windows servers 
I'm not receiving email confirmation of orders - what's up?
Why do my orders disappear in the orders admin page?
How do I make my database secure and non-downloadable?
Why does the log-in page reappear every time when trying to access the 
admin section?
I've forgotten / lost my admin password - how can I retrieve it?
 

I'm not receiving email confirmation of orders - what's up? 
From version 3.6.6 and upwards the system for choosing the email object (the 
component your ASP Ecommerce Plus template uses to send email) has 
become a lot more powerful. 
Most people won't require the information here and emails will be sent 
automatically. However if you are having problems, this is what you need to 
do. 
 
Firstly, log in to your admin section and go to the Admin Main page. 
The email address you set in the "Email address:" section is very important. It 
has to be an address on the same domain as your website as this is a 
security feature for most hosts to avoid SPAM. For instance if your website is 
www.yourwebsite.com then an email address on that domain would be say 
info@yourwebsite.com. 
 
You should see a section "Email Object". In the drop down list you will see a 
list of the available email objects that are installed on your server. If you don't 
see any available email objects in the list, then you need to ask your host if 
they can install an email object for sending email from an ASP page like for 
instance 
CDONTS 
CDO 
ASP Email (PERSITS) 
ASP Mail (ServerObjects) 
JMail (Dimac) 
Some of these are free, so there shouldn't really be a problem. From version 
4.0.1  
SMTPMail (SoftArtisans) 
is also supported. 
 
Ok, so now you can choose an email object in your admin main page. The 
best one to try first is CDONTS, as it doesn't require any further configuration. 
Set the email object to CDONTS and then press submit at the bottom of the 
admin main page, and try an "email friend" to yourself. If you receive the email 
you are all set. 
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If you are using an email object apart from CDONTS then you need to set 
your mailhost. To do this open the file vsadmin/includes.asp in notepad, and 
near the top you should see something like 
mailhost = "your.mailserver.com" 
You will need to set this to the address of your host's mailserver. If you don't 
know what this is then please ask your host. Typical settings would be 
something like 
mailhost = "mail.yourhost.com" 
mailhost = "smtp.yoursite.com" 
 
Once that is set you can use email objects other than CDONTS. 
One important note about using CDO to send mail. There are 2 ways to send 
email using CDO, one which requires a mailhost and one which does not. It is 
worth trying first 
mailhost = "mail.yourhost.com" 
and if that does not work, then try setting 
mailhost = "" 
 
If you still can't get email to work, please ask your host if they have a test 
script for sending email from an ASP page. Once you have tried the test script 
using one of the email objects that we support (listed above), send us an 
email with your FTP login details and URL of the test script and we will have a 
look at why emails are not working from your Ecommerce Plus template. 
 
One other important note. You need a properly configured mailserver to send 
emails from an ASP page. For this reason, don't worry about emails if you are 
testing on your local machine. It will come together when you publish to your 
host.. 
 

Why do my orders disappear in the orders admin page? 
If a payment is not authorized then it will be automatically deleted after the 
time you specify in your admin main page. 
 

How do I make my database secure and non-downloadable? 
If you are using FrontPage, you can right click the fpdb folder in the 
FrontPage folder list and choose Properties... 
Then, make sure the "Allow files to be browsed" option is not checked. 
If you are not using frontpage the options are to use a folder that is outside 
the web root. For instance, when you log in via FTP you might see folders like 
/htdocs - your web root. 
/logfiles - your web log files 
/database - specially for your database files. 
If you have a folder like this "database" folder, (often called "private" or 
similar), then you are very much advised to use it. 
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If neither of the above is true then you have to ask you host to set the security 
settings on the database folder so that files can not be browsed, and the 
database cannot be downloaded. 
 
 
 
 

Why does the log-in page reappear every time when trying to access the 
admin section? 
The usual reason is that your store is hosted on a Unix / Linux server and the 
host is using something like chilisoft.asp which doesn't support an Access 
database. We do have Plus versions available for Unix / Linux servers so 
please contact us if this is the case. 
 

I've forgotten / lost my admin password - how can I retrieve it? 
If you've forgotten the password to your admin section, then the easiest thing 
to do is to download your database and have a quick look in the admin table 
in Access.
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PHP Plus version for Unix / Linux servers 
 
I'm not receiving email confirmation of orders - what's up?
Why do my orders disappear in the orders admin page?
Why can't I run the createdb.php file?
I've forgotten / lost my admin password - how can I retrieve it?  
 

I'm not receiving email confirmation of orders - what's up? 
Make sure that the email address in the admin main page is a valid email 
address on the server. Sometimes emails cannot be sent to an address 
outside of the domain if the "From" address is not on the domain and valid. 
 

Why do my orders disappear in the orders admin page? 
If a payment is not authorized then it will be automatically deleted after the 
time you specify in your admin main page. 
 

Why can't I run the createdb.php file? 
This usually happens when either the database connection hasn't been set 
correctly in vsadmin/db_open_conn.php or if that has been done then check 
with your host that your server is running a minimum of PHP4.1. 
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I've forgotten / lost my admin password - how can I retrieve it? 
If you have phpMyAdmin or something like that installed you can check in the 
admin table. If you don't have that, or don't know how to use it, try creating a 
new file called t.php and add the following to it 
 
<HTML> 
<BODY> 
<?php 
include "vsadmin/db_conn_open.php"; 
$sSQL = "SELECT adminUser,adminPassword FROM admin WHERE adminID=1"; 
$result = mysql_query($sSQL) or print(mysql_error()); 
$rs = mysql_fetch_assoc($result); 
print "The username is : " . $rs["adminUser" ] . "<BR>"; 
print "The password is : " . $rs["adminPassword" ]; 
mysql_free_result($result); 
?> 
</BODY> 
</HTML> 
 
Then, upload this to your web, and put it in the root directory of the store, then 
open in your browser. The most important thing to do is to remember to delete 
the file from your web after using it, as otherwise anyone can get your 
password.
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Dreamweaver F.A.Q. 
 
Why do my images not show up when I preview my page locally?
Why can I see the site correctly on my PC but on a friend's there are no 
images?
How do I define my site?
 

Why do my images not show up when I preview my page locally? 
It could be that you have your image paths set to "Relative to Root" - this 
probably wouldn't be a problem on your server, but locally it'll more than likely 
stop the images from showing and the paths not working. A path which is 
relative to the root would look like this /images/mygif.gif - if it's relative to the 
document it would be in the form of ../images/mygif.gif - you can choose the 
form you want by selecting from the drop down in the window that appears 
when you add an image. 
 

Why can I see the site correctly on my PC but on a friend's there are no 
images? 
This is probably because the path to your image files is pointing to your hard 
drive rather than the images on your server, the most likely cause is that the 
site hasn't been defined...(see below) 
 

How do I define my site? 
Open Dreamweaver, and go to Site>New Site. Give your site a name and 
then browse to where you extracted the template to. If you want to upload 
your files via Dreamweaver then you'll need to add the FTP information that 
was given to you by your host.
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Frontpage F.A.Q. 
 
Why can't I add pages in Navigation View?
Why are parts of the pages missing, like the navigation and news sections?
How do I change the wording of "home" on the nav bar?
Why is all the formatting missing when I upload my site?
How do I make a back-up of my site?
How do I stop Frontpage overwriting my database and database connection 
files?  
 

Why can't I add pages in Navigation View? 
First of all remember that the PHP version doesn't use Frontpage navigation 
and that some templates rely solely on include files rather than a Frontpage 
theme. For the ASP version, for some reason you can't add child pages below 
a .asp page but you can get round this Frontpage quirk by renaming the page 
with a .html termination, dragging in the new page to Navigation View and 
then name the parent page with the .asp extension again. 
 
 

Why are parts of the pages missing, like the navigation and news 
sections? 
This is probably because you have the PHP version and unfortunately PHP 
and Frontpage don't mix too well, but we have found a way around this. 
The first thing is to get the page open in Frontpage :- 
In Frontpage go to Tools>Options>Configure Editors  
Choose "Add"  
Put PHP for file type  
Put the same information as you have for htm, html etc. - this is usually 
Editor Name: FrontPage 
Command: frontpg.exe  
Save 
 
Now you can get the pages open you'll see that the include files are "missing" 
- this is because they are PHP includes not Frontpage includes but you can 
work on them directly from the files in the includes folder - to view your 
changes locally you can download this utility 
http://www.totalpconline.com/phprocketaddin/?page=orders.html or work live 
on the server and on saving your page you can check it in your browser. 
 
There's more information in the first chapter as well as in our PHP help 
section. 
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How do I change the wording of "home" on the nav bar? 
In Frontpage go to Tools > Web Settings > Navigation and change the 
wording there. 
 

Why is all the formatting missing when I upload my site? 
This usually happens when for some reason the theme gets detached from 
the site. Connect live to your site through Frontpage and go to Theme in the 
top menu and go through the themes until you find the one that matches the 
name of your template. If that doesn’t work, try Tools > Recalculate Hyperlinks 
 

How do I make a back-up of my site? 
Open your site live on the server by going to File>New>Web from the top 
Frontpage menu and typing in the URL of your site, and then giving your 
name and password. Your site will now open up on the server so you can 
publish back to your hard drive by hitting the publish icon and choosing a 
back-up location on your hard drive 
 

How do I stop Frontpage overwriting my database and database 
connection files? 
The simplest method is to take them out of your Frontpage web on your 
computer and save them somewhere else on your hard drive. Alternatively 
you can right click on the file and Select Properties > Workgroup and select 
"Exclude this file when publishing the rest of the web".
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GoLive F.A.Q. 
 
Why do I get a little green bug icon in my site file list?
 

Why do I get a little green bug icon in my site file list? 
This means there is an error on the page - usually an incorrect path - if it's 
showing on all pages it's probably located in one of the components. You may 
find that some files in the vsadmin folder show a green bug and due to the 
include structure, these can be safely ignored. 
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Chapter 9 
Search Engine Optimization 
 
 
 
Introduction
Creating dynamic title and meta tags
Creating static URLs
ALT information 
Optimizing your store for the search engines  
Search engine information
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Introduction 
We believe we have most angles covered when it comes to offering search 
engine friendly shopping cart software. Ecommerce templates offers the 
ability to use static pages which are easy to spider by visiting search engines 
as well as unique titles and meta tags for category, product and product detail 
pages and ALT information for all the product images. We have also outlined 
some general information on optimizing your pages for search engines as well 
as an overview of the main players. 
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Dynamic title and meta description tags 
 
From version 4.1.1 it is possible to dynamically generate the title and meta 
description tags for your categories, product and product detail pages. Not 
only are they dynamically generated but you can also add you own unique 
information such as company name to the title tag. The set up details are 
outlined below: 
 

ASP Version  
 
The pages you are going to want to change are... 
categories.asp 
products.asp 
proddetail.asp 
 
Open each of these in turn and go to HTML view. About halfway down the 
page you should see a bunch of "include" files, something like this... 
 
<!--#include file="vsadmin/db_conn_open.asp"--> 
<!--#include file="vsadmin/includes.asp"--> 
<!--#include file="vsadmin/inc/languagefile.asp"--> 
<!--#include file="vsadmin/inc/incfunctions.asp"--> 
<!--#include file="vsadmin/inc/incproducts.asp"--> 
 
  
  
 
 
 
 
 
 
 
 
 
 
 
 
Then, at the very top of the file before the first <html> tag add that 
db_conn_open line along with the metainfo.asp include line like this... 
 
<!--#include file="vsadmin/db_conn_open.asp"--> 
<!--#include file="vsadmin/inc/metainfo.asp"--> 
<html> 
 

If your template uses a DHTML pop-out menu or Mini Cart 
there is no need to delete the line 
< !--#include file="vsadmin/db_conn_open.asp"--> 
Just open vsadmin/db_conn_open.asp in Notepad and make 
sure you don't have a line 
 
DIM sDSN 
 
If you have that, just delete that line. 
 
You can then follow the instructions below as normal. 
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Now repeat this with each of the 3 files categories.asp, products.asp and 
proddetail.asp 
 
Now, on your categories.asp AND the products.asp pages you can change 
the page title tag to something like this... 
 
<title>Bob's widget store: <% 
if topsection<>"" then response.write topsection & ", " 
response.write sectionname%></title> 
 
Also on the categories page, if you use a category description you might want 
to set the meta description tag to this... 
 
<META NAME="Description" 
CONTENT="<%=Replace(sectiondescription,"""","&quot;")%>"> 
 
The information available to the proddetail.asp page is slightly different. On 
that page you can change your page title to... 
 
<title>Bob's widget store: <%= productname & ", " & sectionname & ", " & 
productid %></title> 
 
You might not want to include the product ID, in which case you can use... 
 
<title>Bob's widget store: <%= productname & ", " & sectionname %></title> 
 
For the meta description on the proddetail.asp page you can use... 
 
<META NAME="Description" 
CONTENT="<%=Replace(productdescription,"""","&quot;")%>"> 
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PHP Version  
 
The pages you are going to want to change are... 
 
categories.php 
products.php 
proddetail.php 
 
Open each of these in turn and go to HTML view. About halfway down the 
page you should see a bunch of "include" files, something like this... 
 
<?php include "vsadmin/db_conn_open.php"?> 
<?php include "vsadmin/includes.php"?> 
<?php include "vsadmin/inc/languagefile.php"?> 
<?php include "vsadmin/inc/incfunctions.php"?> 
<?php include "vsadmin/inc/incproducts.php"?> 
 
You will want to delete the first one, the db_conn_open.php line.  
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If your template uses a DHTML pop-out menu or Mini Cart
there is no need to delete the line 
<?php include "vsadmin/db_conn_open.php"?> 
 
You can now follow the instructions below as normal 
en, at the very top of the file before the first <html> tag you should already 
ve a couple of lines of code. Now add the db_conn_open line along with the 
tainfo.php include line like this... 

php 
ssion_cache_limiter('none'); 
ssion_start(); 
lude "vsadmin/db_conn_open.php"; 
lude "vsadmin/inc/metainfo.php";?><html> 

w repeat this with each of the 3 files categories.php, products.php and 
oddetail.php 

w, on your categories.php AND the products.php pages you can change 
 page title tag to something like this... 

tle>Bob's widget store: <?php 
topsection != "") print $topsection . ", "; 

int $sectionname?></title> 
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Also on the categories page, if you use a category description you might want 
to set the meta description tag to this... 
 
<META NAME="Description" CONTENT="<?php print 
str_replace('"','"',$sectiondescription)?>"> 
 
The information available to the proddetail.php page is slightly different. On 
that page you can change your page title to... 
 
<title>Bob's widget store: <?php 
print $productname . ", " . $sectionname . ", " . $productid; 
?></title> 
 
You might not want to include the product ID, in which case you can use... 
 
<title>Bob's widget store: <?php 
print $productname . ", " . $sectionname; 
?></title> 
 
For the meta description on the proddetail.php page you can use... 
 
<META NAME="Description" CONTENT="<?php print 
str_replace('"','"',$productdescription)?>"> 

 
© Ecommerce Templates Page 219 of  229 



 

 
Converting dynamic to static URLs 
 
The default URL for a products page would be something like 
www.yoursite.com/products.asp?id=2 but it is possible to change this to 
something even more search engine friendly like 
www.yoursite.com/productname.asp. You can also do the same for the 
category pages and the product detail, the information is outlined below. 
 

ASP version 
 
Make a copy of products.asp and call it say bobswidgets.asp 
Now, open this page in notepad or your web editor and go to HTML view. 
Now, you should see a set of include files like this: 
 
<!--#include file="vsadmin/db_conn_open.asp"--> 
<!--#include file="vsadmin/includes.asp"--> 
<!--#include file="vsadmin/inc/languagefile.asp"--> 
<!--#include file="vsadmin/inc/incfunctions.asp"--> 
<!--#include file="vsadmin/inc/incproducts.asp"--> 
 
Now just add the variable to specify the category before the incproducts 
include like this for ASP 
 
<!--#include file="vsadmin/db_conn_open.asp"--> 
<!--#include file="vsadmin/includes.asp"--> 
<!--#include file="vsadmin/inc/languagefile.asp"--> 
<!--#include file="vsadmin/inc/incfunctions.asp"--> 
<% 
explicitid=2 
%> 
<!--#include file="vsadmin/inc/incproducts.asp"--> 
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If your template uses a DHTML pop-out menu or Mini 
Cart then you will only find one of the ASP includes in 
the main body of your site. The explicitid will still need
to precede the include line eg.  
<% 
explicitid=8 
%> 
<!--#include file="vsadmin/inc/incproducts.asp"--> 
u can now do the same for categories.asp and proddetail.asp by adding the 
plicitid before: 
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<!--#include file="vsadmin/inc/inccategories.asp"--> 
 
and 
 
<!--#include file="vsadmin/inc/incproddetail.asp"--> 
 
As the explicit id for a product detail page is a product reference, you have to 
enclose this in quotes like this: 
explicitid="yourprodref" 
 
You can get the variable you need by browsing your site and checking the 
particular page URL. For example if your URL for a widget looks like this: 
 
www.yoursite.com/products.asp?id=14 
 
...then you would want to set 
 
<% 
explicitid=14 
%> 
 
If you don't want to change all your pages to static URLs then the URL can be 
in the form of http://www.yoursite.com/products.asp?cat=14 due to the fact 
that Google may not give as much weight to links which contain this generic 
"id" parameter. 
 

PHP version 
Make a copy of products.php and call it say bobswidgets.php 
Now, open this page in notepad or your web editor and go to HTML view. 
Now, you should see a set of include files like this: 
 
<?php include "vsadmin/db_conn_open.php"?> 
<?php include "vsadmin/includes.php"?> 
<?php include "vsadmin/inc/languagefile.php"?> 
<?php include "vsadmin/inc/incfunctions.php"?> 
<?php include "vsadmin/inc/incproducts.php"?> 
 
Now just add the variable to specify the category before the incproducts 
include like this for PHP 
 
<?php include "vsadmin/db_conn_open.php"?> 
<?php include "vsadmin/includes.php"?> 
<?php include "vsadmin/inc/languagefile.php"?> 
<?php include "vsadmin/inc/incfunctions.php"?> 
<?php 
$explicitid=2; 
?> 

 
© Ecommerce Templates Page 221 of  229 



 

<?php include "vsadmin/inc/incproducts.php"?> 
 
  
 
 
 
 
 
  
 
 
 
You can now do the same for categories.php and proddetail.php by adding 
the explicitid before: 
 
<?php include "vsadmin/inc/inccategories.php"?> 
 
and 
 
<?php include "vsadmin/inc/incproddetail.php"?> 
 
As the explicit id for a product detail page is a product reference, you have to 
enclose this in quotes like this: 
$explicitid="yourprodref"; 
 
You can get the variable you need by browsing your site and checking the 
particular page URL. For example if your URL for a widget looks like this: 
 
www.yoursite.com/products.php?id=14 
 
...then you would want to set 
 
<?php 
$explicitid=14; 
?> 
 
If you don't want to change all your pages to static URLs then the URL can be 
in the form of http://www.yoursite.com/products.php?cat=14 due to the fact 
that Google may not give as much weight to links which contain this generic 
"id" parameter. 

If your template uses a DHTML pop-out menu or Mini Cart 
then you will only find one of the PHP includes in the main 
body of your site. The explicitid will still need to precede the 
include line eg.  
<?php 
$explicitid=8; 
?> 
<?php include "vsadmin/inc/incproducts.php"?> 
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ALT Information 
By default all the product pictures and product detail pictures will have the 
ALT information dynamically generated by the value you have added for the 
product name. So if your product name is "Blue Widget" then when your 
mouse passes over the picture the name "Blue Widget" will appear. 
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Optimizing your store 
Once you've got your store set up the next step is getting people to find it. 
Preparing your site for search engines and directories is worth the time and 
effort and pretty simple to do with the templates. We've prepared a very brief 
introduction and guide below that is worth following. 
 

Title tag 
If you look at your HTML code, you'll find something like this near the top of 
your page <TITLE>Untitled document</TITLE>. It's crucial to have a good 
title, around 10 words that clearly explain what the page / site is about and 
including words and phrases you think people will search on, so if you're 
selling widgets for example you might have something like this 
 
<TITLE>Online sales of professional manual and mechanical widgets. My 
Company</TITLE> 
 
It's a good idea to use different titles for different section/pages of your site, so 
on a help page you might have: 
 
<TITLE>How to install mechanical widgets</TITLE> 
 

Meta tags 
Far less important than the <TITLE> tag but still useful for some search 
engines. The description tag is particularly handy for controlling how your link 
will appear. Here you want to use 12 to 15 words that describe the content of 
your page, preferably using the same collection of words and phrases that 
can be found in your main body of text. This again could and should change 
from page to page depending on content. For example: 
 
<META NAME="description" content="Quality widgets and fidgets for sale. 
Buy online at low prices at My Store"> 
 
The other main meta tag is the keywords. It seems their usefulness has all but 
disappeared but they won't harm your site so it's best to include a few. 
Choose words and phrases that people will search on, are relevant to your 
site and appear in your main body of text. For example: 
 
<META NAME="keywords" content="widgets,mechanical widgets,manual 
widgets, widget sales"> 
 
So with this information the top of your code should look something like this: 
 
<html> 
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<head> 
<TITLE>Online sales of professional manual and mechanical widgets. My 
Company</TITLE> 
<META NAME="description" content="Quality widgets and fidgets for sale. 
Buy online at low prices at My Store"> 
<META NAME="keywords" content="widgets,mechanical widgets,manual 
widgets, widget sales"> 
 

Body text 
Many of the major search engines will pick up the text from your site and use 
it, amongst other factors, as a test of relevancy for the search. So having 
keyword rich text is extremely important for giving the search engine 
something to pick up on. You shouldn't go overboard here but certainly having 
your keywords near the top of the page is going to be an advantage. Don't try 
fooling the search engines by hiding text, or listing your keywords 50 times to 
improve ranking. 
 

Alt information 
Each graphic on your site should have accompanying alt information - that's 
the text in a box you see when you pass your cursor over a graphic. Apart 
from aiding the disabled viewers, you can also help with your search engine 
optimization by using concise keyword rich descriptions. For example: 
 
<img border="0" src="images/manual_widget.gif" width="140" height="113" 
alt="Manual Widget"> 
 

Internal links 
Help a search engine index your site, and a person navigate, by having a 
clear navigation structure, text link alternatives to javascript and Flash, and a 
text based site map. 
 

Incoming links 
It appears that particularly for Google, the importance of quality links to your 
site will improve your ranking. You may want to spend some time asking to 
have links placed on related sites, preferably text and with your keyword(s) 
incorporated. You can start off by adding your store to our directory here. 
Beware of "link farms" however. If you want to find out what a quality link 
would be in the eyes of Google, download their toolbar here and check the 
page rank - anything above 5 is good. 
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Other considerations 
A good domain name can help so you might want to look for something like 
manual-widgets.com or mechanicalwidgets.com. Use your keywords in your 
page names where possible and without going over the top eg. 
widgethelp.htm 
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Search engine information 
It's getting more and more difficult to keep up with how search engines work 
and interact, we've outlined below the information in a brief guide to what we 
believe to be correct and will be updating the details as and when we find 
things have changed.  

Google 
Google is undoubtedly the top dog of search engines and a decent listing here 
is without doubt, at the time of writing, one of the keys to the success of a site. 
Listings in Google are free, although you can pay for AdWords to get 
immediate traffic. Google will usually take up to a month to get your site listed, 
and it appears the best way to do so is through the Google bot (spider) 
picking up on your link from another site, spidering (indexing) your site content 
and adding it to their database. The Google database is updated at irregular 
intervals, commonly known as the "Google Dance" as this is when the major 
shake up of the database occurs. You can add your URL to Google but as it's 
important to get links in it's advisable to add your site to dmoz.org and even 
our own store listing. We recommend avoiding link farms and be wary of 
companies guaranteeing instant search engine success. 
 
Google appears to rate sites on a number of aspects, one of the important 
ones being the "quality" of in-bound links eg. a link from Microsoft.com being 
far more interesting than one from your neighbor (unless you live next to Bill 
Gates). Your importance in Google is measured as "page rank" - to find out 
the page rank of a site you'll need to download Google's tool bar. Here is a 
very general and unordered list of what Google is believed to look for on your 
page: 
 
Quality incoming links (preferably using your keywords in the text)  
Keywords in the title  
Keywords in the meta description  
Keywords in the main body of text  
Keywords in the ALT information  
Keywords in the URL  
Descriptive text links within the site  
Text in <H1> tags  
It's important not to overdo things, avoid trying to trick Google, study high 
ranking competitor sites without ripping them off and above all have patience. 
 

Google ad words 
 
You can get into Google immediately through their adword program, rather 
than trying to explain it here, you're best getting the information from the 
horse's mouth. The great thing about adwords is that they will get your site 
advertised on Google immediately, you can also pay for keywords that your 
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site is not showing up on, but keep a close eye on what they are costing you 
and read the information on optimizing your ads. 
 

Yahoo 
There's some debate now on the worth of submitting to yahoo as they are 
using the Inktomi listings. At the time of writing the cost of inclusion is $299 - 
this should get you into the yahoo directory, and in turn a link for Google to 
pick up on - all in all, probably worth it for an ecommerce site but not as 
important as it was in the past. 
 
To add your site to Yahoo, find the category that best suits your needs and 
click on the "Suggest a Site" link at the bottom of the page - make sure you 
read Yahoo's guidelines before submitting. 
 

Altavista 
Again, not as important as it was a couple of years ago but still a widely used 
search engine. You can add your site for free but for a quicker and 
guaranteed listing you will have to pay $39. 
 

Looksmart 
Submitting to Looksmart is worth the investment if you want to get a listing in 
the MSN directory amongst other places, there's a set up of fee of $49 and 
then a charge of $0.15 per click. 
 

Overture 
Overture is one of the major players in pay per click - like Google adwords it's 
a great way to target your audience and in the same vein it can work out 
expensive so it's important to do your research and check out the competition. 
With Overture you bid on the price of your keywords and a well targeted 
campaign can prove very successful - remember that a top three listing is 
beneficial. 
 

Kanoodle 
Another pay-per-click search engine but targeting shopping sites. For more 
information and a $10 free trial, take a look at 
www.ecommercetemplates.com/kanoodle.asp 
 

Other search engines and directories 
Here's a list of other places to submit your site, some are free and some are 
paid inclusions - it's also worth doing a search to find directories of sites that 
are industry related or regional, but again avoid using free for all link farms - 
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you are likely to get more spam than trade, and may even be penalised by the 
major players. 
 
Inktomi (paid)  
All the web (free + paid)  
Lycos (paid)  
Teoma / Ask Jeeves (paid)  
Open Directory (free)  
 
 
 
. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
© Copyright Ecommerce Templates February 2005 
  
 
This package must not be photocopied, reproduced, transmitted in any form 
or by any means without the prior written permission of the copyright owner. 
All requests for permission should be sent to Ecommerce Templates. 
 

 
© Ecommerce Templates Page 229 of  229 

http://www.ecommercetemplates.com/
mailto:info@ecommercetemplates.com

	Ecommerce Templates
	User Manual

	Table of Contents
	Chapter 6 - Design Issues, CSS and DHTML Menus……………………. 116

	Chapter 1�Getting Started
	Welcome
	Requirements
	ASP version
	PHP Version


	Installing the Template
	Opening the Template in Dreamweaver
	Opening your Template in Frontpage
	NOTE

	Opening the Template in Adobe GoLive
	Uploading the store to your server
	Using an FTP program to upload your store
	Using Dreamweaver to Upload your Store
	Publishing your Store via FrontPage
	Making the Database Connection
	ASP Version
	PHP Version
	Files and folders
	Chapter 2�Main Settings & Payment Providers
	SECPay

	The Control Panel
	ASP Version
	PHP Version
	Change Username and Password
	Main admin settings
	Edit admin settings
	Country settings
	Currency Converter (optional)
	Email confirmation
	Email object (ASP version only)
	Store URL
	Products Per Page
	Handling charge
	Shipping type
	Pack products
	USPS /UPS
	Canada Post
	Stock management
	Delete orders
	Delete credit card numbers
	Admin Tweaks
	Multiple languages
	Edit Payment Providers (Main Page)
	Supported Payment Providers
	Email
	PayPal
	Troubleshooting PayPal
	2Checkout
	Authorize.net (SIM method)
	WorldPay
	NOCHEX
	Setting up APC
	Troubleshooting NOCHEX
	Verisign PayFlow Pro (ASP version only)
	Verisign PayFlow Link
	SECPay
	Capture card (ASP version)
	Requirements.
	Setting up the "Capture Card" system with ASPEncrypt install
	Checklist for the ASPEncrypt method
	F.A.Q.
	What is ASPEncrypt?
	What if ASPEncrypt is not installed on the server?
	Can I use my host's shared SSL certificate?
	What is a personal certificate?
	Is this system really secure?
	Capture Card (PHP Version)
	PsiGate
	NetBanx
	Custom
	Setting up a secure server
	Chapter 3�Categories and Products
	Introduction
	Accessing the Categories
	The Screen Explained
	Adding a New Category
	The Screen Explained
	Overview
	Adding products
	Adding a Product Explained
	Section:
	The category where the product will be placed. It is possibl
	Prod. Name:
	Price:
	In Stock:
	Display Product:
	Sell button:
	Image:
	Large Image:
	Product Options:
	Description:
	Long Description:
	Exemptions:
	List Price:
	Additional Sections:
	Product Options
	Product Options Cont . . .
	Option Name:
	Working name:
	Force Selection:
	Price Diff (%):
	Weight Diff(%):
	New Text Input Option:
	Discounts and Coupons
	Coupon or discount:
	Coupon / Discount Effect:
	Working Name:
	Coupon Code:
	Number Available:
	Number Days Available:
	Min Max Purchase Amount:
	Min / Max Quantity:
	Discount Amount:
	Scope:
	Restrict to certain countries:
	Chapter 4�Orders and Affiliates
	Orders admin
	Order details
	Order status types
	Affiliates program
	Drop shipping
	Customer login
	Enabling customer login (ASP Version)
	Enabling customer login (PHP Version)


	Chapter 5�Shipping Methods
	UPS Shipping
	USPS Shipping
	No shipping
	Flat rate shipping
	Weight based shipping
	Price based shipping
	Further Options

	Standard / Express shipping
	State Zone Rules
	Shipping States
	Pack products
	Shipping FAQ
	Can I show shipping costs before checkout?
	Can I use multiple shipping methods?
	I don't need to charge a per item shipping...someone can ord
	I want to charge $5 for the first item entered into the cart
	How do I set up shipping based on a percentage of the final 
	How do I add tax to shipping?




	Chapter 6�Design Issues
	Introduction
	Using Macromedia Fireworks
	Editing text

	Editing graphic colors
	Batch processing
	Frontpage issues
	Frontpage includes
	Modifying an include page (ASP Version)
	Frontpage Navigation (ASP Version)
	Changing Button Names
	Adding a Page
	Deleting a Page
	Troubleshooting




	Modifying an include page (PHP Version)
	How to work "live" on the server
	PHP includes and navigation
	Configuring Frontpage for PHP
	Adding a new page

	Dreamweaver Issues
	Main.dwt
	News.lbi
	Editable Regions
	Adding a new page




	GoLive Issues
	Adding a new page

	Cascading Style Sheets (CSS)
	Editing the hyperlink properties with CSS
	Editing the font properties with CSS
	Using CSS classes
	Editing the category layout




	DHTML Menus
	How the hierarchy works
	How to open a link in a new window
	How to get a text rollover effect if a section name is not a
	How to get rid of the default help links and corresponding p
	How to set up categories and products manually
	Important notes




	Chapter 7�Advanced Tweaks
	Introduction
	How to skin the control panel.
	NB
	We strongly suggest not making any differences to the absolu
	Changing the graphics
	The images associated with the control panel can be found in
	Logo:
	adminimages/ecommerce_templates.gif" width="278" height="53"
	Left hand menu titles:
	adminimages/administration.jpg" width="150" height="31"
	adminimages/product_admin.jpg" width="150" height="31"
	adminimages/shipping_admin.jpg" width="150" height="31"
	adminimages/extras.jpg" width="150" height="31"
	Horizontal line graphic between menu items:
	adminimages/hr.gif
	Observations
	That should give you the basics for skinning the control pan
	How to add a buy button to your home page.
	Adding HTML to product descriptions
	Adding thumbnail photos to your product detail page with Jav
	Adding extra pictures to your product page
	Adding recommended products to your cart page.
	This month’s special offers

	How to change text to graphics.
	How to add a search box to each of your pages
	How to pass search parameters to the search page
	Advanced parameters (ASP version)
	Mail options (Minimum version 1.3.7 to 4.6.0*)
	Product listings (Minimum version 1.3.7)
	Setting the path to your SSL (Minimum version 1.3.7)
	Product page display numbers (Minimum version 1.3.7)
	Disabling SSL (Minimum version 3.5.4)
	Adding tax to shipping (Minimum version 3.5.9)
	Shipping address (Minimum version 3.6.3)
	"Will pick up option" (Minimum version 4.1.0 - only for UPS 
	Layout options (Minimum version 1.3.7)
	Email a friend (Minimum version 1.3.7)
	Removing store functions (Minimum version 2.0.0)
	Affiliates cookie (Minimum version 2.0.0)
	Affiliates commission (Minimum version 4.5.0)
	SQL server (Minimum version 2.0.0)
	Discounts / coupons (Minimum version 3.0.0)
	Hide discount or coupon text (Minimum version 4.1.0)
	Show tax inclusive prices (Minimum version 3.1.2)
	UPS Options (Minimum version 3.5.0)
	Commercial location (Minimum version 3.5.0)
	Set commercialloc=true if you want to place a question and c
	Currency formats (Minimum version 3.1.2)
	Encryption (Minimum version 3.5.0)
	Top navigation (Minimum version 3.5.0)
	Terms and Conditions (Minimum version 3.6.0)
	Quantity boxes (Minimum version 3.6.1)
	Zero price (Minimum version 3.6.3)
	Show product id (Minimum version 3.6.3)
	Hide product options (Minimum version 3.6.4)
	Invoices / packing slips (Minimum version 3.6.6)
	Dump credit card numbers (Minimum version 3.6.6)
	Continue shopping (Minimum version 3.6.6)
	Adjust date (Minimum version 3.6.6)
	Shipping insurance (Minimum version 3.6.6)
	HTML email (Minimum version 4.0.0)
	Email orders (Minimum version 4.0.0)
	Category layout (Minimum version 4.1.0)
	Extra checkout fields (Minimum version 4.1.0)
	Force form submission (Minimum version 4.1.3)
	Enable customer login (Minimum version 4.2.0)
	Wholesale pricing (Minimum version 4.6.0)
	Email headers and footers (Minimum version 4.2.2)
	Order status email (Minimum version 4.5.0)
	DHTML menu (Minimum version 4.6.0)
	Authorize.net (Minimum version 4.5.0)
	Capture Card order status (Minimum version 4.6.0)
	Canadian tax (Minimum version 4.3.0)
	Per payment provider handling charge (Minimum version 4.3.0)
	Split heavy packages (Minimum version 4.5.0)
	Canada Post (Minimum version 4.6.0)
	Forcing minimum purchase amount (Minimum version 4.3.0)
	Alternative currency format (Minimum version 4.7.0)
	Product detail link (Minimum version 4.7.0)
	Hide product option price difference (Minimum version 4.7.0)
	Character sets (Minimum version 4.7.0)
	Multiple languages (Minimum version 4.8.0)
	Multiple admins (Minimum version 4.8.0)
	Client login forwarding page (Minimum version 4.8.0)




	Advanced parameters (PHP version)
	Product listings
	Setting the path to your SSL
	Disabling SSL
	Product page display numbers
	Adding tax to shipping
	Shipping address (Minimum version 3.6.3)
	"Will pick up" option (Minimum version 4.1.0 - only for UPS 
	Layout options
	Email a friend
	Removing store functions
	Affiliates cookie
	Affiliates commission
	Discounts / coupons (Minimum version 3.0.0)
	Hide discount or coupon text (Minimum version 4.1.0)
	Show tax inclusive prices (Minimum version 3.1.2)
	UPS Options (Minimum version 3.5.0)
	Commercial location (Minimum version 3.5.0)
	Currency formats (Minimum version 3.1.2)
	Encryption (Minimum version 3.5.0)
	Top navigation (Minimum version 3.5.0)
	Terms and Conditions (Minimum version 3.6.0)
	Quantity boxes (Minimum version 3.6.1)
	Zero price (Minimum version 3.6.3)
	Show product id (Minimum version 3.6.3)
	Hide product options (Minimum version 3.6.4)
	Invoices / packing slips (Minimum version 3.6.6)
	Dump credit card numbers (Minimum version 3.6.6)
	Continue shopping (Minimum version 3.6.6)
	Adjust date (Minimum version 3.6.6)
	Shipping insurance (Minimum version 3.6.6)
	HTML email (Minimum version 4.0.0)
	Email orders (Minimum version 4.0.0)
	Category layout (Minimum version 4.1.0)
	Extra checkout fields (Minimum version 4.1.0)
	Force form submission (Minimum version 4.1.3)
	Enable customer login (Minimum version 4.2.0)
	Wholesale pricing (Minimum version 4.6.0)
	Email headers and footers (Minimum version 4.2.1)
	Order status email (Minimum version 4.5.0)
	DHTML menu (Minimum version 4.6.0)
	Authorize.net (Minimum version 4.5.0)
	Capture card order status (Minimum version 4.6.0)
	Canadian Tax (Minimum version 4.3.0)
	Per payment provider handling charge (Minimum version 4.3.0)
	Split heavy packages (Minimum version 4.5.0)
	Canada Post (Minimum version 4.6.0)
	Forcing minimum purchase amount (Minimum version 4.3.0)
	Alternative currency format (Minimum version 4.7.0)
	Product detail link (Minimum version 4.7.0)
	Hide product option price difference (Minimum version 4.7.0)
	cURL compilation (Minimum version 4.3.0)
	Character sets (Minimum version 4.7.0)
	Multiple languages (Minimum version 4.8.0)
	Multiple admins (Minimum version 4.8.0)
	Client login forwarding page (Minimum version 4.8.0)




	Chapter 8�F.A.Q and Troubleshooting
	General F.A.Q.
	How do I add links to individual products and categories?
	I need to change hosts - any recommendations?
	Where can I get the updaters?
	Can I upgrade from my Standard Version to the Ecommerce Plus
	Can I resell your shopping cart software?
	How do I edit the text on my store?
	I add a product to my cart but it shows as empty, why's that
	What is the function of the "Authorize" button in my orders 
	Why don't all my categories show up after I've added them th
	Why can’t I see the product images on my store? I just get a
	How can I download my complete product inventory?
	How do I remove the dot after all my category names?
	How can I match the fonts used on the graphics in my templat




	ASP Plus version for Windows servers
	I'm not receiving email confirmation of orders - what's up?
	Why do my orders disappear in the orders admin page?
	How do I make my database secure and non-downloadable?
	Why does the log-in page reappear every time when trying to 
	I've forgotten / lost my admin password - how can I retrieve




	PHP Plus version for Unix / Linux servers
	I'm not receiving email confirmation of orders - what's up?
	Why do my orders disappear in the orders admin page?
	Why can't I run the createdb.php file?
	I've forgotten / lost my admin password - how can I retrieve




	Dreamweaver F.A.Q.
	Why do my images not show up when I preview my page locally?
	Why can I see the site correctly on my PC but on a friend's 
	How do I define my site?



	Frontpage F.A.Q.
	Why can't I add pages in Navigation View?
	Why are parts of the pages missing, like the navigation and 
	How do I change the wording of "home" on the nav bar?
	Why is all the formatting missing when I upload my site?
	How do I make a back-up of my site?
	How do I stop Frontpage overwriting my database and database




	GoLive F.A.Q.
	Why do I get a little green bug icon in my site file list?

	Chapter 9�Search Engine Optimization
	Introduction
	Dynamic title and meta description tags
	ASP Version
	PHP Version


	Converting dynamic to static URLs
	ASP version
	PHP version


	ALT Information
	Optimizing your store
	Title tag
	Meta tags
	Body text
	Alt information
	Internal links
	Incoming links
	Other considerations




	Search engine information
	Google
	Google ad words
	Yahoo
	Altavista
	Looksmart
	Overture
	Kanoodle
	Other search engines and directories





